EMS DESKTOP CLIENT
User Guide

V44.1

Last Updated: March 9, 2018
# Table of Contents

**CHAPTER 1: Introduction to EMS Desktop Client (V44.1)**  
Understanding User Types ................................................................. 2  
Everyday User Reservations ............................................................... 3  
EMS System Architecture ...................................................................... 3  
Upgrading? ............................................................................................ 4  
Product Registration ............................................................................... 5  
Contact Customer Support ................................................................... 5

**CHAPTER 2: Launch EMS** ................................................................. 7

**CHAPTER 3: Manage Database Connections** ................................... 11  
Changing Databases ............................................................................. 12  
Create a New Database Connection ..................................................... 13

**CHAPTER 4: User Settings** .............................................................. 15  
Set user preferences and default values ............................................... 15
Change your password ........................................................................................................... 18
Reset window coordinates ..................................................................................................... 19
Reset column settings ........................................................................................................... 19
Define your views .................................................................................................................. 20

CHAPTER 5: Reservations and Bookings ................................................................................ 21
Reservation Structure ............................................................................................................. 21
Event Timeline ....................................................................................................................... 23

CHAPTER 6: Other Reservation Functions ............................................................................ 24

CHAPTER 7: Recording Actual Attendance Numbers for Bookings ..................................... 25

CHAPTER 8: Manage Attendees and Visitors ......................................................................... 28

CHAPTER 9: View Visitors ...................................................................................................... 29

CHAPTER 10: Check in Visitors ............................................................................................... 32
Check a new visitor into a meeting: ....................................................................................... 32
Check Visitors Into a Meeting ................................................................................................. 36
Calendar ................................................................. -53
Wizard ................................................................. -53
Navigator ............................................................... -53
Browser and Everyday User Reservations ......................... -54
Groups ................................................................. -54
Email ................................................................. -54
Dashboard ............................................................ -55
Manage Services ...................................................... -55
Group Reservations .................................................. -55

CHAPTER 15: Customizing Your Toolbar .......................... 56

CHAPTER 16: Using the Reservation Book ......................... 58

Locations ............................................................. -58
Areas ................................................................. -59
Buildings ............................................................. -59
Rooms ................................................................. -59
CHAPTER 17: Create a Booking in the Reservation Book .......................... 69
Setting the Event Date and Time ......................................................... 70
Setting the Event Location ................................................................. 75
Finding a Standard Room ................................................................. 76
Finding a Best Fit Room ................................................................. 80
Finding a Specific Room ................................................................. 83
Specify Event Information .......................................................... 85

CHAPTER 18: View and Edit Reservations in the Reservation Book ........... 88
To open the Reservation Book ......................................................... 89
To change the Reservation Book display ........................................ 90
To view reservation information ...................................................... 96
To make a new reservation .................................................................98
To edit an existing reservation .........................................................98

CHAPTER 19: Edit Reservations in the Reservations Book .....................101
CHAPTER 20: Import a List of Visitors to a Meeting ...............................104
CHAPTER 21: The Navigator ..........................................................110
CHAPTER 22: Navigator Overview ..................................................113

Open a Reservation in the Navigator .............................................114
Open a Reservation through the Reservation Book ..........................116
Open a Reservation through a Group .........................................116
Open a reservation through a Search .......................................116
Layout and Folder Structure ......................................................117
Reservation Folder .................................................................118
allocate charges to multiple billing reference numbers and/or PO numbers 121
Booking Folder .......................................................................126
Booking Detail Folder ............................................................130
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigator Commands</td>
<td>131</td>
</tr>
<tr>
<td>Navigator options Dialog box</td>
<td>132</td>
</tr>
<tr>
<td>General tab</td>
<td>132</td>
</tr>
<tr>
<td>At A Glance tab</td>
<td>136</td>
</tr>
<tr>
<td>Highlight Categories Tab</td>
<td>137</td>
</tr>
<tr>
<td>Other Navigator commands</td>
<td>138</td>
</tr>
<tr>
<td><strong>CHAPTER 23: Get Familiar with the Navigator</strong></td>
<td>144</td>
</tr>
<tr>
<td>Opening a Reservation in the Navigator</td>
<td>147</td>
</tr>
<tr>
<td>Opening a Reservation from The Reservation Book</td>
<td>148</td>
</tr>
<tr>
<td>Opening a Reservation Through a Group</td>
<td>149</td>
</tr>
<tr>
<td>Opening a Reservation Using a Search</td>
<td>149</td>
</tr>
<tr>
<td>Layout and Folder Structure</td>
<td>149</td>
</tr>
<tr>
<td>Reservation Folder</td>
<td>150</td>
</tr>
<tr>
<td>Reservation Summary Tab</td>
<td>152</td>
</tr>
<tr>
<td>Properties Tab</td>
<td>152</td>
</tr>
</tbody>
</table>
Drawings Tab ................................................................. 158

History Tab ................................................................. 158

Booking Detail Folder .................................................. 158

Navigator Commands .................................................... 159

Navigator Options ....................................................... 160

General Tab .............................................................. 161

At A Glance Tab .......................................................... 165

Highlight Categories ..................................................... 166

Other Navigator Commands ........................................... 167

CHAPTER 24: Edit a Reservation in the Navigator .................. 172

CHAPTER 25: Add Bookings to a Reservation in the Navigator ...... 176

CHAPTER 26: Copy a Reservation in the Navigator .................. 177

CHAPTER 27: Change the Status for a Reservation from the Reservation Summary Tab ..................................................... 183

To change the status for a reservation .................................. 184
To add booking details and items to individual bookings .................................................. 232

To add a booking detail from a non-resource category .................................................. 234

To add setup notes ........................................................................................................... 234

To add attendees ............................................................................................................. 235

To add an agenda (activities) .......................................................................................... 237

To add a room charge ...................................................................................................... 239

To add a booking detail from a resource, service order, or catering category .................. 242

CHAPTER 36: Add Booking Details and Items to Existing Bookings ....................... 250

Adding A Non-Resource Item .......................................................................................... 253

Adding Setup Notes ........................................................................................................ 253

Adding Attendees and Visitors ....................................................................................... 255

Adding An Agenda (Activities) ....................................................................................... 258

Adding A Room Charge .................................................................................................. 260

Adding a Resource, Service Order, or Catering Item ...................................................... 263

CHAPTER 37: Add Booking Detail Items to Multiple Bookings ................................. 271
To add booking detail items to multiple bookings ................................................................. 271

CHAPTER 38: Edit Items for Individual Bookings ................................................................. 274

CHAPTER 39: Copy Booking Details Between Bookings ......................................................... 279

copy booking details between bookings .............................................................................. 279

CHAPTER 40: Delete Booking Details from Multiple Bookings ............................................. 283

To delete booking details from multiple bookings ............................................................... 283

CHAPTER 41: Edit Charges for Multiple Billable Items ......................................................... 286

CHAPTER 42: Edit Count Information for a Booking ............................................................. 288

CHAPTER 43: Add Booking Details Wizard ........................................................................... 292

CHAPTER 44: Copy Booking Details Wizard ........................................................................... 304

CHAPTER 45: Delete Booking Details Wizard ...................................................................... 308

CHAPTER 46: Delete Item Wizard ......................................................................................... 312

CHAPTER 47: Add Item Wizard ............................................................................................. 317

CHAPTER 48: Comments and Reminders in the Navigator ..................................................... 319
Add or Modify Calculations ................................................................. 455

Add or Modify Everyday Users ........................................................... 457

Assign a Group to an Everyday User .................................................. 464

CHAPTER 69: Create an Everyday User from a Group ............................. 466

CHAPTER 70: Assign Everyday Users to a Group ................................ 474

CHAPTER 71: Configure Contacts for a Group .................................... 477

configure contacts ............................................................................. 477

configure a contact manually ............................................................ 479

configure a contact from a group ..................................................... 482

create an everyday user from a contact ............................................ 486

CHAPTER 72: Import Groups ................................................................. 492

CHAPTER 73: Print and Export Everyday User Information .................... 494

To print or export everyday user information ..................................... 494

print everyday user information ..................................................... 496
export a list of everyday users to an Excel spreadsheet .................................................. 497

CHAPTER 74: Print and Export Group Information .......................................................... 499

print group information ........................................................................................................ 499

export a list of groups to an Excel spreadsheet ............................................................... 502

CHAPTER 75: Work with Reservations for a Group ......................................................... 504

work with reservations for a group .................................................................................... 504

search for and view reservations by group from the group-specific window .................. 505

search for and make a reservation for a group from the group-specific window ............... 506

reassign a reservation for a group from the group-specific window ................................ 507

To make a group reservation from the Group Reservation window (EMS Workplace only) ................... 510

CHAPTER 76: Email a Group .......................................................................................... 514

To email a group ................................................................................................................ 514

CHAPTER 77: The Dashboard .......................................................................................... 516

CHAPTER 78: Overview of the Dashboard ...................................................................... 517

Customizing Your Dashboard Options .............................................................................. 519
CHAPTER 100: Generate an EMS Billing Report ......................................................... 644
generate a report ........................................................................................................ 644

CHAPTER 101: Generate Attendee Visitor Reports ..................................................... 647

CHAPTER 102: Configure Automated Reports ............................................................ 652
Query .......................................................................................................................... 655
Saved Report ............................................................................................................. 655

CHAPTER 103: Work with Saved Reports ................................................................. 658
Renaming or Deleting a Saved Report ....................................................................... 662

CHAPTER 104: Work with a Query ........................................................................... 667
create a query ............................................................................................................. 668
Query Builder Filter tab ............................................................................................ 671
Display Fields tab .................................................................................................... 673
Filter tab .................................................................................................................. 676
Sort tab .................................................................................................................... 679
Chart tab .................................................................................................................. 680
Users tab ................................................................. 682
Edit a Query ........................................................... 684
delete a Query ......................................................... 685
View and print a query's filters .................................... 685
run a query ............................................................. 687

CHAPTER 105: Billing .................................................. 693

CHAPTER 106: Overview of Billing in EMS ....................... 694

CHAPTER 107: Search for Transactions .............................. 696

Basic Search ........................................................... 697
Advanced Search ..................................................... 700

CHAPTER 108: Apply Calculations to Billing ....................... 704


Run the Billing Worksheet to Review Charges ..................... 705
Edit Charges on Reservations ..................................... 706
Invoice Reservations in Batch .................................... 706
Run the General Ledger Distribution Report by Invoice ............................................ 707
Apply Payments in Batch ............................................................................................... 708
Void Payments and Invoices ........................................................................................ 709
Additional Billing Reports ............................................................................................. 709
Statements .................................................................................................................... 709
Ageing Report ................................................................................................................. 710
Billing Queries ................................................................................................................ 710

CHAPTER 110: Work with Invoices ............................................................................. 711

Generate an Invoice ....................................................................................................... 712
Reprinting an Invoice ................................................................................................... 721
Void an Invoice .............................................................................................................. 725

CHAPTER 111: Types of Transactions ........................................................................ 731

CHAPTER 112: Work with Transaction ...................................................................... 733

Enter a Transaction: Adjustments, Deposits, Payments, Pre-Payments, Refunds .......... 734
Void a Transaction ......................................................................................................... 740
CHAPTER 113: Generate an EMS Billing Report .............................................742

generate a report .........................................................................................742

CHAPTER 114: Apply a Reservation Discount ...........................................745

CHAPTER 115: Bill Multiple Reference and PO Numbers for a Reservation ....748

CHAPTER 116: Reprice Categories and Room Charges for a Reservation ......752

CHAPTER 117: Confirmations .....................................................................756

Confirmations .............................................................................................756

Notifications .............................................................................................757

CHAPTER 118: Specify Your Confirmation Settings ....................................758

CHAPTER 119: Send Confirmations ............................................................763

Confirmations .............................................................................................764

Notifications .............................................................................................764

CHAPTER 120: Generate a Single Confirmation at a Time .........................765

Manually generating one confirmation at a time ........................................766
Automatically generating a confirmation ................................................................. 769

CHAPTER 121: Generate Printed Confirmations ....................................................... 772

CHAPTER 122: Generate Word Merge Documents for Custom Documentation .... 780

To generate Word Merge Documents ....................................................................... 780

CHAPTER 123: Send Emails .................................................................................... 785

Emailing Reservation Attendees from the EMS Desktop Client Application ........ 786

Sending a Meeting Confirmation or Invoice ............................................................ 787

Sending a Generic Email ........................................................................................ 789

CHAPTER 124: View a History of Sent Emails ....................................................... 790
CHAPTER 1: Introduction to EMS Desktop Client (V44.1)

This section covers the installation and maintenance of EMS Desktop Client. EMS Desktop Client is used by System Administration, IT, and some expert users to maintain software settings, and to manage space and resources.

TIP: If you are new to EMS Desktop Client, get started by Learning About Managing EMS.

Concept: The Installation, Configuration, and User Guides for the EMS Desktop Client apply to all of the following editions:

» EMS Enterprise
» EMS Professional
» EMS Campus Planning Interface

These editions are controlled and based on the EMS Desktop Client, however, their capabilities and features vary and are noted throughout the documentation.

This topic will provide the following information:
UNDERSTANDING USER TYPES

There are two different user types in EMS:

1. **Administrators**: These expert users create and maintain the EMS application within your organization, and manage or approve usage of space. Administrators include conference center managers, event coordinators, registrars, facility and real estate managers, and service providers. They can use this tool to set up and control the booking process and booking templates, define space (buildings, rooms, floors, areas, and regions), define services, manage security and user permissions, grant access, initiate notifications and reports, and integrate with other applications, servers, databases, and systems. Administrators can include Service Providers (Catering, Audio Visual, IT Support Staff), Security, and Receptionist Staff. These users will primarily use the EMS Desktop Client.

2. **Everyday Users**: This is a majority of the users in the organization. Everyday Users, such as an employee who needs to book a conference room or a consultant who needs to book a hoteling space for the day, can use it to make reservations.
and book meetings. Everyday Users are typically requesting rooms and services. These users do not use the EMS Desktop Client, they will primarily use the web based application, EMS Web App in V44.1 (referred to as VEMS if using V44).

EVERYDAY USER RESERVATIONS

An Everyday User Reservation is any reservation that a user has submitted through EMS Web App.

The everyday user reservation searching tool in the EMS Desktop Client is identical to the Browser searching tool with one exception: when the Browser opens for the first time, the Browse for function is set to Reservations whereas the Everyday User Reservation tool is set to Everyday User Reservations. As a result, although this section is written from the perspective of using the Browser, all the information can be applied when using the Everyday User Reservation searching tool.

To open this tool in EMS Desktop Client, click the Everyday User Reservations icon on the EMS toolbar.

EMS SYSTEM ARCHITECTURE

The EMS Desktop Client is the foundation for a broad range of components, services, web applications, APIs, add-ons, and integrations.
UPGRADING?

If you are upgrading to a newer version of EMS, please encourage users at your facility to read the release notes before they begin working with the new version of the software. Doing so will minimize the amount of time it takes them to get “up-to-speed” with the new release and help them benefit from new features and functions that they might not otherwise discover.
IMPORTANT: All the EMS-related components you have licensed must be upgraded with this release.

PRODUCT REGISTRATION

Primary Contacts can obtain the license file from the Support Center area on www.emssoftware.com. This license file is required to activate your EMS software and is required for new and existing customers.

» Configuration
» System Administration
» EMS Campus specific functionality or the Academic Import Utility

**Please note that some discrepancies (e.g., differences in behavior and/or exclusions) will exist.

CONTACT CUSTOMER SUPPORT

» Option 1 (Recommended): Search the Knowledge Base available in the EMS Customer Portal.

» Option 2: Submit a Case directly via the EMS Customer Portal.

» Option 3: Email support@emssoftware.com.

» Option 4 (Recommended for critical issues only): Phone (800) 288-4565.
IMPORTANT: If you do not have a customer login, register here.
CHAPTER 2: Launch EMS

After EMS has been installed on your desktop, a shortcut icon for the application is placed on your desktop. An option for the application is also available from your Start menu. You can double-click the desktop icon to launch the EMS application, or you can select the option from your Start menu.

1. On your desktop, double-click the EMS icon. Alternatively, enter EMS in the Windows start menu in the Search field and then select the EMS option. The application launches, prompting you to enter your credentials.
NOTE: If you are the first person to log in to the EMS application at your organization, a dialog box opens where you enter the information for the login server and database that your application is accessing. (These are set up during implementation.) After you enter this information, the EMS Login dialog box opens.

2. Enter your **User ID** and **Password**. Click **OK**. The EMS Desktop Client application opens. The main menu is open in the application.
**TIP:** If you have an EMS Enterprise license, you can change the server and database you are connecting to by right-clicking on the About EMS Enterprise option.

This launches a pop-up window where you can choose a different server and database.
NOTE: For security reasons, after you log in to EMS the first time using “admin” as both the username and password, at a minimum, we recommend that you change the account password. Ideally, you should create an entirely new administrator account with a new username and password. See Also: Configuring User Accounts.
CHAPTER 3: Manage Database Connections

NOTE FOR EMS CLOUD SERVICES CUSTOMERS:
EMS Cloud Services Customers using the EMS Desktop Client Web Deployment will not change database connections from within the EMS Desktop Client. Please refer here for instructions on switching database connections.

If EMS Desktop Client has been installed on your desktop using the EMS Desktop Client Web Deployment, you can point to a different database through EMS Desktop Client. Contact your system administrator for guidance in databases to use.

This topic will provide information on:

1. Changing Databases
2. Create a New Database Connection
CHANGING DATABASES

1. On the EMS Menu, select File > Change Database to bring up the Database Connections window.

![Database Connections Window](image)

**NOTE:** Any database connection listed in blue is a system record inherited from the EMS Desktop Client Web Deployment that can not be deleted.

2. To connect to a database that is not the system database select it from the list of Database Connections then press the 'Connect' button. This will close and reopen
the EMS Desktop Client connected to the selected database.

Note: The user will need to log in again after changing databases.

CREATE A NEW DATABASE CONNECTION

1. To create a New connection select 'New' in the Database Connections window (shown above) to bring up the Database Connection window.
2. Type in the SQL server and EMS database name then select 'OK' to save the connection. You can delete connections later when you no longer need them.

3. For EMS to save this connection it will first check to see if it is a valid connection. If the connection is invalid, it will not be created you will see this error message:
CHAPTER 3: Manage Database Connections

Error

Connection failed.

OK
CHAPTER 4: User Settings

As an EMS Desktop Client user, you can manage multiple aspects of your account for a superior user experience.

This section provides information on the following settings:

- Set user preferences and default values
- Change your password
- Reset window coordinates
- Reset column settings
- Define your views

SET USER PREFERENCES AND DEFAULT VALUES

Preferences, like system parameters, are settings that affect the basic functioning of your EMS system. The difference is that system parameters are global settings that affect all users on the system, whereas preferences are applicable only to your user account. You can set the values for many preferences for your EMS instance to better suit your working needs. These preferences include the time interval for Time drop-down fields, the size of the paper on which reports, confirmations, and invoices are to be printed, the format in which to send emails from your computer,
and the default values for specific fields in the Reservation Wizard and other EMS client windows.

1. On the EMS main menu, click **Settings > Preferences**. The Preferences dialog box opens. The Preferences tab is the active tab.

2. Edit your user preferences as needed.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Report Setup After Running Reports</td>
<td></td>
</tr>
<tr>
<td>Time Drop Down Interval</td>
<td>The time interval displayed on a Time drop-down list (for example, if you select 30 minutes, then options on the drop-down list are displayed as 1:00 1:30, 2:00 and so on). All Time drop-down lists are 24 hour lists.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>The size of the paper on which reports, confirmations, and invoices are printed. Values are Letter, Legal, and A4.</td>
</tr>
<tr>
<td>Review Notifications When Navigator Opens</td>
<td>If this option is selected, then a notification in the Dashboard is automatically marked as “Reviewed” if you select the notification, and then click Go To. If this option is not selected, then you must select a notification, and then click Reviewed to manually mark the notification as “Reviewed.”</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Do Not Save Window Coordinates</td>
<td></td>
</tr>
<tr>
<td>Email Format</td>
<td>The format in which your emails are sent—HTML or Plain Text.</td>
</tr>
<tr>
<td>Send Emails Using Department Email Address</td>
<td>Select this option if you want the From email address for all the emails that you send from EMS to be the email address of the department that is associated with your user account.</td>
</tr>
<tr>
<td>Use Global Email Settings</td>
<td>If you want to use the global email settings that your EMS administrator has defined, then select this option.</td>
</tr>
<tr>
<td>Use Gmail</td>
<td></td>
</tr>
<tr>
<td>Use Microsoft® Outlook</td>
<td></td>
</tr>
<tr>
<td>SMTP Email</td>
<td>Contact your EMS administrator with assistance in specifying these values.</td>
</tr>
</tbody>
</table>

**NOTE:** If you are using SMTP Email settings that are specific to your account, then you also have the option of creating a signature that is to be included in all the emails that you send from EMS. You can design the signature in plain text on the Design tab or in HTML format on the HTML tab. You can always preview the signature on the Preview tab.

3. Open the Defaults tab, and set the default values for the indicated items.
<table>
<thead>
<tr>
<th>FIELDS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building</td>
<td>The values that you select here automatically populate the appropriate</td>
</tr>
<tr>
<td></td>
<td>fields in the Reservation Wizard, and other EMS client pages.</td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>Event Type</td>
<td></td>
</tr>
<tr>
<td>Event Name</td>
<td></td>
</tr>
<tr>
<td>Event Time</td>
<td></td>
</tr>
<tr>
<td>Reservation Source</td>
<td></td>
</tr>
<tr>
<td>Time Zone/Display Audit Times in This</td>
<td></td>
</tr>
<tr>
<td>Time Zone</td>
<td></td>
</tr>
<tr>
<td>Drawing Application</td>
<td></td>
</tr>
<tr>
<td>Payments Currency</td>
<td></td>
</tr>
</tbody>
</table>

Note: The event name can be a maximum of 30 characters, including spaces.

4. Click **OK** to close the Preferences dialog box and apply your edited preferences and default values.

**CHANGE YOUR PASSWORD**

When your EMS administrator first sets up your user account, your password is predefined for you. You can change this password if you want.
1. On the EMS main menu, click **Settings** > **Change Password**. The Change Password dialog box opens.

2. In the Old Password field, enter your current EMS password.

3. In the New Password field, enter the new password.

4. In the Re-enter New Password field, enter your new password again, exactly as you entered it in the New Password field.

5. Click **OK** to close the Change Password dialog box. The next time that you log in to EMS, you must use your new password.

**RESET WINDOW COORDINATES**

1. On the EMS main menu, click **Settings** > **Reset Window Coordinates**.

2. You will receive a prompt notifying you that window coordinates have been successfully reset.

**RESET COLUMN SETTINGS**

1. On the EMS main menu, click **Settings** > **Reset Column Settings**.

2. You will receive a prompt notifying you that the column settings have been successfully reset.
DEFINE YOUR VIEWS

1. On the EMS main menu, click **Settings > My Views**. The My Views dialog box appears.
2. To create a new view, click **New**.
3. Under the **View** tab, provide a Description and Notes.
4. Under the **Rooms** tab, you can search for rooms by **Building** or **Room Type**.
   - To search by Room Type, choose a **Room** from the Room Type drop-down. A list will appear on the left-hand side of the View screen, including the available rooms, description, building, and room type.
   - To search by Building, choose a **Building** from the Building drop-down. A list will appear on the left-hand side of the View screen, including the available rooms, description, building, and room type.
   - Highlight the desired room and click **>** to select the room. To select multiple rooms, click **>>** or **<<** to remove the selected rooms.
5. Click the **Audit** tab to view details on the View, including the date it was added, who it was added by, the date it was changed and who it was changed by.
6. Click **OK** to save your View.
CHAPTER 5: Reservations and Bookings

The two essential EMS components for meeting and event scheduling are reservations and bookings. To use the EMS Web Client efficiently and effectively, you must understand the structure of a reservation in EMS, the concept of an event timeline for a reservation booking, and how to make a reservation. This section covers the following topics:

» Reservation Structure
  » Reservations
  » Booking Details

» Event Timeline

RESERVATION STRUCTURE

An event in EMS Desktop Client is comprised of the following:

1. A Reservation
2. One or more Bookings
3. Booking details
These three components exist in a hierarchy—a reservation contains one or more bookings and each booking can have one or more details associated with it.

**Reservations**

A reservation is the who and the what of an event. For example, Group X (the who) can reserve some space for an Event Y (the what). A booking is the where and the when of an event. For example, Group X can schedule the conference room (the where) for a staff meeting on the second Monday in January (the when). Group X now has a single reservation with a single booking in EMS. If, however, Group X schedules the conference room (the where) for a staff meeting on the second Monday of each month for a calendar year (the when), then Group X now has a single reservation with twelve bookings in EMS.

**Booking Details**

A booking can have one or more booking details associated with it. Booking details are the resources or services that are needed for an event, the notes for the event, the activities for the event, the room charges for the event, or any combination of these. For example, for Group X’s staff meeting, the resources
could include the requested catering (coffee service, bagels and muffins, and so on) and the A/V equipment (a projector, a speaker’s podium, and so on).

**EVENT TIMELINE**

The following time designators are used for an event in EMS Desktop Client:

- **Event Time:** The time period during which the event actually takes place.
- **Setup/Teardown Hours:** The hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up after the event.
- **Reserved Time:** The total time for which the space (the where) is reserved. This time is the event time plus the setup/teardown time.

<table>
<thead>
<tr>
<th>VARIABLE</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved Start Time</td>
<td>8:00 A.M.</td>
</tr>
<tr>
<td>Setup Hours</td>
<td>1 hour</td>
</tr>
<tr>
<td>Event Start Time</td>
<td>9:00 A.M.</td>
</tr>
<tr>
<td>Event End Time</td>
<td>4:00 P.M.</td>
</tr>
<tr>
<td>Teardown Hours</td>
<td>1.5 hours</td>
</tr>
<tr>
<td>Reserved End Time</td>
<td>5:30 P.M.</td>
</tr>
<tr>
<td>Reserved Time</td>
<td>9.5 hours</td>
</tr>
</tbody>
</table>
CHAPTER 6: Other Reservation Functions

EMS Desktop Client contains several miscellaneous standalone functions to assist you in managing and maintaining reservations and bookings in your system as well as managing your general work requirements.

» Record Actual Attendance Numbers for Bookings
» Manage Attendees and Visitors
» View Visitors
» Check In Visitors
» Import a List of Visitors to a Meeting
CHAPTER 7: Recording Actual Attendance Numbers for Bookings

You use the Attendance Entry tool to view and record the actual attendance for bookings. (The tool does not address reservation-level attendance.) The actual attendance numbers that you enter do not replace the setup count (i.e., the estimated attendance) that you entered prior to an event. Reports that provide attendance information typically provide both the estimated attendance and the actual attendance.

1. On the EMS main menu, click **Reservations > Other > Attendance Entry**. The Attendance Entry window opens.
2. In the **Date** field, select a date for which you are recording the booking attendance, on or before the current day’s date. You can filter the results by building and/or a booking status.

3. For each booking as needed, scroll right to the Actual Attendance column, double-click in the field to select the currently displayed value, and then enter the actual attendance number in the column.
4. Click **Close**.
CHAPTER 8: Manage Attendees and Visitors

Visitor management is an optional feature that your administrator can enable on booking templates so that visitors can be added to your meetings in EMS Desktop Client and EMS Web App (or VEMS if on V44). If the feature is enabled, you can:

» View Visitors
» Check in Visitors
» Import a List of Visitors to a Meeting
» Generate Attendee Visitor Reports
CHAPTER 9: View Visitors

If visitors have been entered in your system, you can look them up in EMS Desktop Client.

1. On the EMS menu bar, click Reservations > Other > Visitors. The Visitors window opens on the Visitors tab.

2. Specify search criteria:
   - Start Date/End Date—The default value is the current day’s date.
   - Building—Select (all) buildings, a specific building, an area, or a view to search.
Show Cancelled—Select this option to search for registered attendees or visitors for canceled events.

Group—To search for registered attendees or visitors regardless of group, leave this field blank; otherwise, to search based on a specific group, enter a search string in the field.

Visitor—To search for a specific attendee or visitor, enter a search string in the field.

Include Checked In—Selected by default. Clear this option to search only for registered attendees and/or visitors who have not yet been checked in to their events.

3. Click Display. The list refreshes to match your search criteria.

4. Optionally, do one or more of the following:

   To see the booking linked to the person, select an attendee or visitor from the search results, and then click Open to open the reservation in the Navigator that contains the booking that the attendee/visitor is attending.

   To check a person in, select an attendee or visitor from the search results, or CTRL-click to select multiple attendees/visitors, and then click Check In to “check in” the attendees/visitors to the event. A date and timestamp is added to each attendee’s/visitor’s record. (you can do the same to Check Out once people have checked in).
To export a list of people to a spreadsheet, on the Tools menu, click Export to export the list of attendees/visitors to a spreadsheet.

To print a list of people, on the Tools menu, or from the Visitors window, click Print to generate an onscreen preview of the list of attendees/visitors. A variety of options are available from this preview, including the options to email the list, to export the list to a .pdf, and so on.
CHAPTER 10: Check in Visitors

This topic will provide information on:

» Check a new visitor into a meeting
» Check Visitors Into a Meeting
  » Check In From the Booking Check-In Dashboard

» Checking in From the Reservation Book

CHECK A NEW VISITOR INTO A MEETING:

1. On the EMS menu bar, click Reservations > Other > Visitors. The Visitors window opens.
2. Open the Groups tab (sometimes re-labeled "Employees" or "Customers").
TIP: Once you have added the new visitor, the **Print Badge** button becomes enabled on the screen above so you can print badges.

3. Find the group or individual hosting the new visitor; specify search criteria:

   - **Start Date/End Date**—The default value is the current day’s date.
   - **Building**—Select (all) buildings, a specific building, an area, or a view to search.
   - **Group**—Enter some or all of the hosting group’s name.

4. Click **Display**. The groups and people that meet your search criteria are displayed in the middle pane of the Visitors window.
5. Select the hosting group from the search results, and then click **New Visitor**. The New Visitor dialog box opens. When you create this visitor account, they will be
associated with the group or individual you selected in the window above.

6. Enter the information for the unregistered visitor, and then click **OK**. The Visitor dialog box closes. You return to the Visitors window with the group and newly configured visitor automatically selected.
NOTE: Building and Name are required fields. Depending on how your EMS administrator configured your system, Company Name, Email Address and/or Phone might be required. Notes are always optional. If you selected a specific building in Step 3, then the Building field is automatically populated with the name of the building in which the event is scheduled and you cannot edit this value; however, if you have set your preferences for buildings such that this building is not available to you, then the Building field cannot be populated with the correct value, and you cannot add the new visitor. See Setting User Preferences and Default Values.

7. Repeat above steps as needed to add all new visitors to the event. The information in the Event column for each new visitor is determined by your Administrator's settings (specified when configuring the event building). For example, “Unregistered Visitor” might be displayed. The date and time when you add an unregistered visitor to an event is used as the Check-In date and time for the visitor.

CHECK VISITORS INTO A MEETING

If authorized, you can check unregistered visitors into a meeting from the Main Menu or the Reservation Book.
CHECK IN FROM THE BOOKING CHECK-IN DASHBOARD

1. Select **Booking Check In** from the menu bar in EMS Desktop Client.

2. Set filters to search for bookings you want to check into.

3. Select an event from the list of results that displays and click the **Check In** button.

**TIP:** This feature replaces the Building and Booking Check In tools in previous releases.

CHECKING IN FROM THE RESERVATION BOOK

Bookings in the Reservation Book can be checked into by right-clicking on the booking and selecting Check In.
CHAPTER 11: Import a List of Visitors to a Meeting

To import a list of visitors to a meeting, you will

» Ensure your list of visitors is ready for import.
» Navigate to the meeting you want to work with.
» Import your list of visitors.
» Select the meetings within the reservation to which to add your list of visitors.
» Confirm and finalize.

1. Your list of visitors must be a tab-delimited spreadsheet that contains the information (in the order listed) for the visitors you want to import. Each visitor must be a separate line entry.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
<th>REQUIRED/OPTIONAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitor</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>Text. 50 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Email Address</td>
<td>Text. 255 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
<td>REQUIRED/OPTIONAL</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Phone</td>
<td>Text. 50 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Notes</td>
<td>Text. No maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Name</td>
<td>Text. 50 characters maximum.</td>
<td>Required</td>
</tr>
</tbody>
</table>

**TIP:** You can click **Print Format** on the second page of the Add Booking Details Wizard (described below) to see the required format for the tab-delimited file.

2. Open the reservation from the Reservation Book.
3. In the left pane of the Navigator window that opens, select the meeting for which you are importing the list of attendees/visitors, and in the Bookings pane on the right, click **Tools**, and then select **Add Booking Details Wizard**.
4. The Add Booking Details wizard opens.
5. Select Visitors or Attendees, and then click **Next**.

6. The second page of the Add Booking Details Wizard opens with a blank row for adding an attendee/visitor to the event.

7. Click **Import**. The Open File dialog box opens. Browse to and select your visitor list spreadsheet, and then click **Import** to import the file. The Add Booking Details Wizard is updated with the imported attendee/visitor information. Each imported visitor is a separate line entry in the Wizard.
8. Click **Next**. The Select Bookings window opens, listing all the bookings within the selected reservation with a date on or after the current day’s date, *and* that do not already have the visitor list added.

![Select Bookings window](image)

**TIP:** To show canceled bookings, clear the Hide Canceled Bookings checkbox. To hide them, select the option. To show all bookings regardless of date, clear the Hide Old Bookings option.

9. Select the meetings to which to add your visitor list (use CTRL+click or Select All to select multiple meetings), and then click **Finish**.

10. A message opens asking you if you want to add more booking details. Click **No**.

11. A message opens indicating that the changes were made successfully. Click **OK** to close the message and return to the Navigator. The booking detail (Visitors) and its items (visitors) are displayed as folders under the appropriate booking folders in the Navigator.
CHAPTER 12: The EMS Main Window

The EMS main window is your starting point for the EMS application. The window provides quick access to all the EMS functions (Reservations, Reports, Configuration, and so on) and system tools. The EMS Main window has four major components:

» Title Bar
» Menu Bar
» Toolbar
» Main Menu

TITLE BAR

The name of the software, EMS Software, and the version number of the application appear in the title bar across the top of the main window.

MENU BAR

The menu bar is set up in a standard Windows menu format with menu commands grouped into menus (File, Settings, Reservations, and so on) across the
menu bar. Some of these menu commands are also available in the main menu.

TOOLBAR

The toolbar provides quick access to the most commonly used functions. The toolbar buttons that are always displayed by default are the buttons for Book, Calendar, Wizard, Navigator, Browser, Everyday User Reservations, Clients, Email, Dashboard, and Manage Services. Other buttons for other functions are also displayed by default depending on the version of EMS that you are running, for example, EMS Academic Planning or EMS Workplace. Some of the functions that are available on the toolbar are also available from the main menu. You can customize the appearance of this toolbar to best suit your business needs. See Also: Toolbar Buttons.

MAIN MENU

The main menu gives you access to the main EMS functions: Reservations, Reports, Billing, Configuration, and System Administration.
The main menu is arranged in a hierarchical folder structure. The top-level folders are the system functions of Reservations, Reports, Billing, Configuration, and System Administration. The available tasks for each top-level folder are further organized into subfolders. For example, to perform a system administration task, you must first open the top-level System Administration folder, and then open the correct subfolder to view the list of available tasks.
You can always close the main menu by clicking the Close button in the upper right corner. To open the main menu again, on the menu bar, click File > Show Main Menu.
CHAPTER 13: Work with EMS Windows

This topic guides you in modifying the size and manner of viewing information in most pages or "browser windows" in EMS Desktop Client.

CLICK-AND-DRAG

Column headers and borders enable you to change column location, order, or width. When a window offers the option shown below, you can click and drag a column header to group data by that column.
RIGHT-CLICK COLUMN MENU

These menus let you sort, hide, and group lists and resize.

COLUMN SORT ARROWS

Use the up/down arrows in each header to quickly sort a column in ascending or descending order.
COLUMN FILTERS

Filtering options help narrow down lists.
CHAPTER 14: Toolbar Buttons

The toolbar always displays buttons for Book, Calendar, Wizard, Navigator, Browser, Everyday User Reservations, Groups, Email, Dashboard, and Manage Services. Other buttons for other functions might also display, depending on the version of EMS that you are running (such as EMS Campus or EMS Workplace) and additional components your organization might have installed, such as EMS Glance or the EMS Polycom Interface. Some of the functions that are available on the toolbar are also available from the main menu. You can customize the appearance of this toolbar to best suit your business needs; keep in mind that your System Administrator might have re-labeled these options with different names than the examples shown in this topic.

TIP: If you are new to EMS Desktop Client, we recommend that you print out this Toolbar Cheat Sheet.
BOOK

Often called the "Reservation Book," this window shows all confirmed reservations (time and room) for your organization. Canceled bookings are not shown. You can use the Book to view and edit existing reservation, and to make new reservations. For detailed instructions, See Also: Using the Reservation Book.

CALENDAR

You use the Calendar to quickly find for reservations, bookings, and service orders using basic or advanced criteria; results are displayed in a calendar view. See Also: Using the Calendar.

WIZARD

You use the Reservation Wizard to make reservations using a streamlined booking template. See Also: Using the Reservation Wizard.

NAVIGATOR

The Navigator enables you to view and manage all aspects of a reservation including bookings and booking details. This window also presents whenever
you open a reservation for editing from other pages in EMS Desktop Client. See Also: The Navigator Overview.

BROWSER AND EVERYDAY USER RESERVATIONS

Authorized users can use the Browser or Everyday User Reservations Browser to search at a very detailed level for reservations, web reservations, bookings, service orders, resources, and queries. See Also: Search with the Browser.

GROUPS

Your organization might have re-labeled this button, "Customers" or "Employees." You can use this browser to search for groups or individuals and reservations and bookings made on their behalf. See Also: Groups and Contacts.

EMAIL

If your system is configured to use SMTP email, clicking this button launches a generic email window. For detailed instructions, See Also: Sending Email from EMS.
DASHBOARD

Authorized users can access this window for centralized information about reservations in a single location. They typically use this feature to plan day-to-day tasks, such as set and check reminders, send or read notifications, approve or check the status of meeting and service order requests, and review the latest changes to events. See Also: Overview of the EMS Dashboard.

MANAGE SERVICES

You use Manage Services to search for and view the resources with and without service orders for all bookings on a particular day as well as the current state of the resources and their Reviewed status. After viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you can mark a resource as un-reviewed. You can also open a resource in the Navigator, and edit it if necessary. See Also: Manage Services.

GROUP RESERVATIONS

If your organization has licensed EMS Workplace, you might see Group Reservation icon in your toolbar. This feature enables you to manage and make reservations for Groups in a centralized location. See Also: Work with Information for a Group.
CHAPTER 15: Customizing Your Toolbar

1. Right-click the toolbar and click Customize.

2. The Customize Toolbar dialog box opens.

3. To display the toolbar icons as large icons, select Large Icons; otherwise, click Small Icons. To add or remove icons from the toolbar display, select them (CTRL+click to pick more than one at a time) and then use the arrow buttons in the...
middle or double-click on them to move them between the Hide or Show panels.

To change the order (from left to right) in which the icons are displayed on the tool-
bar, click Move Up or Move Down.

4. Click OK to save your changes and update the toolbar, or click Cancel to exit without saving your changes).
CHAPTER 16: Using the Reservation Book

The Reservation Book provides a view of all the confirmed reservations (the reserved time as well as the room for which the reservation is scheduled) for your organization. (Canceled bookings are not shown.) You use the Reservation Book to view information for a reservation, to edit an existing reservation, and to make a new reservation. In addition, before you edit or make a reservation, you can change the Reservation Book display so it better suits your working needs.

Concept: Space is Hierarchical in EMS

In EMS, your organization's office is made up of locations, spaces, and users.

LOCATIONS

A physical area representing multiple spaces. Depending on how large your company is, it could be anything from "West Coast HQ" to a campus-level "Mail Room 6". and can contain multiple rooms, buildings, and other spaces.
AREAS

Similar to locations, and area can also include multiple locations, and helps you group locations, buildings, and rooms by your own organization's

BUILDINGS

A physical building containing rooms, with pre-defined equipment and service options. Buildings belong to Locations.

ROOMS

Rooms with pre-defined equipment and service options. Rooms belong to a Building. You can think of the hierarchy like this: Your Company > New York HQ > Client Consultation Area > Central Park Building > Nicest Conference Room

USERS

When you add users in EMS, how you define their user profiles and booking templates control whether they will be able to schedule events in the rooms you've configured.

To open the Reservation Book, on the EMS toolbar, click the Book icon; a window opens where you can see all confirmed reservations for today. You can set Filters along the top, such as Building, View, and Date to change the events
listed, and you can change the time zone displayed. All today's reservations that meet the filtering criteria are displayed in the book in the Daily view. You might have to scroll up and down to see all reservations.

**TIP:** You can only make a new reservation from here in the Daily View. You might also be able to Check In to events from here. You can customize the information that shows when you mouse over an event.
FILTERING ROOMS

You can filter the Reservation Book to only show certain Rooms.

1. Click Filter. The Filter Rooms dialog box opens.

   ![Filter Rooms dialog box]

   If you click Room Properties, you can filter by Building, Floor, Room Type, Capacity, and Room Availability.
If you click Specific Room, you can filter the list to only show events in specific rooms.

2. Click **OK** to close the popup and update in the Reservation Book.

**TIP:** Click **Reset** at the top of the Rooms list to reset filters back to defaults.

CUSTOMIZING YOUR RESERVATION BOOK DISPLAY

Click Options (upper right) to open the Book Options dialog box where you can customize the display of the book and reservations in it.

**NOTE:** As of Update 22, you can simultaneously view event type color and status color from the Reservation Book. See Also: *Book Option Fields* below.
Book Option Fields

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Hour</td>
<td>The daily start time for the Reservation Book display.</td>
</tr>
<tr>
<td>Automatically Refresh</td>
<td>The time interval at which the Reservation Book display is automatically refreshed.</td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display</td>
<td>The information that is displayed in the middle bar for a reservation.</td>
</tr>
<tr>
<td>Time Display Interval</td>
<td>Changes the granularity of the time display interval.</td>
</tr>
<tr>
<td>Maximum No. of Rooms</td>
<td>The maximum number of rooms to display in the Reservation Book.</td>
</tr>
<tr>
<td>Booking Colors Based On</td>
<td>The color of the bookings in the reservation. Select one: <strong>Status</strong>, <strong>Event Type</strong>, or <strong>Check-in Status</strong> (for EMS Workplace only.)</td>
</tr>
</tbody>
</table>

**Show Event Type Color As Outline on Bookings:** Check this box to simultaneously view Status and Event Type on the Reservation Book.

For example, in the image below, the event type is yellow and the status is blue.
<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rooms Without Bookings</td>
<td>Whether to highlight rooms without bookings and if so, the highlight color. If both Highlight Rooms and Booked Space Status Only are selected, then only those rooms that do not have a Booked Space status are highlighted.</td>
</tr>
<tr>
<td>Room Display</td>
<td>Display the room code or the room name for a reservation.</td>
</tr>
<tr>
<td>Building Display</td>
<td>Display the building code or the building name for a reservation.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Go To Today on Startup</td>
<td>If selected, the Reservation Book opens to the current day's date; otherwise, it opens to the last date viewed.</td>
</tr>
<tr>
<td>Always Prompt for Room Filter on Startup</td>
<td>If Show ‘(all)’ in Building List is also selected, then when you open the Reservation Book, the Room Filter dialog box opens on top of the Reservation Book. You can select different options on this dialog box to display only specific reservations in the book, for example, bookings only for selected rooms. If you do not select any options on this dialog box, but instead simply close it, then all reservations for all rooms in all buildings are displayed in the book.</td>
</tr>
<tr>
<td>Hide Current Time Indicator</td>
<td>Show or hide the vertical bar that indicates the current time for current day.</td>
</tr>
</tbody>
</table>

**NOTE:** The Current Time indicator is displayed only if the view is the Daily or Weekly view and the view includes the current day's date.

<table>
<thead>
<tr>
<th>Show ‘(all)’ in Building List</th>
<th>Show the &quot;all&quot; option on the Building drop-down list; otherwise, a user must select a specific building. If this option is selected in conjunction with Always Prompt for Room Filter on Startup, then when you open the Reservation Book, then the Room Filter dialog box always opens on top of the Reservation Book. If you are setting your Reservation Book options, and you do not want to the Room Filter dialog box to open on top of the Reservation Book when you open the book, then do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>» Clear Always Prompt for Room Filter on Startup.</td>
</tr>
<tr>
<td></td>
<td>» Clear Show (‘all’) in Building List.</td>
</tr>
<tr>
<td></td>
<td>» On the Building drop-down list in the Reservation Book, select any building, area, or view.</td>
</tr>
</tbody>
</table>
**NOTE:** The building, area, or view that you select is not important. This last step just clears the “all” building option from the Reservation Book cache and ensures that the Room Filter dialog box does not open on top of the Reservation Book. Going forward, you can always select all buildings, or any specific building, area, or view as needed when you are working in the Reservation Book.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Capacity</td>
<td>Show the minimum and maximum capacities next to the room description.</td>
</tr>
<tr>
<td>Hide Booking</td>
<td>Hide the vertical shadow bar that highlights the reserved and/or event start times and end times when a user moves a booking in the Reservation Book.</td>
</tr>
</tbody>
</table>

**CUSTOMIZE EVENT INFORMATION ON MOUSEOVER**

In the Book Options dialog box, click the Tooltip Display tab to select which items to include in the tooltip that opens when you mouseover an event in the Reservation Book.
CHAPTER 17: Create a Booking in the Reservation Book

To begin, locate and select the room you want to book in the Reservation Book (Daily display). To the right of the room in the time grid, click and drag your mouse to select a start time and end time. The Reservation Wizard launches.

You use the Reservation Wizard to check for available space for an event and to make a reservation for the event.

Concept: Reservations are containers for multiple bookings; bookings are individual meetings.

When you "make a reservation" in EMS, you are creating the broader rules for events that take place with a similar purpose and involving most of the same people, services, resources, and spaces. When you "book" a meeting, you are creating a meeting within a reservation. See Also: Reservation Structure.

The Reservation Wizard helps you search for rooms that are available for a particular time on one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You can also create a series reservation by selecting one date and time, but multiple rooms.
To make a reservation using the wizard, you will:

» Set the event date, time, and status
» Set the event location
» Specify the event information

The following procedure describes how to make a reservation by selecting values for the required and optional fields.

» If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard Template drop-down list is displayed at the top of the Reservation Wizard. You can streamline the booking process by choosing from these templates, which automatically sets the default values for many of the fields in the Reservation Wizard.

» If your job entails making multiple reservations that require the same information, and you are not using reservation wizard templates, then you can set your own default values for many of the fields in the Reservation Wizard. See Also: Setting User Preferences and Default Values.

SETTING THE EVENT DATE AND TIME

1. On the toolbar, click the Wizard icon. The Reservation Wizard opens. All required fields in the wizard are marked with a red dot. Your EMS administrator configures the required fields.
2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different month (< or >) or for a different year (<< or >>). You can also click a month at the top of the calendar to open a drop-down list from which you can select a different month and you can also click a year at the top of the calendar to open a drop-down list from which you can select a different year.

   If the event dates do not follow a pattern, use one or more of the following options for entering a date; otherwise, go to the next step. Click to pick dates on the calendar. To select all five days in a work week, click in the blank space to the left of the week. To select all seven days in a week, double-click in the blank space to the left of the week.
To select every occurrence of a specific day of the week for the displayed month (for example, all Tuesdays in November, 2012), click the heading (S, M, T, and so on) for the day. To select every occurrence of a specific day of the week shown (regardless if the day falls within the same month), double-click the heading (S, M, T, and so on) for the day. If you need to clear a single selected date, click the date again. To clear multiple selected dates in a single step, click Clear Month to clear all currently selected dates for the currently displayed month or click Clear All to clear all currently selected dates regardless of month or year.

If the event dates do follow a recurrent pattern, (for example, the third Friday of every month), click Date Pattern to open the Date Pattern dialog box and enter
your event date information. The steps that you use to create a date pattern in EMS are very similar to the steps that you use to create a date pattern in Microsoft Outlook or in any other calendaring product.

![Date Pattern](image)

As you specify the event dates, the Selected Dates tab is automatically updated with the selected dates. Dates that are closed are displayed in red on the Calendar tab, holidays are green. These are linked to information about the closure (in the Selected Dates tab, click Holidays). To remove the date your selection, open the Selected Dates tab, select the date, or CTRL-click to select multiple dates, and then click Remove. When you make a reservation for multiple dates, the process is easier if you first remove all holidays or closed dates from the list of selected dates; however, be very careful when selecting dates for removal as you are not prompted to confirm your selection before you click Remove.

Viewing information about a holiday or closed date from the Calendar tab
3. Specify the start time and end time for the event:
   » Select a time from the drop-down list for each field.
   » Manually enter the time in each field. When you manually enter the time, you can use a shortcut. For example, for 9:00 am, you need to enter only "9a" and for 2:00 pm, you need to enter only "2p" and so on. If you enter an end time that is earlier than the start time, then the system assumes that the end time is the next day and the phrase "Next Day" is displayed to the right of the End time field.

4. Specify Setup and Teardown times. To use the default setup and teardown times that your EMS administrator has assigned to the rooms in your system, leave Use Default selected. To override the default setup/teardown times, clear Use Default, select Minutes or Hours, and then enter your own setup and teardown times. Remember, setup and teardown times are the hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up
after the event. For example, for a 30 minute setup time, you can enter 30 minutes or 0.5 hours.

5. Select the status for the event. Depending on the status that you select, for example, Tentative or Hold, you might be required to enter a reconfirm date. You can monitor reservations that must be reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See Also: EMS Dashboard.

SETTING THE EVENT LOCATION

You have three options for selecting the event location on the first window of the Reservation Wizard:

<table>
<thead>
<tr>
<th>SEARCH METHOD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Use this option to display a list of all the available rooms that meet all the requested dates.</td>
</tr>
<tr>
<td>Best Fit</td>
<td>Use this option if no one room can meet all the requested dates. The system lists the available rooms along with the number of bookings for which you can reserve each room. You can piece together the entire reservation using Best Fit, or just part of it.</td>
</tr>
<tr>
<td>Specific Room</td>
<td>Use this option to confirm the availability and reserve of one specific room for the scheduled event.</td>
</tr>
</tbody>
</table>

NOTE: Standard search is required for Video Conference room assignments.
NOTE: By default, EMS looks for an available room or rooms in only the first 50 rooms that it finds in the pre-configured Rooms list. To search more than 50 rooms, before you begin any search, click Options > Max. Number of Rooms to Search, and then select a different number of rooms to search.

FINDING A STANDARD ROOM

By default, when you search for a standard room, rooms that are available all day are marked with an asterisk (*). To set or clear this option, click Options > Standard Search > Show Available All Day Indicator.

1. Select Standard.
2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to search for a standard room. Your selection on the Building drop-down list determines the options that are available on the Time Zone drop-down list. If you select (all) buildings, then you can select a time zone. If you select a specific building, then by default, a time zone is selected for the building, and you cannot select a different value.
3. If applicable, select the appropriate time zone for the event.
4. Specify one or more room settings:
   - Type is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type drop-down list.
   - Floor is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down list.
   - Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type drop-down list.
   - Setup count is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count. The selected setup type and setup count are applied to all the bookings that you add to this reservation. If any of the bookings require a different setup type or count, you can change this information after you complete the reservation.

5. You can add optional Features on the Features tab.

6. Click Next. Up to two tabs are displayed:
   - The Available tab, which is the active tab and is always displayed, lists all the rooms that meet all your event criteria. If you have elected to show
the Available All Day Indicator, the rooms that are available all day are marked with an asterisk (*). By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

» The Conflicts tab is displayed only if there are rooms that are not available for the requested dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling as well as list of the events that are scheduled for each room.

**Example of standard room search results**
7. Select the room, or CTRL-click to select the multiple rooms you are scheduling for the event. If the reservation is for a video conferencing meeting, then you must select a minimum of two rooms. You must designate one of these rooms as the Host Location on the Video Conference tab on the last page of the Reservation Wizard.

8. Optionally, do one or both of the following; otherwise, go to Step 9.
   » Click Room Info to open the Room Info dialog box and view information about any bookings for the room, the room properties, its pricing, and/or to view an image of the room.
   » Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

9. Click the Move button (>) to move the rooms to the Selected list.

   **TIP:** If you select more than one room, all the selected rooms are booked for all the event dates.

10. Click Next.
FINDING A BEST FIT ROOM

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to search for a standard room.

3. If applicable, select the appropriate time zone for the event.

**NOTE:** Your selection on the Building drop-down list determines the options that are available on the Time Zone drop-down list. If you select (all) buildings, then you can select a time zone. If you select a specific building, then by default, a time zone is selected for the building, and you cannot select a different value.

4. Do one or more or all of the following for room specifications:

   » Type is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type drop-down list.

   » Floor is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down list.
Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type drop-down list.

Setup count is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count. The selected setup type and setup count are applied to all the bookings that you add to this reservation. If any of the bookings require a different setup type or count, you can edit the reservation later.

5. You can add optional Features for the room on the Features tab.

6. Click Next. Up to two tabs are displayed:

   The Available tab, which is the active tab and is always displayed, has two lists. The list in the left pane is a list of all the rooms that meet some or all of your event criteria. The list in the right pane is a list of all the event dates that must be fulfilled. By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)
The Conflicts tab is displayed only if there are rooms that are not available for the requested dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling for the event as well as list of the events that are scheduled for each room.

Example of best fit room search results

7. Optionally, do one or both of the following; otherwise, go to the next step.
   » To see detailed room information, click Room Info (such as the room properties, pricing, and/or to view an image of the room).
To see building hours, click Building Hours (which shows hours when the selected room/building is open on the reserved date).

8. If a room is available, select the single room that is available for all the requested dates, and then click the Move button (>) to move the room to the Event Dates list. If a room is not available, select a room that is available for some of your requested dates, and then click the Move button (>) to move the room to the Event Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to continue.

FINDING A SPECIFIC ROOM

You can use the specific room search to book a standard EMS room or a room or area that is not managed in EMS. An override room, or "override description," is used to book an event in a space that has not been configured in your EMS system. For example, your EMS administrator might have configured an override room named "Other Area" in the Engineering building. To book an event in Dr. Wilson's office, which is a room that is not defined in EMS, in the Engineering building, you can select the "Other Area" room and specify "Dr. Wilson's Office" for the location. EMS does not track availability for events booked in override rooms; however, EMS reports on events that are scheduled in an override room just like any other event scheduled for any other room.
1. Select Specific Room. The Room Selector dialog box opens.

2. To choose a room from list of all rooms in all available buildings, select (all) on the Building drop-down list; then select a room, and then click OK. To select a room in a specific building, area, or view, select it on the Building drop-down list, select the room, and then click OK. If the room is configured as an override room, go to the next step, otherwise, go skip to Step 4.

3. In the Location field, enter the location of the override room, and then click Next skip the remaining steps in this subsection.

4. Click Next. If the event is scheduled for a single date and the room is available, then continue. In all other cases, (for example, the event is scheduled for a single date but the room is not available or it is a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific room is
available. You can open the Conflicts tab to view the list of dates for which the specific room is not available as well as list of the events that are scheduled for the room.

5. Optionally, do one or both of the following; otherwise, go to the next step.
   - To see detailed room information, click Room Info (such as the room properties, pricing, and/or to view an image of the room).
   - To see building hours, click Building Hours (which shows hours when the selected room/building is open on the reserved date).

6. If the specific room is available for all the event dates, then click the Move All button (>>) to schedule the room for all the event dates. If the specific room is not available, try another approach such as reserving a different specific room, or using the Standard or Best Fit search method.

7. Click Next to continue.

**SPECIFY EVENT INFORMATION**

After you select an event location or locations, you must specify other information for the event. You must enter information in the required fields.
1. Enter event information using the elements in this window (see also: Reservation Wizard Fields).

2. Click Finish. The Navigator window opens. The reservation information appears in the window. You use this window to add booking details and to make any needed modifications to the reservation and its bookings.
NOTE: A reservation is not complete and rooms are not removed from the Available list until you click Finish. Although unlikely, it is possible for another user to select and reserve a room during the time period after you have selected the room but before you have finalized the reservation. If this occurs, after you click Finish, a message opens stating that your reservation conflicts with an existing reservation.
CHAPTER 18: View and Edit Reservations in the Reservation Book

The Reservation Book provides a graphical view of all the confirmed reservations (the reserved time as well as the room for which the reservation is scheduled) for your organization. (Canceled bookings are not shown.) You use the Reservation Book to view information for a reservation, to edit an existing reservation, and to make a new reservation. In addition, when the Reservation Book first opens, before you edit or make a reservation, you can change the Reservation Book view so that it better suits your working needs.

This section will provide information on the following topics:

- To open the Reservation Book
- To change the Reservation Book display
- To view reservation information
- To make a new reservation
- To edit an existing reservation
TO OPEN THE RESERVATION BOOK

1. From the toolbar, click the Book icon. The first time that you open the Reservation Book for your EMS implementation, by default, the Filter dialog box opens on top of a blank Reservation Book. You can leave the room filtering criteria set to their default values, or you can select different values as needed, and then click OK. All reservations that meet the filtering criteria and that are scheduled for the current day’s date are displayed in the book in the Daily view.

**TIP:** You might need to use the book’s scroll features to scroll through all the reservations that are scheduled for the current day’s date.

» If an event is scheduled for a room that is a component of a combination room, then the reservation text is displayed in black. A duplicate reservation is also shown for the combination room; however, the reservation text is displayed in gray to indicate that a component of the combination room is currently booked for the indicated time and therefore, the combination room is not available.

» Conversely, if an event is scheduled for a combination room, then the reservation text for the combination room is displayed in black and the reservation text for each component is displayed in gray. This reversed color coding indicates that the component room is currently booked for the selected time and that none of the components is available.
The Reservation Book has the following appearance:

» Minimum and maximum capacities are displayed next to room descriptions
» The current time is shown by a vertical line in the grid, called the Current Time Indicator
» If building hours have been configured for a building, then this information is displayed for the building

The reservations are displayed with three components:

1. A left bar that indicates the setup time
2. A middle bar that indicates, by default, the event name
3. A right bar that indicates the teardown time

TO CHANGE THE RESERVATION BOOK DISPLAY

2. You can change the Reservation Book display in the following ways:
   » Change the list of rooms that are displayed in the Reservation Book based on room properties.
Change the list of rooms that are displayed in the Reservation Book based on a specific room(s).

» Change the Reservation Book view.

» Change multiple display options for a reservation.

» Select which items to include in the tooltip that opens when you place the cursor over an event in the Reservation Book.

» Change the display date using the calendar.

» Change the display date using the Reservation Book scroll features.

3. To change the list of rooms based on room properties:
   
a. Click Filter if the Filter dialog box is not already open.

b. Select Room Properties and customize one or more of the following:
   
   » Leave the Building drop-down list set to the default value of (all) buildings, or select a specific building, area, or view.

   » Select a specific floor.

   » Select a specific room type.

   » Select Capacity and then enter a capacity.

   » Select Academic to limit the search to academic rooms.

   » Select a Room Availability option.

4. Click OK. The Filter Rooms dialog box closes. The room display in the Reservation Book is changed accordingly.
5. To change the list of rooms that are displayed in the Reservation Book based on a specific room or rooms:
   a. If the Filter Rooms dialog box is not already open, then above the Rooms list, click **Filter** to open the dialog box and select Specific Room.
   b. Select the room, or CTRL-click to select multiple rooms on the Available list.
   c. Click the **Move (>)** button to move the selected rooms to the Selected list.

   The Reservation Book is updated to show bookings only for the selected rooms.

6. To change the Reservation Book view:
   a. From the View drop-down list, select Daily, Weekly, or Monthly.

7. To change multiple **display options** for a reservation:
   a. Click **Options** (upper right hand corner of Reservation Book) to open the Book Options dialog box (the General tab is the active tab).
   b. Change multiple display options not only for the Reservation Book, but also a reservation in the book.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>The daily start time for the Reservation Book display.</td>
</tr>
<tr>
<td>Hour</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>The information that is displayed in the middle bar for a reservation.</td>
</tr>
<tr>
<td>Time Dis-</td>
<td>Changes the granularity of the time display interval.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Maximum Number of Rooms</td>
<td>The maximum number of rooms to display in the Reservation Book.</td>
</tr>
<tr>
<td>Booking Colors</td>
<td>The color of the bookings in the reservation. Select one: Status, Event Type, or Check-in Status (for EMS Workplace only.)</td>
</tr>
<tr>
<td>Rooms Without Bookings</td>
<td>Whether to highlight rooms without bookings and if so, the highlight color. If both Highlight Rooms and Booked Space Status Only are selected, then only those rooms that do not have a Booked Space status are highlighted.</td>
</tr>
<tr>
<td>Room Display</td>
<td>Display the room code or the room name for a reservation.</td>
</tr>
<tr>
<td>Building Display</td>
<td>Display the building code or the building name for a reservation.</td>
</tr>
<tr>
<td>Go To Today on Startup</td>
<td>If selected, the Reservation Book opens to the current day's date; otherwise, it opens to the last date viewed.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Always Prompt for Room Filter on Startup</td>
<td>If Show ‘(all)’ in Building List is also selected, then when you open the Reservation Book, the Filter dialog box opens on top of the Reservation Book. You can select different options on this dialog box to display only specific reservations in the book, for example, bookings only for selected rooms. If you do not select any options on this dialog box, but instead simply close it, then all reservations for all rooms in all buildings are displayed in the book.</td>
</tr>
<tr>
<td>Hide Current Time Indicator</td>
<td>Show or hide the vertical bar that indicates the current time for current day.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> The Current Time indicator is displayed only if the view is the Daily or Weekly view and the view includes the current day's date.</td>
<td></td>
</tr>
<tr>
<td>Show ‘(all)’ in Building List</td>
<td>Show the “all” option on the Building drop-down list; otherwise, a user must select a specific building. If this option is selected in conjunction with Always Prompt for Room Filter on Startup, then when you open the Reservation Book, then the Filter dialog box always opens on top of the Reservation Book. If you are setting your Reservation Book options, and you do not want to the Filter dialog box to open on top of the Reservation Book when you open the book, then do the following:</td>
</tr>
<tr>
<td><strong>»</strong> Clear Always Prompt for Room Filter on Startup.</td>
<td></td>
</tr>
<tr>
<td><strong>»</strong> Clear Show ‘(all)’ in Building List.</td>
<td></td>
</tr>
<tr>
<td><strong>»</strong> On the Building drop-down list in the Reservation Book, select any building, area, or view.</td>
<td></td>
</tr>
<tr>
<td><strong>NOTE:</strong> The building, area, or view that you select is not important. This last step just clears the “all” building option from the Reservation Book cache and ensures that the Filter dialog box does not open on top of the Reservation Book. Going forward, you can always select all buildings, or any...</td>
<td></td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>specific building, area, or view as needed when you are working in the Reservation Book.</td>
</tr>
<tr>
<td>Show</td>
<td>Show the minimum and maximum capacities next to the room description.</td>
</tr>
<tr>
<td>Capacity</td>
<td></td>
</tr>
<tr>
<td>Hide</td>
<td>Hide the vertical shadow bar that highlights the reserved and/or event start times and end times when a user moves a booking in the Reservation Book.</td>
</tr>
<tr>
<td>Booking</td>
<td></td>
</tr>
<tr>
<td>Shadow</td>
<td></td>
</tr>
</tbody>
</table>

8. To select which items to include in the **tooltip** that opens when you place the cursor over an event in the Reservation Book:
   a. Click **Options** (upper right hand corner of Reservation Book) to open the Book Options dialog box.
   b. Open the **Tooltip Display** tab and select which items to include in the tooltip that opens when you rest the mouse pointer on an event in the Reservation Book.

9. To change the display date using the **calendar**:
   a. From the **Date** field, click the drop-down arrow to open the Calendar.
   b. Use the (< and >) scroll features at the top of the calendar to change the month or use the (>) scroll features at the top of the calendar to change the year.
   c. To select a different date for a month, click the date.
10. To change the display date using the Reservation Book **scroll features:**
   a. Use the scroll features at the top of the reservation book display to scroll to a different day, week, month, or any different combination of these.
   b. To reset the display immediately to the current day’s date, click **Today**.

**TO VIEW RESERVATION INFORMATION**

1. On the EMS toolbar, click the **Book** icon. The Reservation Book opens in the Daily view.
2. To view the reservation in the Navigator, double-click the middle bar for the reservation entry or right-click the reservation entry and on the context menu that opens, click **Open**.
3. You can view the reservation information in the following ways:
   - View the **bookings** for a room
   - View the **properties** for a room
   - View the **pricing** for a booked room
   - View the **setup** information, event information, or teardown information for a reservation.
4. To view the bookings for a room:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box. The tab on this dialog box lists all the bookings for the selected room based on the current view (Daily, Weekly,
Monthly) and on the date that is shown in the Date field.

b. To view a booking in the Navigator, select the booking, and then click Open.

5. To view room properties:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box.
   b. Open the Room tab. The tab on this dialog box lists all the properties for the room, such as the room code, the room name, the room classification, etc. It also lists the setup type and capacity for the room, and any notes that have been entered for the room.

6. To view the pricing for a booked room:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box.
   b. Open the Pricing tab. This tab displays any pricing information that was defined for the room.

7. To view the room setup information, event information, or teardown information for a reservation:
   a. Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A tooltip showing the respective setup, event, or teardown information opens.
   b. If buildings that are located in multiple time zones are currently displayed, you can specify the time zone in which to view all of your bookings.
TO MAKE A NEW RESERVATION

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.
2. Change the display to show the room for which you are making the reservation.
3. Select the date for which you are making the reservation.
4. In the Time Grid for the room, click and hold the left mouse button, drag the mouse to schedule the room and time, and then release the mouse button to open the Reservation Wizard. See Create a Reservation in the Reservation Wizard.

TO EDIT AN EXISTING RESERVATION

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.
2. Optionally, you can do one or more of the following to edit an existing reservation:

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the setup time for a reservation</td>
<td>Drag the left bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the event time</td>
<td>Drag the middle bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>Click Yes in the Confirm Change dialog box.</td>
</tr>
</tbody>
</table>
### Change the teardown time for a reservation

- Drag the right bar horizontally to a new time.
- Click Yes in the Confirm Change dialog box.

### Edit the reservation building, room, time, or both

- Drag and drop the reservation to a new room that is the same building or in a different building, and/or to a new time.
- Click Yes in the Confirm Change dialog box.

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the context menu that opens, select one of the following:

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a reservation in the EMS Navigator.</td>
</tr>
<tr>
<td>Move Forward</td>
<td>Move the reservation date forward by one day or one week.</td>
</tr>
<tr>
<td>Move Backward</td>
<td>Move the reservation date backward by one day or one week.</td>
</tr>
<tr>
<td>Move to a Specific Date</td>
<td>Move the reservation to a specific date.</td>
</tr>
<tr>
<td>Change Status</td>
<td>Change the status of the reservation.</td>
</tr>
<tr>
<td>Copy Bookings</td>
<td>N/A</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Swap Rooms With Another Booking</td>
<td>Swap the room assignments of two events. The swap option is applicable only for two events that have identical meeting patterns.</td>
</tr>
<tr>
<td>Highlight Related Reservations</td>
<td>Highlights the bookings that belong to the same reservation.</td>
</tr>
</tbody>
</table>

**NOTE:** Although this option is available on the context menu for a reservation, its associated functionality is currently under development.
CHAPTER 19: Edit Reservations in the Reservations Book

1. Begin by locating a booking in the Reservation Book.

2. You can do one or more of the following to edit an existing reservation:

<table>
<thead>
<tr>
<th>STEP</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the setup time</td>
<td>Drag the left bar horizontally to a new time, then click Yes.</td>
</tr>
<tr>
<td>Change the event time</td>
<td>Drag the middle bar horizontally to a new time, then click Yes.</td>
</tr>
<tr>
<td>Change the teardown time</td>
<td>Drag the right bar horizontally to a new time, then click Yes.</td>
</tr>
<tr>
<td>Change the building, room,</td>
<td>Drag and drop the reservation to a new room that is the same building</td>
</tr>
<tr>
<td>time, or both</td>
<td>or in a different building, and/or to a new time, the click Yes.</td>
</tr>
</tbody>
</table>

3. Right-click on a reservation in the Reservation Book to access a menu of editing options (defined below).
### OPTION

<table>
<thead>
<tr>
<th>OPTION</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a reservation in the EMS Navigator.</td>
</tr>
<tr>
<td>Add To Personal Calendar</td>
<td>Adds the reservation to your personal calendar.</td>
</tr>
<tr>
<td>Send Invitation</td>
<td></td>
</tr>
<tr>
<td>Move Forward</td>
<td>Move the reservation date forward by one day or one week.</td>
</tr>
<tr>
<td>Move Backward</td>
<td>Move the reservation date back by one day or one week.</td>
</tr>
<tr>
<td>Move To Specific Date</td>
<td>Move the reservation to a specific date.</td>
</tr>
<tr>
<td>Change Status</td>
<td>Change the status of the reservation.</td>
</tr>
<tr>
<td>Copy Bookings</td>
<td>Opens the Copy Bookings wizard.</td>
</tr>
<tr>
<td>Swap Rooms With Another Booking (EMS)</td>
<td>Swap the room assignments of two events (only applicable)</td>
</tr>
</tbody>
</table>
### Option Description

**for two events that have identical meeting patterns). Right-click on one of the two reservations that you are swapping, and on the context menu that opens, click Swap Rooms, click on the other reservation, then click Yes.** Note: If the rooms that you are swapping have been configured with a default setup type, and the setup count is not within the capacity of one or both rooms, a message opens indicating this, but you are not prevented from swapping rooms.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Swap Rooms With Another Booking (EMS Academic Planning)</strong></td>
<td>Swaps only the two bookings selected for the indicated day. (Just like Swap Rooms With Another Booking in EMS.)</td>
</tr>
<tr>
<td><strong>Swap Rooms With Another Course (EMS Academic Planning)</strong></td>
<td>If the meeting patterns of two courses are identical, then the swap is allowed and all bookings between the two courses for the entire term are swapped.</td>
</tr>
<tr>
<td><strong>Highlight Related Bookings</strong></td>
<td>Highlights the bookings that belong to the same reservation.</td>
</tr>
<tr>
<td><strong>Check In</strong></td>
<td>Check into the booking.</td>
</tr>
</tbody>
</table>
CHAPTER 20: Import a List of Visitors to a Meeting

To import a list of visitors to a meeting, you will

- Ensure your list of visitors is ready for import.
- Navigate to the meeting you want to work with.
- Import your list of visitors.
- Select the meetings within the reservation to which to add your list of visitors.
- Confirm and finalize.

1. Your list of visitors must be a tab-delimited spreadsheet that contains the information (in the order listed) for the visitors you want to import. Each visitor must be a separate line entry.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
<th>REQUIRED/OPTIONAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitor</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>Text. 50 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Email Address</td>
<td>Text. 255 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
<td>REQUIRED/OPTIONAL</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Phone</td>
<td>Text. 50 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Notes</td>
<td>Text. No maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Name</td>
<td>Text. 50 characters maximum.</td>
<td>Required</td>
</tr>
</tbody>
</table>

**TIP:** You can click **Print Format** on the second page of the Add Booking Details Wizard (described below) to see the required format for the tab-delimited file.

2. Open the reservation from the Reservation Book.
3. In the left pane of the Navigator window that opens, select the meeting for which you are importing the list of attendees/visitors, and in the Bookings pane on the right, click Tools, and then select Add Booking Details Wizard.
4. The Add Booking Details wizard opens.
5. Select Visitors or Attendees, and then click Next.

6. The second page of the Add Booking Details Wizard opens with a blank row for adding an attendee/visitor to the event.

7. Click Import. The Open File dialog box opens. Browse to and select your visitor list spreadsheet, and then click Import to import the file. The Add Booking Details Wizard is updated with the imported attendee/visitor information. Each imported visitor is a separate line entry in the Wizard.
8. Click **Next**. The Select Bookings window opens, listing all the bookings within the selected reservation with a date on or after the current day’s date, *and* that do not already have the visitor list added.

   ![Select Bookings Window](image)

   **TIP:** To show canceled bookings, clear the Hide Canceled Bookings checkbox. To hide them, select the option. To show all bookings regardless of date, clear the Hide Old Bookings option.

9. Select the meetings to which to add your visitor list (use CTRL+click or Select All to select multiple meetings), and then click **Finish**.

10. A message opens asking you if you want to add more booking details. Click **No**.

11. A message opens indicating that the changes were made successfully. Click **OK** to close the message and return to the Navigator. The booking detail (Visitors) and its items (visitors) are displayed as folders under the appropriate booking folders in the Navigator.
CHAPTER 21: The Navigator

The Navigator is the window in EMS that you use to view and manage all aspects of a reservation including bookings and booking details.

This section includes the following:
» Overview of the Navigator
» Edit a Reservation in the Navigator
» Add Bookings to a Reservation in the Navigator
» Copy a Reservation in the Navigator
» Change the Status of a Reservation in the Navigator
» Reprice Categories and Room Charges for a Reservation in the Navigator
» Apply a Reservation Discount
» Edit a Booking in the Navigator
» Edit Multiple Bookings in the Navigator
» Move Bookings to a Different Reservation in the Navigator
» Copy Multiple Bookings in the Navigator
» Booking Details and Items Overview
  » Add Booking Details and Items to Individual Bookings
  » Add Booking Details and Items to Multiple Bookings
  » Edit Booking Detail Items for Individual Bookings
  » Copy Booking Details Between Bookings
  » Delete Booking Detail Items from Multiple Bookings
  » Edit Charges for Multiple Billable Item
  » Edit Count Information for a Booking in the Navigator
  » Add Booking Details Wizard
  » Copy Booking Details Wizard
  » Delete Booking Details Wizard
  » Delete Item Wizard
  » Add Item Wizard
» Comments and Reminders in the Navigator
  » Add Multiple Comments and Reminders to a Reservation

» User-Defined Fields in the Navigator
» Attachments in the Navigator
» Drawings in the Navigator
» Resource Utility Conflicts Tool
» Approve or Deny Reservation Requests
CHAPTER 22: Navigator Overview

This section provides an overview of opening a reservation in the Navigator, the Navigator's layout and folder structure, and the commands that are available in the Navigator.

This topic provides information on the following:

- Open a Reservation in the Navigator
- Open a Reservation through the Reservation Book
- Open a Reservation through a Group
- Open a Reservation through a Search
- Layout and Folder Structure
  - Reservation Folder
    - Allocate Charges to Multiple Billing Reference Numbers and/or PO Numbers
  - Booking Folder
  - Booking Detail Folder
OPEN A RESERVATION IN THE NAVIGATOR

After you create a new reservation using the Reservation Wizard, the reservation opens automatically in the Navigator. You can also manually open the Navigator by:

» Selecting a reservation, booking, or service order to open directly in the Navigator. See steps below.
» Opening a reservation through the Reservation Book. See Also: Open a reservation through the Reservation Book.
» Opening a reservation through a group. See Also: Open a reservation through a group.
» Opening a reservation through a search. See Also: Open a reservation through a search.

1. On the toolbar, click the Navigator icon to open the Open Navigator dialog box.
2. On the Open drop-down list, select the item that you are opening: reservation, booking, or service order.

3. Do one of the following:
   - In the No. field, enter the number for the reservation, service order, or booking, and then click OK.
   - To enter the last reservation, booking, or service order that you made during your current or last EMS session, double-click in the field, and then click OK.
NOTE: If you do not know the reservation number, you can search for the reservation. On the Open Navigator dialog box, click Browse to open the Browser.

OPEN A RESERVATION THROUGH THE RESERVATION BOOK

On the toolbar, click the Book icon to open the Reservation Book, and then in the Reservation Book, double-click a booking for the reservation to open the reservation in the Navigator. See Also: View and Edit Reservations in the Reservation Book.

OPEN A RESERVATION THROUGH A GROUP

You can search for a reservation for a group and open the reservation in the Navigator from the group-specific window. See Also: Reservations for a Group.

OPEN A RESERVATION THROUGH A SEARCH

You can search for a reservation using the Browser, the Web Reservation Tool, and/or the Calendar, and then double-clicking the search result entry to open the reservation in the Navigator.
TIP: You can also click Browse on the Open Navigator dialog box to open the Browser search tool.

LAYOUT AND FOLDER STRUCTURE

The Navigator has three panes: left pane, a top right pane, and a bottom left pane. The left pane displays a selected reservation, all the bookings for the reservation, and the details for each booking in a Windows Explorer-style folder structure. The top-level folder is the reservation folder. The folders that are located beneath a reservation folder are the booking folders. The folders that are located beneath a booking folder are the booking detail folders. The top right pane of the Navigator displays different tabs and options depending on the folder or item that is selected in the left pane of the Navigator. The bottom right pane of the Navigator functions just like a browser window (See Also: Getting Started with EMS), and it also displays different information and options depending on the folder or item that is selected in the left pane.
RESERVATION FOLDER

A reservation folder contains the *who* and the *what* information for the reservation. When you select a reservation folder in the left pane of the Navigator, the reservation number is displayed in the title bar of the Navigator, and the following tabs are displayed in the upper right pane of the Navigator:

» **Reservation Summary tab**—The Reservation Summary displays information about the selected reservation, including the event name, the group for which the reservation was made, the group contact name, the group contact phone number, and the reservation number.

» **Properties tab**—The Properties tab displays not only the same information as the Reservation Summary tab, but also information such as the event type, the second group contact, the date that the reservation was added, the date that the reservation was changed, and so on.
» **Billing Reference Allocation tab**—By default, the charge for a reservation is allocated to a single billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a reservation to multiple billing reference numbers by percentage. See Also: *Allocating charges to multiple billing reference numbers and/or PO numbers*.

**TIP:** Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab to be displayed. See Also: [EMS System Parameters](#).

» **PO Number Allocation tab**—By default, the charge for a reservation is allocated to a single purchase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reservation to multiple billing PO numbers by percentage. See Also: *Allocating Charges to Multiple Billing Reference Numbers and/or PO Numbers*.

**TIP:** Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be displayed. See Also: [EMS System Parameters](#).

» **Reminders tab**—The Reminders tab displays any reminders that were created for the selected reservation. See Also: *Comments and Reminders in the Navigator*.

---

**EMS Software © 2018 / V44.1 / Page 119**
Comments—The Comments tab displays any text entries that were made for the selected reservation. See Also: Comments and Reminders in the Navigator.

Attachments tab—The Attachments tab displays any attachments (files) that have been saved with the reservation. See Also: Attachments in the Navigator.

User Defined Fields—The User Defined Fields tab displays the additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields. See Also: User Defined Fields in the Navigator.

Transactions—The Transactions tab displays any invoices that were generated for the selected reservation or any payments that were applied to the selected reservation. See Billing, for detailed information about invoices and other financial transactions in EMS.

History tab—The History tab displays the history for the reservation: the date that a change was made to the reservation, the ID of the user who made the change, the field that was changed, the old field value, and the new field value.

Emails tab—The Emails tab displays any summarizing information for any emails that were sent via SMTP to the group for whom the reservation was made. See Also: Sending Email from EMS.

Also, when you select a reservation folder:

All the tabs in the upper pane of the window have some of the basic features of an EMS browser window. You can change the width of the data columns, you can sort the data columns on a tab in either ascending or descending sort order, and you
can rearrange the column order by dragging a column to a new location using the column heading. See Also: EMS Browser Window.

The bookings for the selected reservation are displayed in the Bookings pane (the lower right pane) of the Navigator. The colored rectangle to the left of a booking indicates the booking's status. If a booking has been canceled, a Canceled icon is displayed on the booking folder in both the Reservation (left) pane and the Bookings pane.

You can right-click in the upper pane and open a context menu with options for emailing the group for which the reservation was made, or the first contact for the group.

**ALLOCATE CHARGES TO MULTIPLE BILLING REFERENCE NUMBERS AND/OR PO NUMBERS**

**TIP:** The following procedure details how to allocate a reservation charge to multiple billing reference numbers; however, by analogy, you can follow this procedure to allocate booking charges or booking detail charges to multiple billing reference numbers and/or PO numbers.

1. For a selected reservation, open the Billing Reference Allocation tab, and then click Edit. The Billing Reference Allocation dialog box opens. By default, when this dialog box first opens, it displays the charge for the reservation allocated 100% to a single billing reference number placeholder.
2. Select the billing reference number placeholder, and then click Edit. The Split Billing Add dialog box opens.
3. Do one of the following:

» Enter the billing reference number to which you are allocating the reservation charges, and then click OK. The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with the newly added billing reference number allocated at 100%. Continue to Step 5.

» Click the Search icon to open a Billing References dialog box, and then do one of the following:

» Select a billing reference number from the list, click Select, and then click OK.

» In the Find field, enter a search string, and then click Display to display a list of all billing reference numbers that meet your search criteria. Select the appropriate billing reference number from the search results, click Select, and then click OK.

» The Billing References dialog box closes. You return to the Split Billing Add dialog box with the selected billing reference number displayed in the dialog box.

**TIP:** Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive, and it can appear anywhere in the search results. For example, a search string of 445 returns both 123.445.678 and 445.678.123.
4. Click OK. The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with the selected billing reference number allocated at 100%.

5. Do one of the following:
   
   » To allocate the reservation charges to only this single billing reference number, click OK. The Billing Reference Allocation dialog box closes and you return to the Navigator. The newly added billing reference number, allocated at 100%, is displayed on the Billing Reference Allocation tab.

   » To allocate the reservation charges to multiple billing reference numbers.


![Split Billing Add dialog box]

7. Do one of the following:

   » In the Billing Reference field, enter a billing reference number, and then click OK.
Click the Search icon to open a Billing References dialog box, and then do one of the following:

- Select a billing reference number from the list, click Select, and then click OK.
- In the Find field, enter a search string, and then click Display to display a list of all billing reference numbers that meet your search criteria. Select the appropriate billing reference number from the search results, click Select, and then click OK.

**TIP:** Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive, and it can appear anywhere in the search results. For example, a search string of 445 returns both 123.445.678 and 445.678.123.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with each of the newly added billing reference numbers displayed with a 0% allocation.

8. Repeat Step 6 and Step 7 until you have added all the needed billing reference numbers.
9. For each new billing reference number, double-click in the Percent field to select the percent, and then change the percent to the appropriate value.

**NOTE:** The percentages must add up to 100%.

10. Click OK to close the Billing Reference Allocation dialog box and return to the Billing Reference Allocation tab. All the billing reference numbers and their percent allocations are displayed on the tab.

**BOOKING FOLDER**

Booking folders contain the *where* and *when* information for the reservation. If you can expand a booking folder, this indicates that details have been added to the booking. The booking details for the selected booking are displayed in the Booking Details pane (the lower right pane) of the Navigator. A green background for a booking detail folder indicates that one or more booking detail items have been invoiced for the booking.
When you select a booking folder in the left pane of the Navigator, the booking number is displayed in the title bar of the Navigator, and the following tabs are displayed in the upper right pane of the Navigator:

» **Booking Summary tab**—The Booking Summary displays information about the selected booking, including the event date, the reserved time, the event time, and so on. If you use Outlook as your email program, you can do the following from this tab:
To add the selected booking to your personal calendar, click Outlook > Add to Personal Calendar.

To send invitations for the meeting to one or more contacts in your Outlook Address Book, click Outlook > Send Invitation.

Properties tab—The Properties tab displays not only the same information as the Booking Summary tab, but also information such as the event type, the setup count, the date that the booking was added, the date that the booking was changed, and so on.

Billing Reference Allocation tab—By default, the charge for a booking is allocated to a single billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a booking to multiple billing reference numbers by percentage. See Also: Allocating charges to multiple billing reference numbers and/or PO numbers.

TIP: Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab to be displayed. See Also: EMS System Parameters.

PO Number Allocation tab—By default, the charge for a booking is located to a single purchase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reservation to multiple billing PO numbers by percentage. See Also: Allocating Charges to Multiple Billing Reference Numbers and/or PO numbers.
**TIP:** Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be displayed. See Also: [EMS System Parameters](#).

**Reminders tab**—The Reminders tab displays any reminders that were created for the selected booking. See Also: [Comments and Reminders in the Navigator](#).

**Attachments**—The Attachments tab displays any attachments that were saved with the booking. See Also: [Attachments in the Navigator](#).

**Comments**—The Comments tab displays any comments that were made for the selected booking. See Also: [Comments and Reminders in the Navigator](#).

**Drawings**—The Drawings tab displays a list of files that were attached to the selected booking. See Also: [Drawings in the Navigator](#).

**History**—The History tab displays a list of changes made for the selected booking: the date the change was made to the booking, the user who made the change to the booking, and information (field) that was changed for the booking.

Also, when you select a booking folder, all the tabs in the upper pane of the window have some of the same basic features of an EMS browser window. You can change the width of the data columns, you can sort the data columns on a tab in either ascending or descending sort order, and you can rearrange the column order by dragging a column to a new location using the column heading.
BOOKING DETAIL FOLDER

If you can expand a booking folder, this indicates that details have been added to the booking. Booking details, which are also called categories, are the services (catering, A/V equipment, and so on), notes, attendees, activities, and room charges that you can add to a booking.
TIP: Booking detail folders and booking detail items are discussed in Booking Details and Items Overview.

NAVIGATOR COMMANDS

The Navigator has two constant commands in the upper left hand corner: Open Reservation and View Alerts and three constant commands in the upper right hand corner: Print, Refresh, and Settings.

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Reservation</td>
<td>Allows you to open and work with multiple reservations in the same Navigator session. See Opening a reservation directly in the Navigator.</td>
</tr>
<tr>
<td>View Alerts</td>
<td>Open and view any alerts that have been generated for the selected reservation, booking, or a booking detail that is a service order or catering category.</td>
</tr>
<tr>
<td>Print</td>
<td>➤ Printing an invoice or a confirmation at the reservation level. See Confirmations.</td>
</tr>
<tr>
<td></td>
<td>➤ Printing the Setup Worksheet for Reservation report, the Service Orders report, and the Banquet Event Order report. See Reports and Queries.</td>
</tr>
<tr>
<td></td>
<td>➤ Printing the history of a reservation, all its bookings, and all its booking detail items.</td>
</tr>
<tr>
<td>Refresh</td>
<td>For refreshing the Navigator display based on the settings that you have specified in the Navigator Options</td>
</tr>
<tr>
<td>COMMAND</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Settings</td>
<td>Options—Opens the Navigator Options dialog box in which you can specify such things as what is to be displayed in the Navigator, mouse actions in the Navigator, and so on.</td>
</tr>
<tr>
<td></td>
<td>Confirmation Settings—Opens the Confirmation Settings dialog box which provides a variety of options that you can specify for manual and automatic generation of a confirmation for a reservation or a booking. See Also: Confirmations</td>
</tr>
</tbody>
</table>

All other navigator commands are available as buttons in the upper right pane and lower right pane of the Navigator.

**NAVIGATOR OPTIONS DIALOG BOX**

The Navigator Options dialog box has three tabs: General, At a Glance, and Highlight Categories.

**GENERAL TAB**

General tab—On the General tab, you select the options for such things as which types of bookings to show in the Navigator (old bookings and/or canceled bookings), the result of double-clicking a listed folder (opens the item or expands the folder), the booking time that is displayed (reserved time or event time), and the highlight color for invoiced items.
**Navigator Options dialog box, General tab**

![Navigator Options dialog box]

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Show Old Bookings</td>
<td>Show bookings in the Navigator that occurred before the current day's date.</td>
</tr>
</tbody>
</table>
### FIELD | DESCRIPTION
---|---
Show Canceled Bookings | Selected, show bookings in the Navigator with a canceled status.
Show Wizards in Tools menu | Show all on the Tools menu in the Bookings pane. If cleared, show only the "Wizards" option, which you must click to open a form from which you can select a tool.
Show Deleted Item | Show all deleted items (bookings, deleted resource items, and so on) for a reservation in the Navigator.
Hide Empty Tabs | Hide the tabs that do not have any data displayed on them for a selected reservation, booking, or booking detail.

**Double-Clicking a Listed Folder**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the item</td>
<td>Opens the item for editing.</td>
</tr>
<tr>
<td>Expands folder</td>
<td>Opens the next level of folders.</td>
</tr>
</tbody>
</table>

**Wizard Results**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Show</td>
<td>Show a confirmation of all changes, regardless if they were successful, on a Wizard Results page.</td>
</tr>
<tr>
<td>Show Unchanged Only</td>
<td>Show only those changes that were not successful on a Wizard Results page.</td>
</tr>
</tbody>
</table>

**Confirmation**
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always prompt</td>
<td>When you click Confirmation, opens a Confirmation filter which you can use to change the default filter options for a confirmation before generating it.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>When you click Confirmation, opens an onscreen preview of the confirmation.</td>
</tr>
<tr>
<td>Email</td>
<td>When you click Confirmation, opens an email of the confirmation.</td>
</tr>
<tr>
<td>Print</td>
<td>When you click Confirmation, prints an immediate confirmation.</td>
</tr>
</tbody>
</table>

**Booking Display Time**

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved Time</td>
<td>Show the total time for which the space is reserved. This time is the event time plus the setup/teardown times.</td>
</tr>
<tr>
<td>Event Time</td>
<td>Show only the event time for which the space is reserved.</td>
</tr>
<tr>
<td>Invoiced Items</td>
<td></td>
</tr>
<tr>
<td>Highlight Color</td>
<td>The color with which invoiced items are highlighted in the Navigator window.</td>
</tr>
</tbody>
</table>

**Service Orders**

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Pricing</td>
<td>Show pricing on a service order.</td>
</tr>
<tr>
<td>Show Item Notes</td>
<td>Show item notes on a service order.</td>
</tr>
</tbody>
</table>
### AT A GLANCE TAB

On the At A Glance tab, you specify whether reminders, comments, attachments, and so on are to be displayed in the left pane of the Navigator when a reservation folder, booking folder, booking detail folder, and/or booking detail item is opened.

**Navigator Options dialog box, At a Glance tab**
HIGHLIGHT CATEGORIES TAB

On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all booking detail item folders for the selected booking detail. The default is to Highlight All, which means every booking detail item folder for every booking detail is denoted with a checkmark.

Navigator Options dialog box, Highlight Categories tab
OTHER NAVIGATOR COMMANDS

All other Navigator commands are available as buttons in the upper right pane and lower right pane of the Navigator. The buttons that are available are dynamically updated based not only on the folder or item that is currently selected in the left pane of the Navigator, but also on the tab that is open in the upper right pane of the Navigator.
Buttons available in the Navigator window with a reservation folder selected

Buttons available in the Navigator window with a booking folder selected
Buttons available in the Navigator window with a booking detail folder selected
Many of these same commands are also available on a context menu, which is a menu that opens when you right-click on a folder or item in the Navigator. All the context menus that are available in the Navigator offer a limited set of choices based on the folder or item that is selected in the Navigator.
Comparing context menus
CHAPTER 22: Navigator Overview

Booking Detail context menu

Booking Detail Item context menu
CHAPTER 23: Get Familiar with the Navigator

The Navigator is the master page you use to view a reservation and all its details. It launches from many areas of EMS Desktop Client.

To familiarize with the Navigator, this topic provides information on how to do the following:

- Open a reservation in the Navigator
- Review the Navigator's layout and folder structure
- Learn the commands available on the Navigator
Navigator in EMS Desktop Client
CHAPTER 23: Get Familiar with the Navigator

EMS Reservation Navigator

The Reservation Navigator is accessed by opening a reservation through the Reservation Book, Reservation Navigator, Browser, or the Dashboard.

Reservation Summary Information

Booking Summary Information

NOTE: What you click in the left-hand pane drives what you see in the rest of the window.
OPENING A RESERVATION IN THE NAVIGATOR

After you create a new reservation using the Reservation Wizard, the reservation opens automatically in the Navigator. To open an existing reservation, follow the steps below.

1. On the toolbar, click the **Navigator** icon. The Open Navigator dialog box.

**Open Navigator Dialog Box**
2. On the Open drop-down, select the item that you are opening—reservation, booking, or service order.

3. Do one of the following:
   - In the Reservation No. field, enter the reservation ID, service order number, or booking ID, and then click **OK**.
   - To see the last reservation, booking, or service order that you made during your current or last EMS session, double-click in the field, and then click **OK**.

**TIP:** If you do not know the reservation number, you can search for the reservation. On the Open Navigator dialog box, click **Browse** to open the Browser, and then find your reservation.

**OPENING A RESERVATION FROM THE RESERVATION BOOK**

On the toolbar, click the **Book** icon to open the Reservation Book, and then in the Reservation Book, double-click a reservation; this opens the reservation in the Navigator.
OPENING A RESERVATION THROUGH A GROUP

You can search for a reservation made for a group or individual user from the Groups icon; this opens the reservation in the Navigator.

OPENING A RESERVATION USING A SEARCH

You can search for a reservation using the Browser, the Web Reservation Tool, and/or the Calendar. Double-clicking the search result entry will open the reservation in the Navigator. You can also click Browse on the Open Navigator dialog box to open the Browser search tool.

LAYOUT AND FOLDER STRUCTURE

The Navigator has three panes:

1. The left pane displays a selected reservation, all the bookings for the reservation, and the details for each booking in a hierarchical folder structure. The top-level folder is the reservation folder. The folders that are located beneath a reservation folder are the booking folders. The folders that are located beneath a booking folder are the booking detail folders.

2. The top right pane of the Navigator displays different tabs and options depending on the folder or item that you click on in the left pane.
3. The bottom right pane of the Navigator functions just like a browser window, and shows different information and options depending on the folder or item you click on in the left pane.

**Navigator Panes (Reservation Folder Selected)**

![Reservation Folder](image)

**RESERVATION FOLDER**

A reservation folder contains the who and the what information for the reservation. When you select a reservation folder in the left pane of the Navigator, the reservation number is displayed in the title bar of the Navigator. You can change the width of the data columns, you can sort the data columns on a tab in either ascending or descending sort order, and you can rearrange the column...
order by dragging a column to a new location using the column heading. When you select a reservation folder, the bookings for the selected reservation show in the Bookings pane (the lower right pane) of the Navigator. The colored rectangle to the left of a booking indicates the booking's status. If a booking has been canceled, a Canceled icon is displayed on the booking folder in both the Reservation (left) pane and the Bookings pane. You can right-click in the upper pane and open a context menu with options for emailing the group for which the reservation was made, or the first contact for the group.

When you select a Reservation folder, the following tabs are displayed in the upper right pane of the Navigator:

» Reservation Summary Tab
» Properties Tab
» Billing Reference/PO Allocation Tab
» Reminders Tab
» Attachments Tab
» Comments Tab
» User Defined Fields Tab
» Transactions Tab
» Emails Tab
RESERVATION SUMMARY TAB

The Reservation Summary displays information about the selected reservation, including the event name, the group for which the reservation was made, the group contact name, the group contact phone number, and the reservation number.

PROPERTIES TAB

The Properties tab displays not only the same information as the Reservation Summary tab, but also information such as the event type, the second group contact, the date that the reservation was added, the date that the reservation was changed, and so on.

BILLING REFERENCE/PO ALLOCATION TAB

By default, the charge for a booking is allocated to a single billing reference number and/or a single purchase order (PO) number. This tab enables you to allocate booking charges or booking detail charges to multiple billing reference numbers and/or PO numbers. Your EMS administrator must enable the "Use Billing Reference Allocation" and "Use PO Number Allocation" parameters for this tab to be displayed.

See Also: Allocating Multiple Billing and PO Numbers For a Reservation.
REMINDERS TAB

The Reminders tab displays any reminders that were created for the selected reservation.

ATTACHMENTS TAB

The Attachments tab displays any attachments that were saved with the reservation.

COMMENTS TAB

The Comments tab displays any comments that were made for the selected reservation.

HISTORY TAB

The History tab displays a list of changes made for the selected booking: the date the change was made to the booking, the user who made the change to the booking, and information (field) that was changed for the booking.

USER DEFINED FIELDS TAB

The User Defined Fields tab displays the additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are
available as well as the allowed values for these fields. See Also: Working with User Defined Fields.

TRANSACTIONS TAB

The Transactions tab displays any invoices that were generated for the selected reservation or any payments that were applied to the selected reservation.

EMAILS TAB

The Emails tab summarizes any emails that were sent via SMTP to the group for whom the reservation was made. This does not include notifications and other communications done using EMS for Outlook or by other means.

BOOKING FOLDER

Booking folders contain the where and when information for the reservation. If you can expand a booking folder, this indicates that details have been added to the booking. The booking details for the selected booking are displayed in the Booking Details pane (the lower right pane) of the Navigator. A green background for a booking detail folder indicates that one or more booking detail items have been invoiced for the booking.
Navigator with Booking Folder Selected

When you select a booking folder in the left pane of the Navigator, the booking number is displayed in the title bar of the Navigator. You can change the width of the data columns, you can sort the data columns on a tab in either ascending or descending sort order, and you can rearrange the column order by dragging a column to a new location using the column heading.

When you select a Booking folder, the following tabs are displayed in the upper right pane of the Navigator:

» Booking Summary Tab
» Properties Tab
» Billing Reference/PO Allocation Tab
BOOKING SUMMARY TAB

The Booking Summary displays information about the selected booking, including the event date, the reserved time, the event time, and so on. If you use Outlook as your email program, you can use this tab to add the selected booking to your personal calendar (click Outlook > Add to Personal Calendar) or send invitations for the meeting to one or more contacts in your Outlook Address Book (click Outlook > Send Invitation).

PROPERTIES TAB

The Properties tab displays not only the same information as the Booking Summary tab, but also information such as the event type, the setup count, the date that the booking was added, the date that the booking was changed, and so on.

BILLING REFERENCE/PO ALLOCATION TAB

By default, the charge for a booking is allocated to a single billing reference number and/or a single purchase order (PO) number. This tab
enables you to allocate booking charges or booking detail charges to multiple billing reference numbers and/or PO numbers. Your EMS administrator must enable the "Use Billing Reference Allocation" and "Use PO Number Allocation" parameters for this tab to be displayed.

See Also: Allocating Multiple Billing and PO Numbers For a Reservation.

REMINDERS TAB

The Reminders tab displays any reminders that were created for the selected booking.

ATTACHMENTS TAB

The Attachments tab displays any attachments that were saved with the booking.

COMMENTS TAB

The Comments tab displays any comments that were made for the selected booking.
DRAWINGS TAB

The Drawings tab displays a list of files that were attached to the selected booking.

HISTORY TAB

The History tab displays a list of changes made for the selected booking—the date the change was made to the booking, the user who made the change to the booking, and information (field) that was changed for the booking.

BOOKING DETAIL FOLDER

If you can expand a booking folder, this indicates that details have been added to the booking. Booking details, which are also called categories, are the services (catering, A/V equipment, and so on), notes, attendees, activities, and room charges that you can add to a booking.
Navigator with Booking Detail Folder Selected

See Also: Adding Services to a Meeting

NAVIGATOR COMMANDS

The Navigator has two constant commands in the upper left corner: Open Reservation and View Alerts. The Navigator also has three constant commands in the upper right corner: Print, Refresh, and Settings.

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Reservation</td>
<td>Allows you to open and work with multiple reservations in the same Navigator session.</td>
</tr>
</tbody>
</table>
### COMMAND | DESCRIPTION
--- | ---
View Alerts | Open and view any alerts that have been generated for the selected reservation, booking, or a booking detail that is a service order or catering category.

Print | - Printing an invoice or a confirmation at the reservation level.
- Printing the Setup Worksheet for Reservation report, the Service Orders report, and the Banquet Event Order report.
- Printing the Transaction report.
- Printing the history of a reservation, all its bookings, and all its booking detail items.

Refresh | For refreshing the Navigator display based on the settings that you have specified in the Navigator Options dialog box.

Settings | - Options—Opens the Navigator Options dialog box in which you can specify such things as what is to be displayed in the Navigator, mouse actions in the Navigator, and so on.
- Confirmation Settings—Opens the Confirmation Settings dialog box which provides a variety of options that you can specify for manual and automatic generation of a confirmation for a reservation or a booking.

All other navigator commands are available as buttons in the upper right pane and lower right pane of the Navigator.

**NAVIGATOR OPTIONS**

The Navigator Options (click in the upper right corner) has three tabs:
1. **General**

2. **At A Glance**

3. **Highlight Categories**

**GENERAL TAB**

On the **General** tab, you select the options for such things as which types of bookings to show in the Navigator (old bookings and/or canceled bookings), the result of double-clicking a listed folder (opens the item or expands the folder), the booking time that is displayed (reserved time or event time), and the highlight color for invoiced items.
**Navigator Options Dialog Box, General Tab**

![Image of Navigator Options Dialog Box]

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GENERAL</strong></td>
<td></td>
</tr>
<tr>
<td>Show Old Bookings</td>
<td>Show bookings in the Navigator that occurred before the current day's date.</td>
</tr>
<tr>
<td>Show Canceled Bookings</td>
<td>Selected, show bookings in the Navigator with a canceled status.</td>
</tr>
<tr>
<td>Show Wizards in Tools</td>
<td>Show all on the Tools menu in the Bookings pane. If cleared, show only the</td>
</tr>
<tr>
<td>menu</td>
<td>Wizards option, which you must click to open a form from which you can</td>
</tr>
<tr>
<td></td>
<td>select a tool.</td>
</tr>
</tbody>
</table>
## FIELD

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Deleted Items</td>
<td>Show all deleted items (bookings, deleted resource items, and so on) for a reservation in the Navigator.</td>
</tr>
<tr>
<td>Hide Empty Tabs</td>
<td>Hide the tabs that do not have any data displayed on them for a selected reservation, booking, or booking detail.</td>
</tr>
</tbody>
</table>

### DOUBLE-CLICKING A LISTED FOLDER

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the item</td>
<td>Opens the item for editing.</td>
</tr>
<tr>
<td>Expands folder</td>
<td>Opens the next level of folders.</td>
</tr>
</tbody>
</table>

### WIZARD RESULTS

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Show</td>
<td>Show a confirmation of all changes, regardless if they were successful, on a Wizard Results page.</td>
</tr>
<tr>
<td>Show Unchanged Only</td>
<td>Show only those changes that were not successful on a Wizard Results page.</td>
</tr>
</tbody>
</table>

### CONFIRMATION

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always prompt</td>
<td>When you click Confirmation, opens a Confirmation filter which you can use to change the default filter options for a confirmation before generating it.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>When you click Confirmation, opens an onscreen preview of the confirmation.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email</td>
<td>When you click Confirmation, opens an email of the confirmation.</td>
</tr>
<tr>
<td>Print</td>
<td>When you click Confirmation, prints an immediate confirmation.</td>
</tr>
<tr>
<td>Booking Display Time</td>
<td></td>
</tr>
<tr>
<td>Reserved Time</td>
<td>Show the total time for which the space is reserved. This time is the event time plus the setup/teardown times.</td>
</tr>
<tr>
<td>Event Time</td>
<td>Show only the event time for which the space is reserved.</td>
</tr>
<tr>
<td>INVOICED ITEMS</td>
<td></td>
</tr>
<tr>
<td>Highlight Color</td>
<td>The color with which invoiced items are highlighted in the Navigator window.</td>
</tr>
<tr>
<td>SERVICE ORDERS</td>
<td></td>
</tr>
<tr>
<td>Show Pricing</td>
<td>Show pricing on a service order.</td>
</tr>
<tr>
<td>Show Item Notes</td>
<td>Show item notes on a service order.</td>
</tr>
<tr>
<td>Show Item Special Instructions</td>
<td>Show special instructions for items on a service order.</td>
</tr>
<tr>
<td>Highlight Changes Made</td>
<td>Highlight any changes that have been made to a service order within the specified number of days.</td>
</tr>
</tbody>
</table>
### Footer Message

Show reconfigured blocks of text that appear in footer of a service order (for example, a Cancellation policy).

#### BOOKING EDIT

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Adjust Reserved Time</td>
<td>If the reservation includes setup and/or teardown times, then automatically adjust</td>
</tr>
<tr>
<td>Time When Event Time is Changed</td>
<td>the total time for the reservation (the event time plus the setup/teardown time) when the event time is changed.</td>
</tr>
</tbody>
</table>

### AT A GLANCE TAB

On the **At A Glance** tab, you specify whether reminders, comments, attachments, and so on are to be displayed in the left pane of the Navigator when a reservation folder, booking folder, booking detail folder, and/or booking detail item is opened.
Navigator Options Dialog Box, At A Glance Tab

HIGHLIGHT CATEGORIES

On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all booking detail item folders for the selected booking detail. The default is to Highlight All, which means every booking detail item folder for every booking detail is denoted with a checkmark.
CHAPTER 23: Get Familiar with the Navigator

*Navigator Options Dialog Box, Highlight Categories Tab*

![Image of Navigator Options Dialog Box]

**OTHER NAVIGATOR COMMANDS**

All other Navigator commands are available as buttons in the upper right pane and lower right pane of the Navigator. The buttons that are available are dynamically updated based not only on the folder or item that is currently selected in the left pane of the Navigator, but also on the tab that is open in the upper right pane of the Navigator.
Buttons available in the Navigator window with a reservation folder selected

Buttons available in the Navigator window with a booking folder selected
Buttons available in the Navigator window with a booking detail folder selected
Many of these same commands are also available on a context menu, which is a menu that opens when you right-click on a folder or item in the Navigator. All the context menus that are available in the Navigator offer a limited set of choices based on the folder or item that is selected in the Navigator.

*Comparing context menus*
CHAPTER 24: Edit a Reservation in the Navigator

When you edit a reservation in the Navigator, you are working with the who and the what information for the event: the event name, the group name, and so on. When you edit a reservation, you can edit the reservation information (event name, event coordinator, and so on), and you can edit the billing information (pricing plan, payment type, and so on).

Tip: When you edit a reservation, if you select a different pricing plan, that plan is applied at the reservation level only; categories and room charges are not automatically repriced. To reprice your categories or room charges based on a new pricing plan, you use the Update Pricing Plan wizard.

See Also: Repricing Categories and Room Charges for a Reservation.

1. Open the reservation in the Navigator.
2. In left pane the Navigator, select the reservation that you are editing, and then on the Reservation Summary tab or on the Properties tab, click Edit. The Reservation window opens. The Reservation tab is the active tab.
3. Edit information on the Reservation and Billing Information tabs as needed.
Tip: If you select a different pricing plan, then the pricing plan is applied at the reservation level only. Categories and room charges are not automatically repriced. To reprice your categories or room charges based on a new pricing plan, you must use the Update Pricing Plan Wizard.

4. Click OK. The Reservation window closes and you return to the Navigator, which now shows the updated information for the reservation.
CHAPTER 25: Add Bookings to a Reservation in the Navigator

You can use the Navigator to add one or more bookings to an existing reservation.

1. Open the reservation in the Navigator. See Navigator Overview.
2. In the left pane of the Navigator, select the reservation to which you are adding the bookings, and then in the Bookings pane, click New. The Reservation Wizard opens.

See Also: Create a Reservation in the Reservation Wizard.
CHAPTER 26: Copy a Reservation in the Navigator

You can make a new reservation easily by copying an existing one and then make any necessary changes to it. When you copy an existing reservation, you must provide a new start date and a new status, however, you can copy existing reservation reminders, comments, user-defined fields, and drawings "as-is," and you can copy one or more or all the existing booking details.

1. Open the reservation in the Navigator.
2. In the left pane of the Navigator, select the reservation you want to copy, and then in the right pane, click Tools, and then click Copy Reservation Wizard.
3. The Copy Reservation Wizard opens.
4. Enter the information for the new reservation.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION/COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Start Date</td>
<td>The date of the first booking for the new reservation.</td>
</tr>
<tr>
<td>New Status</td>
<td>The status for the new reservation.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION/COMMENTS</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>Enter a date if it is required for the new status that you selected.</td>
</tr>
<tr>
<td>Conflict Status</td>
<td>Enter a conflict status in the event that the new bookings are in conflict with any existing bookings.</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>Enter a date if it is required for the new conflict status that you selected.</td>
</tr>
<tr>
<td>Copy Reminders</td>
<td>Leave the appropriate options selected to copy the existing items &quot;as-is,&quot; or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Comments</td>
<td></td>
</tr>
<tr>
<td>Copy User</td>
<td></td>
</tr>
<tr>
<td>Defined Fields</td>
<td></td>
</tr>
<tr>
<td>Copy Attachments</td>
<td></td>
</tr>
<tr>
<td>Copy Drawings</td>
<td></td>
</tr>
<tr>
<td>Copy Booking</td>
<td>Select the booking details that are being copied (CTRL-click to select multiple details) or to select all the details for copying, click Select All.</td>
</tr>
<tr>
<td>Details</td>
<td>Note: By default, only active booking details are displayed. To show inactive booking details for copying, click Show Inactive.</td>
</tr>
<tr>
<td>Copy Inactive</td>
<td>Selected by default. Copies the inactive resource and/or rooms from the existing reservation to the new reservation. Clear this option if you do not want to copy the inactive resources and rooms.</td>
</tr>
</tbody>
</table>
5. Click Next. The Select Bookings window opens. This window displays all the bookings for the reservation that you are copying.

Tip: You can use the Hide Canceled Bookings option to show or hide canceled bookings. To show all bookings regardless of date, clear Hide Old Bookings.

Tip: The start date that you specified becomes the date of the first booking for the new reservation. Once you copy bookings for this reservation, they are scheduled according to the same pattern as the existing reservation. For example, if the existing reservation has three bookings and each booking was
scheduled every seven days (12/14, 12/21, and 12/28), and the start date for the new reservation is 12/15, then the new reservation has three bookings with dates of 12/15, 12/22, and 12/29.

6. Select the booking(s) you want to recreating in the new reservation (or click Select All to select all the displayed bookings in a single step), and then click Finish. A message opens indicating that the changes were made successfully.

Tip: When you copy multiple bookings, the bookings are simply copied and pasted "as-is;" the bookings are not moved to a different location. If you need to move a booking to a different location, see Changing Rooms for Bookings.

7. Click OK to close the message and return to the Navigator. Both the existing reservation and the new reservation are now listed in the left pane of the Navigator. The new reservation is assigned a number based on the next available reservation number in the database. If any of the new bookings are in conflict with existing bookings, this conflict is indicated in the Navigator.
CHAPTER 27: Change the Status for a Reservation from the Reservation Summary Tab

Even though the Change Booking Status Wizard is available for changing the status of multiple bookings in a reservation, most reservationists who approve reservations that are submitted from Web App do so by using the Change Status function that is available on the Reservation Summary tab in the Navigator. This is because unlike the Change Booking Status Wizard, when you use the Change Status function in the Navigator to change the status of a reservation, an option is available for automatically generating and sending a confirmation to the group for whom the reservation was made.

**TIP:** Your EMS administrator must grant you the appropriate security access to change the status of a booking, which includes canceling a booking. If you want to change the status of a booking using the Change Booking Status Wizard, see [Editing Multiple Bookings in the Navigator](#).
TIP: An email can be automatically generated and sent only if Email is selected for the Confirmation setting on the General tab of the Navigator Options dialog box, and if the group for which the reservation was made has an email address in its record. See Navigator Options dialog box and Search for and Configure Groups.

TO CHANGE THE STATUS FOR A RESERVATION

1. Open the reservation in the Navigator. See:
   - Open a reservation directly in the Navigator
   - Open a reservation through the Reservation Book
   - Open a reservation through a group
   - Open a reservation through search

2. In left pane in the Navigator, select the reservation that you are editing, and then on the Reservation Summary tab, click Change Status. The Change Booking Status window opens.
3. On the Status drop-down list, select the new status for the bookings.

**TIP:** If you select any type of Canceled status, then three additional fields—Reason, Who Canceled and Notes—are displayed on the Change Booking Status window. You must enter data in all three of these fields before you can continue in the Wizard.
4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, do one or both of the following:
   
   » Leave **Update Reservation Status** selected to have the reservation-level status changed as well.
   
   » Select **Send Confirmation If Successful** to have an email automatically generated and sent to the group for whom the reservation was made.

   **TIP:** The confirmation is generated based on the system confirmation settings that you have specified. See **Specifying your Confirmation Settings**.

6. Click **Next**. The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day's date and that do not have invoiced items. By default, all the bookings are selected.
CHAPTER 27: Change the Status for a Reservation from the Reservation Summary Tab

TIP: To show canceled bookings, clear Hide Canceled Bookings. Conversely, to hide canceled bookings, select Hide Canceled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

7. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the status, and then click Finish. The Change Booking Status Results window opens. This window lists all the bookings for the reservation, whether the status was successfully changed or not.
TIP: Optionally, to view only the bookings for the selected reservation that were NOT successfully changed, select **Show Unchanged Only**. To view the details for a specific booking that was changed, select the booking, and then click **Go To**.

8. Click Close to close the Change Status Results window and return to the Navigator.
**WARNING:** If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens onscreen. If you close this report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator, select **Tools > Resource Inventory Conflict**.
CHAPTER 28: Reprice Categories and Room Charges for a Reservation

When you edit a reservation, changes to the pricing plan are applied at the reservation-level only. Booking level service categories and room charges are not automatically repriced. To reprice services or room charges based on a new pricing plan, use the Update Pricing Plan Wizard shown here.

**NOTE:** You can reprice a room charge for a booking only if the room charge has not been invoiced. To reprice a room charge that has been invoiced, you must first **void the invoice**.

Additionally, you can also [Edit Charges for Multiple Billable Items](#).

1. **Open the parent reservation in the Navigator.**
2. In left pane the Navigator, select the reservation or booking with which you want to work, and then on the **Reservation Summary** tab, click **Update Pricing**.
3. The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is displayed in the Pricing Plan field. The window displays all the service categories and room charges that can be repriced in one or more of the reservation bookings.
**TIP:** If the reservation has other optional Pricing Plans, you can change the list using the drop-down field at the top.

4. Select a service category or room charge (CTRL-click to select multiple items) to reprice and click **Next**.
5. The next window lists all bookings under the reservation that have one or more of the selected service categories or room charges that you can reprice.

![Update Pricing Plan Wizard](image)

6. Select the booking(s) for which you want to apply the repricing (you can click **Select All** to select all the displayed bookings in a single step), and then click **Finish**. A message confirms your changes.

7. Click **OK** to close the message and return to the Navigator.
CHAPTER 29: Apply a Reservation Discount

You use the Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced details in a booking. The discount is applied as a percentage of the total charge for an item and it is added to any existing discounts that have already been applied to the item.

TIP: To apply a discount to invoiced items, you must first void the invoice.
See Void an invoice.

1. Open the reservation in the Navigator. See:
   » Open a reservation directly in the Navigator
   » Open a reservation through the Reservation Book
   » Open a reservation through a group

2. In the left pane of the Navigator, select the reservation to which you are applying the discount.
3. In the Bookings pane, click Tools, and then click Apply Reservation Discount. The Apply Reservation Discount window opens. All the bookings for the selected reservation with their categories that have not been invoiced are displayed.

4. Leave the Category set to the default value of (all), or optionally, to apply a discount to all the items in a specific category, on the Category drop-down list, select a category. The Apply Reservation Discount window is updated with the bookings.
that have the selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are applying the discount, or click **Select All** to select all the displayed bookings in a single step, and then click **Finish**. A message appears indicating that the changes were made successfully.

8. Click **OK** to close the message and return to the Navigator.

After you apply a reservation discount, you can view it and/or edit it when you are editing the reservation on the **Billing Information** tab of the Reservation window in the Navigator. See **Edit a Reservation in the Navigator**.
CHAPTER 30: Edit a Booking in the Navigator

When you edit a booking in the Navigator, you are working with the when and where information for the event: the event time, the event location, and so on. To edit a booking, you must have the appropriate security access. For example, you cannot move a booking to a room if your EMS administrator has not granted you access to the room. Likewise, you cannot change the status for a booking from Tentative to Confirmed if your EMS administrator has not granted you access to the Confirmed status. If you cannot change a booking and you have appropriate permissions, it might be locked.

See Also: To edit billable information for a booking, see Edit Booking Detail Item Charges for Multiple Items.

**TIP:** Remember, you can also edit certain booking information in the Reservation Book.
1. **Open the Navigator.**

2. In left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible. Select the booking you want to change; the panes on the right refresh to show information for the booking. On the Booking Summary tab or on the Properties tab, click Edit.

3. The Booking window opens. A message is displayed at the top of the window that indicates the hours for the building that contains the selected room. If the booking has any type of booking detail assigned to it, then "This Booking has Service Orders" is displayed at the top of the window.
TIP: If you have access, you can change the status of a booking, including canceling a booking.

» If you change the status for a booking, you can select Update Reservation Status to change the reservation-level status to match.

» If you edit a video conference, any date and time changes you make to the booking automatically cascade to all related bookings.

4. On the Booking tab, edit the information for the booking as needed, and then click OK.
If you edited anything other than the date, time, or location for a booking, the Booking window closes and you return to the Navigator, which now shows the updated information for the booking.

If you cancel a booking, a Cancel Status dialog box opens in which you must identify the user who canceled the booking and provide notes (for example, a cancellation reason) about the cancellation.

If you edited the date, time, or location for a booking, a dialog box opens, warning you that critical booking information has changed and asking you if you want to continue. Click Yes. The Booking window closes and you return to the Navigator, which now shows the updated information for the booking. If you reserved a resource, a Resource Inventory Conflicts report then opens. If you close this report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
CHAPTER 31: Edit Multiple Bookings in the Navigator

This topic guides you in using the wizards available from the Navigator to make the same changes to multiple bookings at once. To edit billable information for a booking, see Editing Charges for Multiple Items.

This topic will also provide information on:

» Changing the Booking Date/Time
» Changing Booking Status
» Changing Rooms
» Changing Miscellaneous Information

EDIT MULTIPLE BOOKINGS

1. Open the Navigator.

2. Select the booking(s) on the left pane that you want to apply the same change(s).
   The Tools menu offers several wizards to help you batch-edit the bookings with the same changes.
CHAPTER 31: Edit Multiple Bookings in the Navigator

CHANGING THE BOOKING DATE/TIME

1. In the Bookings pane, click Tools > Change Booking Date/Time Wizard. In the window that presents, make changes using the field definitions below.
### Field: Date

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No changes</td>
<td>The default value.</td>
</tr>
<tr>
<td>Reschedule Booking</td>
<td>Reschedule the bookings to an earlier date that is based on the number of days that you specify.</td>
</tr>
<tr>
<td>Earlier</td>
<td></td>
</tr>
<tr>
<td>Reschedule Booking</td>
<td>Reschedule the bookings to a later date based on the number of days that you specify.</td>
</tr>
<tr>
<td>Later</td>
<td></td>
</tr>
<tr>
<td>Reschedule Booking to</td>
<td>Reschedule the bookings to a new date that you specify.</td>
</tr>
<tr>
<td>Specific Date</td>
<td></td>
</tr>
<tr>
<td>FIELD</td>
<td>VALUE</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Time</td>
<td>No changes</td>
</tr>
<tr>
<td></td>
<td>End Booking Earlier</td>
</tr>
<tr>
<td></td>
<td>End Booking Later</td>
</tr>
<tr>
<td></td>
<td>Reschedule Booking</td>
</tr>
<tr>
<td></td>
<td>Reschedule Booking Later</td>
</tr>
<tr>
<td></td>
<td>Reschedule Booking to</td>
</tr>
<tr>
<td>Specific Time</td>
<td>Reserved Start</td>
</tr>
<tr>
<td></td>
<td>Event Start</td>
</tr>
<tr>
<td></td>
<td>Event End</td>
</tr>
<tr>
<td></td>
<td>Reserved End</td>
</tr>
<tr>
<td></td>
<td>Set Setup/Teardown</td>
</tr>
</tbody>
</table>
### FIELD | VALUE | DESCRIPTION
--- | --- | ---
 |  | minutes that you specify. |
 |  | Start Booking Earlier | Resets the event start time and the reserved start time to an earlier time, based on the number of hours that you specify. |
 |  | Start Booking Later | Resets the event start time and the reserved start time to a later time, based on the number of hours that you specify. |

2. Click Next. The Select Bookings window opens, showing all current and future bookings for the selected reservation so you can select which ones to which to apply the date/time change.
Tip: To show canceled bookings, clear Hide Canceled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

3. Select bookings to which to apply the date/time change and then click Finish. The Change Booking Date/Time Results window opens to show the new changes.

4. Click Close to return to the Navigator.

CHANGING BOOKING STATUS

If authorized, you can change the status of multiple bookings using the Change Booking Status Wizard (includes canceling a booking). If you change the status for a booking, you can quickly change the parent reservation status to match.

Tip: If you select any type of Canceled status, three additional required fields present: Reason, Who Canceled and Notes. For status changes to bookings, you can leave Update Reservation Status selected to change the parent reservation status to match. You can select Send Confirmation If Successful to trigger an email to the group or individual for whom the reservation was made (depending on your Confirmation Settings).
2. Enter a Reconfirm Date (if required) for the new status you selected.
3. Click Next. The Select Bookings window opens, listing all the current and upcoming bookings for the reservation that do not have invoiced items. By default, all the bookings are selected. To show canceled bookings, clear Hide Canceled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

4. Select the booking(s) for which you want to change the status, and then click Finish. The Change Booking Status Results window to show booking status changes for this reservation.
Tips: To see only bookings that were not changed, select Show Unchanged Only. To view the details for a specific booking that was changed, select the booking, and then click Go To. If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens when you Close this window. You can manually run a Resource Inventory Conflict report: in the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.

5. Click Close to close the Change Status Results wizard and return to the Navigator.

CHANGING ROOMS

1. In the Bookings pane, click Tools > Change Room Wizard. The Change Room Wizard opens, where you can specify whether you want to search for rooms or only change to a specific room.
Tip: Clicking Search for Rooms changes this workflow to present you with a list of all available rooms that match your search criteria later in these steps. Clicking Specific Room means you can search for a room using the Search icon. In this case, you will not need to select from a list of rooms later.

2. Once you select the new room, the Change Rooms window refreshes so you apply detailed changes to the bookings.

Tips: In the left pane, select the bookings you want to move to a new room. In the right pane, change the building, the room specifications, the status, the room features, or any combination of these as needed for the selected bookings, and then click Next.

3. If prompted, enter a new setup count. Make sure that this count is the maximum that you expect the new room to hold. You can apply the following options: Update Setup Type on Selected Bookings and/or Update Setup Count On Selected Bookings (use Minimum).

4. To apply the same status change to the parent reservation, select Update Reservation Status.

5. Click Next. The Change Room Wizard is refreshed with an Available tab (if you selected Search for Rooms initially, and if applicable, a Conflicts tab).
a. The Available tab shows available rooms that match your criteria, and contains two panes. The left pane lists all the rooms that meet some or all of your event criteria. The right pane lists all the event dates that must be fulfilled.

b. The Conflicts tab lists rooms (if any) that were not available due to booking conflicts.

Tip: You can click Room Info to see room properties, setup type, features, and pricing, or Building Hours to see when the selected room/building is open.

6. Select from the list of available rooms and use the arrow buttons to move them to the right pane.

7. When you have fulfilled all dates, click Finish
8. Once you confirm your changes, the Change Rooms Results window opens to show your changes.

![Change Rooms Results window]

9. Click Close to return to the Navigator.

**CHANGING MISCELLANEOUS INFORMATION**

For multiple bookings, you can batch-change the event name, the event type, the setup type, the setup count, and the attendance.

1. In the Bookings pane, click Tools > Change Miscellaneous Booking Information Wizard. The Change Miscellaneous Booking Information Wizard opens.
2. Select the information to change, enter new values, and then click Next. The Select Bookings window shows the bookings to which you can apply these changes.
3. Select bookings to which to apply the changes then click Finish. A message opens, indicating that the changes were made successfully.

4. Click OK to close the message and return to the Navigator.
CHAPTER 32: Move Bookings to a Different Reservation in the Navigator

You use the Move Bookings Wizard to move one or more bookings that do not have invoiced items from a selected reservation to an existing reservation or to an entirely new reservation.

Note: When you move a booking, the booking and all its associated details are removed entirely from the original reservation.

1. Open the reservation in the Navigator.
2. In the left pane of the Navigator, select the reservation from which you are moving the bookings. In the pane on the right, click Tools, and then click Move Bookings Wizard.
3. The Move Bookings Wizard opens with the option to move the bookings to an Existing Reservation pre-selected. You can enter the reservation number of an Existing Reservation or start a New Reservation.

4. Click Next. The Select Bookings window displays, listing the bookings for the selected reservation that do not have invoiced items.
5. Select the booking(s) you want to move to the new or existing reservation (you can click Select All to select all the displayed bookings in a single step), and then click Finish. A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator, which now shows both the old reservation and the new or existing reservation in the left pane of the Navigator. Any conflicts that arise are indicated in the Navigator.

Tip: You can use the Hide Canceled Bookings and Hide Old Bookings options to adjust the list.
CHAPTER 33: Copy Multiple Bookings in the Navigator

You use the Copy Bookings Wizard to copy one or more bookings to a new date or to a set of dates, either within the same reservation or to a new reservation.

1. Open the Navigator.
2. In the left pane of the Navigator, select the reservation from which you are copying the bookings.
3. In the Bookings pane, click Tools, and then click Copy Bookings Wizard. The Copy Bookings Wizard opens with Copy to Reservation No. automatically selected; the number for the reservation from which you are copying the bookings is displayed in the field.
4. You can copy the bookings to an existing reservation (click the Search icon to search for the reservation) or copy the bookings to a new reservation (click Copy to New Reservation).

5. Enter the information for the reservation to which you are copying the bookings.

<table>
<thead>
<tr>
<th>INFORMATION</th>
<th>DESCRIPTION/COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Start Date</td>
<td>The date of the first booking for the new reservation.</td>
</tr>
<tr>
<td>New Status</td>
<td>The status for the new reservation.</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>Enter if required for the new status that you selected.</td>
</tr>
<tr>
<td>Conflict Status</td>
<td>You must enter a conflict status in the event that the new bookings are in conflict with the existing</td>
</tr>
<tr>
<td>INFORMATION</td>
<td>DESCRIPTION/COMMENTS</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>bookings.</td>
<td></td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>Enter if required for the new conflict status that you selected.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy Reminders</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Comments</td>
<td></td>
</tr>
<tr>
<td>Copy User Defined Fields</td>
<td></td>
</tr>
<tr>
<td>Copy Attachments</td>
<td></td>
</tr>
<tr>
<td>Copy Drawings</td>
<td></td>
</tr>
<tr>
<td>Copy Booking Details</td>
<td>Select the booking details that are being copied (CTRL-click to select multiple details) or to select all the details for copying, click Select All.</td>
</tr>
<tr>
<td></td>
<td>Note: By default, only active booking details are displayed. To show inactive booking details for copying, click Show Inactive.</td>
</tr>
<tr>
<td>Copy Inactive Resources/Rooms</td>
<td>Selected by default. Copies the inactive resource and/or rooms from the existing bookings to the new bookings. Clear this option if you do not want to copy the inactive resources and rooms.</td>
</tr>
</tbody>
</table>
6. Click Next. The Select Bookings window opens, listing all the bookings for the copied reservation, regardless of the date or status.

Tips: You can use the Hide Canceled Bookings and Hide Old Bookings options to adjust the data. The start date you specify becomes the date of the first new booking. In addition, the copied bookings are scheduled according to the same pattern as the existing reservation. For example, if the existing reservation has three bookings and each booking was scheduled every seven days (12/14, 12/21, and 12/28), and the new start date for the first booking is 12/18, then the existing or new reservation has three bookings with dates of 12/15, 12/22, and 12/29.
7. Select the booking(s) that you want to copy to the existing or new reservation (you can click Select All to select all the displayed bookings in a single step), and then click Finish. A message confirms that the changes were made successfully.

Tip: When you copy multiple bookings, they are simply copied and pasted "as-is": bookings are not moved to a different location. If you need to move a booking to a different location, see Changing Rooms for Multiple Bookings.

8. Click OK to close the message and return to the Navigator. The reservation from which you copied the bookings and the reservation to which you copied the bookings are displayed in the left pane of the Navigator. If you moved the bookings to a new reservation, then the new reservation that is created is assigned the next available reservation number in the database. If any of the new bookings are in conflict with bookings in the existing reservation, this conflict is indicated in the Navigator.
CHAPTER 34: Booking Details and Items Overview

Booking details, which are also called categories, are the services (catering, A/V equipment, and so on), notes, attendees, activities, or room charges that you can add to a booking. Booking detail items, also called resources, are the individual items (coffee, sandwich, projector, and so on) that you add to a booking detail. When you add a resource to a booking, for example, coffee, various selections might be available or required, for example, regular, decaf, Italian roast, breakfast blend, and so on. Depending on how your EMS administrator has configured your categories, a resource might require service order times to be specified.

**TIP:** Your EMS administrator can configure buildings and categories so that a particular category can be used only in a particular building or buildings. This means that when you are adding booking details to a reservation, some booking details (categories) might not be displayed as an option.

The booking details for a selected booking are displayed in the Booking Details pane (the lower right pane) of the Navigator.
TIP: Categories that contain resources, but do not require service times are referred to as "resource categories." Categories that contain resources and that require service times are referred to as "service order categories." Categories that are used to manage food service are referred to as "catering categories." Categories that are used to manage miscellaneous notes (setup notes), agenda items, attendees/visitors, or room charges are referred to as "non-resource categories."

*The Navigator Window with a Booking Folder Selected*
If you select a booking detail folder that is for a Resource with Service Order category or a Catering category, then the service order number is displayed in the title bar of the Navigator.

*The Navigator Window With a Booking Detail Folder Selected*

When you select a booking detail folder in the left pane of the Navigator, the tabs that are displayed in the upper right pane of the Navigator depend on the type of booking detail that you selected.

» <Booking Details> **Summary** tab—The Summary displays information about the selected booking detail, including the event date, the event location, and the event status.
» **Properties** tab—The Properties tab also displays information about the booking detail, including the date that it was added to the booking, who added the detail, and, if applicable, the date that the detail was changed and who made the change.

If the booking detail has a price/charge associated with it, for example, a room charge, then the following two tabs are also displayed:

» **Billing Reference Allocation** tab—By default, the charge for a booking detail can be allocated to a single billing reference number. On the **Billing Reference Allocation** tab, you can allocate the charge for a reservation to multiple billing reference numbers by percentage. See Also: *Allocating charges to multiple billing reference numbers and/or PO numbers.*

**TIP:** Your EMS administrator must enable the **Use Billing Reference Allocation** parameter for this tab to be displayed. See Also: *EMS Desktop Client Parameters.*

» **PO Number Allocation** tab—By default, the charge for a booking detail can be allocated to a single purchase order (PO) number. On the **PO Number Allocation** tab, you can allocate the charge for a reservation to multiple billing PO numbers by percentage. See Also: *Allocating charges to multiple billing reference numbers and/or PO numbers.*
TIP: Your EMS administrator must enable the **Use PO Number Allocation** parameter for this tab to be displayed. See Also: [EMS Desktop Client Parameters](#).

**SERVICE ORDER**

If the selected booking detail requires a service order or catering category, then the following four tabs are also displayed:

- **User Defined Fields** tab—The User Defined Fields tab displays the additional fields that store custom data for the booking detail. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields. See Also: [User Defined Fields in the Navigator](#).
- **Reminders** tab—The Reminders tab displays any reminders that were created for the selected booking detail. See Also: [Comments and Reminders in the Navigator](#).
- **Comments** tab—The Comments tab displays any comments that were made for the selected booking detail. See [Comments and Reminders in the Navigator](#).
- **History** tab—The History tab displays the history for the booking detail (the date that a change was made to the detail, the ID of the user who made the change, the field that was changed, the old field value, and the new field value).

Also, when you select a booking detail folder:
Most of the tabs in the upper pane of the window have some of the basic features of an EMS Browser window. You can change the width of the data columns, you can rearrange the column order by dragging a column to a new location using the column heading, and you can sort the data columns in either ascending or descending sort order. See Also: EMS Browser Window.

The booking detail items for the selected booking detail are displayed in the Items pane (the lower right pane) of the Navigator. A green check mark appears in front of each individual item that has been added to a booking. If the item is a package, then a green checkmark is displayed not only in front of the package, but also, in front of each individual item in the package. A red "X" is displayed in front of any booking detail and/or booking detail item that has been deleted from a booking. The Items pane has all the features of an EMS Browser window. See Also: EMS Browser Window.

If you select a booking details item in the left pane of the Navigator, then the entire right pane of the Navigator is refreshed with three tabs—Properties tab that displays for the selected item, a Selections tab that displays the selections for the booking detail item (if applicable), and a History tab that details the history of the item.
A booking detail might include a service order. A service order is a request to use the resource for a specified time period as opposed to using the resource for the entire event. For example, an event that meets from 10:00 am to 2:00 pm, might have food service from 11:00 am to noon. A service order consists of the service type, start and end times, and a unique, system-generated service order ID. For a catering booking detail, you can also indicate estimated count, guaranteed count, and actual count. You can create multiple service orders in the same booking. For example, you might have a number of catering services (breakfast, lunch, and afternoon refreshments) in the course of a one day training event. In this case, multiple folders are displayed under the booking folder.
on the left side of the Navigator window, with each folder representing a unique service order.

*The Navigator window showing multiple service orders in the same booking*

If you reserve an item from a category that does not require a service order, your only choices are to reserve the item for the event time or for the entire reserved time.

**TIP:** Your EMS administrator might have configured a default service type for some or all of your system's categories, but you can always select a different value. In addition, your EMS administrator might have configured states to manage your service order process. For detailed information about states, See Also: [Configure Categories](#).
CHAPTER 35: Add Booking Details and Items to Individual Bookings

The steps that you follow to add booking details and items to individual bookings depend on the category type. Also, you can add multiple occurrences of a booking detail to a booking only if the booking detail is a Resource with Service Order category or a Catering category. If the booking detail is not a Resource with Service Order category or a Catering category, and the detail is already added to a booking, you cannot add the detail again to the booking. You can, however, add more items to the booking detail.

TO ADD BOOKING DETAILS AND ITEMS TO INDIVIDUAL BOOKINGS

1. Open the reservation in the Navigator. Refer to the following for directions:
   
   » Opening a reservation directly in the Navigator
   
   » Opening a reservation through the Reservation Book
» **Opening a reservation through a group**

» **Open a reservation through a search**

2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible.

3. Select the booking folder, and then in the Booking Details pane, click **New**. The Booking Details list opens.

4. Select the booking detail that you are adding to the booking. A dialog box opens.

5. Continue to one of the following:
» Add a booking detail from a non-resource category
» Add a booking detail from a resource, service order, or catering category

TO ADD A BOOKING DETAIL FROM A NON-RESOURCE CATEGORY

A booking detail that is from a non-resource category can be setup notes, attendees, agenda (activities), or a room charge.

TO ADD SETUP NOTES
1. Enter the sequence number for the setup notes.

**TIP:** The sequence number determines the order in which the notes are displayed in the Items pane in the Navigator when the booking detail (Setup Notes) is selected for a booking.

2. Enter the appropriate notes or comments.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be excluded from external reports like a confirmation), then select Internal.

4. Click OK. The Setup Notes dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

**TIP:** After you add setup notes for the first time to a booking, Setup Notes is no longer an available option on the Booking Details drop-down list. To add more setup notes to the booking, select the Setup Notes folder for the booking or click a Setup Note in the Items pane, and then click New.

TO ADD ATTENDEES

*Attendees dialog box*
1. Enter the information for the attendee. At a minimum, you must enter the attendee name.

2. If the attendee is a visitor (that is, not registered for the event), then select **Visitor**.

3. Click **OK**. The Attendee dialog box remains open.

4. Repeat Step 1 through Step 3 until you have added all the needed attendees/visitors to the booking.

5. Click **Cancel**. The Attendees dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.
TIP: If you close the Attendees dialog box before you have added all the needed attendees/visitors to the booking, then Attendees is no longer an available option on the Booking Details drop-down list. To add more attendees/visitors to the booking, select the Attendees folder for the booking or click an attendee/visitor in the Items pane, and then click New.

TO ADD AN AGENDA (ACTIVITIES)

Agenda dialog box
1. Enter the start time, the end time, and a description for the agenda.
2. Optionally, in the Description field, enter a name or description for the agenda.

**TIP:** The description can be a maximum of 50 characters, including spaces.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be excluded from external reports like a confirmation), then select Internal.
4. Click **OK**. The Agenda dialog box remains open.
5. Repeat Step 1 through Step 4 until you have added all the needed agendas.
6. Click **Cancel**. The Agenda dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

**TIP:** If you close the Agenda dialog box before you have added all the needed agendas/activities to the booking, then **Agenda** is no longer an available option on the Booking Details drop-down list. To add more agenda/activities to the booking, select the Agenda folder for the booking or click an agenda in the Items pane, and then click **New**.
TO ADD A ROOM CHARGE

1. Enter the sequence number for the room charge.

   **TIP:** The sequence number determines the order in which the charges are displayed in the Items pane in the Navigator when the booking detail (Room Charge) is selected for a booking.

2. Optionally, enter notes or comments about the room charge.
3. If needed, edit the quantity.

4. Select the appropriate pricing method, and then enter any other additional information as needed after you select a pricing method.

<table>
<thead>
<tr>
<th>PRICING METHOD</th>
<th>ADDITIONAL FIELDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Unit Price</td>
</tr>
<tr>
<td>Half Day/Full Day (Event Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Reserved Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Hourly (Event Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>PRICING METHOD</td>
<td>ADDITIONAL FIELDS</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Hourly (Reserved Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Specific)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
</tbody>
</table>

5. Optionally, enter a discount percent and/or a reservation discount.
6. Click **OK**. The Room Charge dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.
TIP: If you must add multiple room charges to a booking, then after you add charges for the first time to a booking, Room Charge is no longer an available option on the Booking Details drop-down list. To add more charges to the booking, select the Room Charge folder for the booking or click a room charge in the Items pane, and then click New.

TO ADD A BOOKING DETAIL FROM A RESOURCE, SERVICE ORDER, OR CATERING CATEGORY

If you select a service order or catering category, a Service Order dialog box opens with, at a minimum, options for Service, Reviewed, Service Start Time, and End Time. If a catering category is selected, additional fields for Estimated, Guaranteed and Actual Counts are displayed. Go to Step 1 below.

*Example of a Service Order dialog box for a catering category*
If you select a resource category, then a Resource Selection dialog box opens.

The Resources tab is the active tab. Go to Step 4.

Example of a Resource Selection dialog box, Resources tab
1. Select the service type.

2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and if applicable, select Reviewed and/or a state.

   **TIP:** For more information about reviewing service orders and selecting states, see also: Search for Service Orders.

3. Click OK. A Resource Selection dialog box. The Resources tab is the active tab.
4. Do one of the following
   
   To select one or more resources from the pre-configured list of resources, leave the **Resources** tab open, and then go to Step 5.
   
   To add multiple resources to the booking in a single step, open the **Packages** tab, and then go to Step 7.

5. Do one of the following on the Grouping drop-down list:
   
   Leave the default value of (all) as is to search for all items in all groupings.
   
   Select a specific grouping to search for only those items in the grouping. For example, if the selected resource category is A/V Equipment, then available groupings could include Computer, Phone, Video, and so on. To search only for the available phones to add to a booking detail, select the Phones grouping.

6. Optionally, in the Filter field, enter a search string by which to filter your search.

   **TIP:** Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of co returns coffee service, conference phone, and mini-copier.
7. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

**TIP:** If you change the quantity for a resource package, then the quantity for each individual resource that makes up the package is also changed.

8. Do one of the following:

   » For the **Resources** tab, on the Items list, select the resource item, or CTRL-click to select the multiple resource items that you are adding to the booking.

   **TIP:** Your EMS administrator might have configured an override resource (also known as an override description) so that you can book a resource that has not been configured in your EMS database. For example, the administrator might have configured an override resource named "Other." If you select the Other resource, then a Description field is displayed on the Resource Selection dialog box. You must enter a description or name for the override resource before you can continue. EMS does not track availability of override resource items; however, EMS reports on override resource items just like any other resource item.
For the **Package** tab, select the package that contains the multiple resources that you are adding to the booking.

9. Click **Select**.

For items on the **Resources** tab, if your EMS administrator configured selections for the resource, then either you might be required to make selections for the resource, or you have the option to make selections for the resource; otherwise, go to Step 10.
Example of a Resource Selections dialog box

For packages on the Packages tab, the package is added to the booking. An entry for the package as well as entry for each item in the package is displayed in the Booking Detail Items pane of the Navigator.

10. Repeat Step 4 through Step 9 until you have added all the necessary booking detail items for the selected booking.
11. Click **Close**. The Resource Selection dialog box closes. The resource and its items are displayed as folders under the Booking folder in the Navigator.

**TIP:** If you close the Resource Selection dialog box before you have added all the needed resource items to the booking, and the booking detail is not from a catering or service order category, then the booking detail is no longer an available option on the Booking Details drop-down list. To add more resource items to the booking, you can select the Booking Detail folder for the booking or you can click a booking detail item in the Items pane, and then click **New**.
CHAPTER 36: Add Booking Details and Items to Existing Bookings

The steps that you follow to add booking details and items to individual bookings depend on the category of the item. You can only add an item more than once to a booking if it is a Resource with Service Order or Catering item.

1. **Open the Navigator.**
2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible, select the booking folder, and then in the Booking Details pane, click New. The Booking Details list opens.
**TIP:** You can also add booking details and items after the first one has been added by clicking on the booking and then clicking the Tools menu. This launches a menu with wizards to streamline the process of working with many types of details for the booking.
You can even use the Add Booking Details Wizard to add booking details and items to multiple bookings in a single step, and you can add the same detail (for service order and catering categories) to multiple bookings. The steps that you follow depend on the category type and how your Administrator has configured your system.

You can also copy booking details and items from one booking to another: right-click on the booking detail and click **Copy**. Then right-click on the booking to which the booking detail is being copied and click **Paste**.
3. Select the type of item you want to add to the booking.

4. Continue to the appropriate subtopic below:
   
   » Adding a Non-Resource Item
   » Adding a Resource, Service Order, or Catering Item

## ADDING A NON-RESOURCE ITEM

Non-resource items include:

1. Setup Notes
2. Attendees and Visitors
3. Agenda (Activities)
4. Room Charges

## ADDING SETUP NOTES

1. Select Setup Notes from the New menu, so you can new setup notes for the booking.
2. Enter the sequence number for the setup notes, which determines the order in which the notes are listed in the Items pane in the Navigator.

3. Enter notes or comments. If you want these notes to be printed on internal reports only (the notes would be excluded from external reports like a confirmation), select the Internal checkbox.

4. Click OK. The Setup Notes dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.
**TIP:** After you add setup notes for the first time to a booking, Setup Notes is no longer an available option on New menu. To add more setup notes to the booking, expand the folder hierarchy for the booking until you see existing Setup Notes, click on one, and then click New.

**ADDING ATTENDEES AND VISITORS**

Visitors are non-registered attendees who are not already in your EMS database, such as temporary building guests.
1. Select Visitor from the New menu so you can add attendees and visitors to the meeting. At a minimum, you must enter the visitor name.

2. You can select the Visitor option to flag attendees who are not registered for the event.

3. Click OK. The dialog box remains open.
4. Repeat Steps 1 through 3 until you have added all the needed attendees/visitors to the booking.

5. Click Cancel to return to the Navigator window.

**TIP:** If you close the Attendees dialog box before you have added all the needed attendees/visitors to the booking, Attendees is no longer an available option on New menu. To add more attendees/visitors to the booking, expand the folder hierarchy for the booking until you see existing Attendees/Visitors, click on one, and then click New.
ADDING AN AGENDA (ACTIVITIES)

1. Select Agenda from the New menu so you can add agendas to the meeting. Enter the information for the agenda.

2. Enter the start time, the end time for the agenda. You can enter a name or description for the agenda (maximum of 50 characters, including spaces) in the Description field. If you want these notes to be printed on internal reports only, select Internal.
3. Click OK. The Agenda dialog box remains open.
4. Repeat Steps 1 through 4 until you have added all the needed agendas.
5. Click Cancel. The Agenda dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

**TIP:** If you close the Agenda dialog box before you have added all the needed attendees/visitors to the booking, Agenda is no longer an available option on New menu. To add more agendas to the booking, expand the folder hierarchy for the booking until you see existing agendas, click on one, and then click New.
ADDING A ROOM CHARGE

1. Select Room Charge from the New menu so you can add room charges to the meeting. Enter the information for the agenda.

2. Enter the Sequence Number for the room charge, which determines the order in which the charges are listed in the Navigator. You can enter notes or comments about the room charge. If needed, edit the quantity.
3. Select the appropriate pricing method, and then enter any other additional information as needed after you select a pricing method:

<table>
<thead>
<tr>
<th>PRICING METHOD</th>
<th>ADDITIONAL FIELDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Unit Price</td>
</tr>
<tr>
<td>Half Day/Full Day (Event Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Reserved Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Hourly (Event Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Reserved Time)</td>
<td>Hourly Price</td>
</tr>
</tbody>
</table>
### PRICING METHOD

<table>
<thead>
<tr>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Charge</td>
</tr>
<tr>
<td>Maximum Charge</td>
</tr>
<tr>
<td>Initial Flat Charge</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Charge</td>
</tr>
<tr>
<td>Maximum Charge</td>
</tr>
<tr>
<td>Initial Flat Charge</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly Price</td>
</tr>
</tbody>
</table>

#### TIP: 
If you close the Room Charge dialog box before you have added all the needed attendees/visitors to the booking, Room Charge is no longer an available option on New menu. To add more room charges to the booking, expand the folder hierarchy for the booking until you see existing room charges, click on one, and then click New.
ADDING A RESOURCE, SERVICE ORDER, OR CATERING ITEM

1. From the New menu, select a resource, service order, or catering item, such as the examples shown below.
If you add a service order or catering item from the New menu, a Service Order dialog box opens with, at a minimum, options for Service, Reviewed, Service Start Time, and End Time. For catering items, additional fields display for you to enter Estimated, Guaranteed and Actual Counts.
Example of a Service Order dialog box for a catering category

*TIP:* Select the Service type and enter the Start Time. You can enter additional fields as needed.

» If you select a resource category item, then a Resource Selection dialog box opens, where you select resources to add to the booking.
Example of a Resource Selection dialog box, Resources tab
**TIP:** Your EMS administrator might have configured an override resource (also known as an Override Description) so you can book a resource that has not been configured in your EMS database. For example, the administrator might have configured an override resource named "Other." If you select the "Other" resource, then a Description field is displayed on the Resource Selection dialog box. You must enter a description or name for the override resource before you can continue. EMS does not track availability of override resource items; however, EMS reports on override resource items just like any other resource item. Furthermore, you might be able to select variations for an item.
Example of a Resource Selections Dialog Box

You can use the Grouping drop-down list to search for available items in a specific grouping, such as A/V Equipment. In the Filter field, you can add a keyword for the search.
To add multiple resources as a "Package" to the booking in a single step, click the Packages tab, choose a package, and specify how many packages to add Quantity field. If you change the quantity for a resource package, the quantity for each individual resource that makes up the package is also changed.

2. Once you have chosen items to add to the booking, click Select.
3. Repeat steps to add more items.
4. Once finished, click Close to return to the Navigator.

**TIP:** If you close the dialog box before you have added all the needed items to the booking, they no longer an available option on New menu. To add more items to the booking, expand the folder hierarchy for the booking until you see existing items, click on one, and then click New.
CHAPTER 36: Add Booking Details and Items to Existing Bookings

Navigator Dialog

![Navigator Dialog Image]
CHAPTER 37: Add Booking Detail Items to Multiple Bookings

You use the Add Item Wizard to add booking detail items to multiple bookings for categories that are already added to the bookings. For example, you can use this Wizard to add food service items only if any of the bookings already has food service added as a booking detail.

**TIP:** To add booking details and items for categories that are not already in use, see *Adding Booking Details and Items to Multiple Bookings*.

TO ADD BOOKING DETAIL ITEMS TO MULTIPLE BOOKINGS

1. Open the reservation in the Navigator. See Also:
   - Opening a reservation directly in the Navigator
   - Opening a reservation through the Reservation Book
   - Opening a reservation through a group
2. In the left pane of the Navigator, select the reservation to which you are adding the booking detail items.

3. In the Bookings pane, click **Tools**, and then click **Add Item Wizard**. The Add Item Wizard opens. The first window in this Wizard, the Select Category window, displays only those categories that are already in use for any of the bookings in the reservation.

4. Select the category to which you want to add items.

5. Click **Next**.
The steps that you now must follow depend on the category type. See Also:

» To add a booking detail from a non-resource category

» To add a booking detail from a resource, service order, or catering category
CHAPTER 38: Edit Items for Individual Bookings

1. Open the Navigator.
2. Select the booking detail folder that contains the items that you want to edit.
3. In the Items pane, select the item you want to change.

NOTE: The item cannot be invoiced. If the item is invoiced, the Edit button is not available. To edit an invoiced item, you must first void the invoice.

4. Click Edit.
   » If editing a non-resource item, the Booking Detail dialog box opens. Edit the item as necessary, and then click OK to return to the Navigator.
   » If editing a resource item, the Resource dialog box opens on the Resource tab. You might also see a Selections tab. Edit the information as necessary.
**TIP**: You can select a different item for the resource. Sequence determines the order in which the items (for example, juice, muffins, and so on) are displayed in the Items pane in the Navigator.

**Time in Use** indicates the time that the resource is to be available for the booking. You only can edit the **Time In Use** if the item is not from a resource from a service order or catering category. (The **Time in Use** is applied at the category level for these types of resources.) See Also: [Event Timeline](#).
5. If you want for notes to be printed on internal reports only, select **Internal**.

6. If you edit the pricing method, enter information as needed:

<table>
<thead>
<tr>
<th>PRICING METHOD</th>
<th>ADDITIONAL FIELDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Unit Price</td>
</tr>
<tr>
<td>Half Day/Full Day (Event Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Reserved Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Service Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Hourly (Event Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
</tbody>
</table>

Note: Available only for a resource with a service order.
<table>
<thead>
<tr>
<th>PRICING METHOD</th>
<th>ADDITIONAL FIELDS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Reserved Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Service Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Specific)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
</tbody>
</table>

Note: Available only for a resource with a service order.
7. If applicable, open the **Selection** tab, and edit the resource selections as needed.
8. Click **OK**. The dialog box closes, and you return to the Navigator with the edited item still selected in the Items pane.

**TIP:** If you need to edit counts and/or times for individual items in a resource, service order, or catering, category, see [Edit Count Information for a Booking](#).
CHAPTER 39: Copy Booking Details Between Bookings

You use the Copy Booking Details Wizard to copy the details from one booking in a reservation and paste them into other bookings for the same reservation.

COPY BOOKING DETAILS BETWEEN BOOKINGS

1. Open the reservation to which you are copying the booking details in the Navigator. See:
   - Open a reservation directly in the Navigator
   - Open a reservation through the Reservation Book
   - Open a reservation through a group

2. In the left pane of the Navigator, select the reservation from which you are copying the details.

3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard. The Copy Booking Details Wizard opens. The first window in this Wizard, the Select Booking Details to Copy window, displays all the bookings for the selected reservation, regardless of date. By default, the Copy From Reservation No. field displays the reservation number for the selected reservation.
4. Optionally, in the Copy From Reservation No. field, click the **Search** icon to open the Open Navigator dialog box and search for and select a different reservation from which to copy the booking details. The Select Booking Details to Copy window is refreshed with all the bookings details for the selected reservation.

5. Optionally, do one or both of the following:
   
   » On the Category drop-down list, select a specific category of booking details to display on the Select Booking Details to Copy window.
   
   » Leave **Copy Inactive Resources/Rooms** selected to copy this information for the bookings. Clear this option if you do not want to copy this information.
6. Select the booking, or CTRL-click to select the multiple bookings from which you are copying the booking details, and then click **Next**. The Select Bookings window opens. This window displays all the bookings with a date greater than or equal to the current day's date to which you can copy the booking details.

**TIP:** To show canceled bookings, clear **Hide Canceled Bookings**. Conversely, to hide canceled bookings, select **Hide Canceled Bookings**. To show all bookings regardless of date, clear **Hide Old Bookings**.
7. Select the booking, or CTRL-click to select the multiple bookings to which you are copying the booking details, or click Select All to select all the displayed bookings in a single step, and then click **Finish**. A message opens indicating that the changes were made successfully.

8. Click **OK** to close the message and return to the Navigator.
CHAPTER 40: Delete Booking Details from Multiple Bookings

You use the Delete Booking Details Wizard to delete one or more booking details that do not have invoiced items from multiple bookings in a single step. When you delete a booking detail from a booking, any items that have been added for the detail are also deleted.

TO DELETE BOOKING DETAILS FROM MULTIPLE BOOKINGS

1. Open the reservation from which you are deleting the booking details in the Navigator. See:
   - Open a reservation directly in the Navigator
   - Open a reservation through the Reservation Book
   - Open a reservation through a group

2. In the left pane of the Navigator, select the reservation from which you are deleting the booking details.

3. In the Bookings pane, click Tools, and then click Delete Booking Details Wizard. The Delete Booking Details Wizard opens. The first window in this
Wizard, the Select Categories window, displays all the categories (booking details) that are already in use for any of the bookings in the selected reservation.

4. Select the category, or CTRL-click to select the multiple categories that you are deleting from the reservation, or click Select All to select all categories in a single step.

5. Click Next. The Select Booking Details window opens. This page lists all the bookings for the selected reservation with a date greater than or equal to the current day's date that have the categories (booking details) that were selected for deletion but do not have any invoiced items.
6. Select the booking, or CTRL-click to select the multiple bookings from which you are deleting the categories, or click **Select All** to select all the displayed bookings in a single step, and then click Finish. A message appears indicating that the changes were made successfully.

7. Click **OK** to close the message and return to the Navigator.
CHAPTER 41: Edit Charges for Multiple Billable Items

You can edit resource quantities and billing information (price, pricing method, and so on) for individual items, or you can use the Edit Charges tool to edit this information for multiple non-invoiced items. To edit the billing information for invoiced items, you must first void the invoice. See Also: Void an Invoice and Reprice Service Categories and Room Charges for a Reservation.

1. **Open the Navigator and select the reservation** you want to work with.

2. In the left pane of the Navigator, you can edit all billable items in all the bookings for a reservation, only the billable items in a selected booking (expand the reservation folder, and under the expanded reservation folder, select the booking that contains the items that you want to edit).

3. In the Bookings/Booking Details pane, click **Tools > Edit Charges**. The Edit Charges window opens. If you selected a reservation, then all non-invoiced billable items in all the bookings for the selected reservation are displayed in the window; otherwise, only the non-invoiced billable items for the selected booking are displayed.
4. To change the quantity, pricing method, price, or discount percentage for an item, click in the field and make your changes.

5. When your changes are complete, click **Close**. Any resulting recalculations automatically execute. The Edit Charges window closes and you return to the Navigator.
CHAPTER 42: Edit Count Information for a Booking

Concept: You use this tool to change various "counts" for a booking, such as setup count, attendance count, the estimated count, guaranteed count, and actual count for a booking detail (with a category type of catering), as well as the counts for non-invoiced booking detail items. You can make similar changes in other areas of the application. The Edit Counts simply collates all count information in a single location for editing.

You can edit the counts for all bookings in a reservation or for just a selected booking.

1. Locate and select the parent reservation in the Navigator, click Tools, and then click Edit Counts.
2. The Edit Counts window shows a list of bookings under the reservation; select the booking for which you want to edit counts.
TIP: You can focus the list of counts on a Category. The middle pane is refreshed with the information for the selected category. If the category is a resource with a service order, then the pane displays the service type and the start and end times for the category. If the category is catering, then the pane also displays the estimated count, guaranteed count, and actual count for the booking detail.

3. In the middle pane, select the booking detail that contains the items for which you want to change the count. The lower pane refreshes with a list of all the non-invoiced items for the selected detail.
4. To edit the count information for any booking detail or detail item, click in the appropriate field and make the necessary edits. Repeat needed for each booking. When finished, click **Close** to return to the Navigator.
CHAPTER 43: Add Booking Details Wizard

Concept: What are Services, Categories, and Resources?

» Booking details are also called categories.
» Booking detail items, also called resources, are the individual items (coffee, sandwich, projector, and so on) that you add to a booking detail.
» A booking detail might include a service order.

If your booking template is designed so you can add details such as catering, audio/video equipment, or housekeeping to a meeting, you will see fields for these options in the details screens for the booking.

To add services, equipment, and other resources to an existing meeting, you will:

» Navigate to the event.
» Add services and so on to the event.
» Save your changes and send notifications.
» (If the request requires approval) Follow up on your service order request.

1. Open the reservation.
TIP: For an in-depth overview of Booking Details you can see for existing events in the Navigator, see Booking Details and Items Overview. This topic simply guides you in adding a service order to a booking.

2. Focus the Navigator on the booking within that reservation for which you want to add services, equipment, etc., and click the Tools button, then select Add Booking Details Wizard (your Administrator might have re-labeled this option; if it does appear, services are not allowed for this type of booking).
3. Add a Service order: In the Add Booking Details popup window that presents, select a category of service or equipment you want to add. The fields on the right panel change depending on the selection you make.
4. When you have completed the fields in the right panel, click the Next button. EMS Desktop Client advances you through the information you must enter to complete the service order. Tabs and fields that display to you vary depending on how the type of service is configured for your organization. The example below shows a catering service order that is defined to allow you to add menu items; two have been added to the right panel which indicates menu items to be included with the order (in this case, for 5 servings). The same type of window displays for other types of services such as equipment; the only difference is that the items might be human activities such as setup, teardown, opening windows, turning on lights, and so on.
**TIP**: You can add notes and other details to each menu item by selecting it and clicking the **Edit** button. Click **OK** to save such changes.
Note: If a cost is associated with an item, cost related fields will appear similar to those shown above; if you are authorized, you can change them (for example, to apply a discount). See Also: **Repricing Categories and Room Charges**.

5. Once you have finished selecting items for the service order, click the Next button. A final screen presents where you can select the bookings to which you want to apply the service order.
6. Select the booking(s) for which you want to add the service order and then click the Finish button.

7. On the confirmation popup that presents, click Yes to add more service orders, or No to finalize the service order. You return to the Navigator and the new service order appears in the lower right panel. If the service order requires an approval workflow, the state of the request shows in the State column.
Tip: You can see and work with the items (resources) requested for a service order by selecting it in the lower right panel above and then clicking the Items button.
You can click the buttons on the right to add or change items in the list. Clicking New will launch a popup window where you can add more items within this category of service. This example shows catering fields. When you have completed all required information, click OK to finalize the new item.
Once a service order has been added to a booking and you click to expand the order in the left panel, information in both the upper and lower right panel changes to show detail about that specific service order. The following four tabs show in the Navigator in the upper right panel:

- **User Defined Fields tab**—The User Defined Fields tab displays the additional fields that store custom data for the booking detail. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields. See [Working with User Defined Fields in the Navigator](#).

[Image of the Catering - Istanbul form with fields and tabs highlighted]
Reminders tab—The Reminders tab displays any reminders that were created for the selected booking detail.

Comments tab—The Comments tab displays any comments that were made for the selected booking detail.

See Working with Comments and Reminders in the Navigator.

History tab—The History tab displays the history for the booking detail (the date that a change was made to the detail, the ID of the user who made the change, the field that was changed, the old field value, and the new field value).
Also, service order items for the selected booking detail show in the Items pane in the lower right panel. A green check mark appears in front of each individual item that has been added to a booking. If the item is a package, then a green checkmark is displayed not only in front of the package, but also, in front of each individual item in the package. A red "X" is displayed in front of any booking detail and/or booking detail item that has been deleted from a booking.

If you click on a booking details item in the left pane of the Navigator, then the entire right pane of the Navigator is refreshed with three tabs: a Properties tab that displays for the selected item, a Selections tab that displays the selections for the booking detail item (if applicable), and a History tab that details the history of the item.

See Also:

» Adding Booking Details and Items to Multiple Bookings
» Editing Booking Detail Items for Individual Bookings
» Editing Booking Detail Item Charges for Multiple Items
CHAPTER 44: Copy Booking Details Wizard

You use the Copy Booking Details Wizard to copy details from one booking to another booking under the same reservation.

1. Open the parent reservation in the Navigator.
2. In left pane the Navigator, select the reservation or booking with which you want to work.
3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard.
4. The Copy Booking Details Wizard pops up, listing all the bookings for the selected reservation.
Tip: You can change the reservation from which to copy details by clicking the Search icon. You can narrow the list by selecting a Category. You can clear the Copy Inactive Resources/Rooms if you want to carry over these items.

5. Select the booking(s) for which you want to copy details and click Next.

6. The next window lists the details you can copy.
Tip: Use the Hide Canceled Bookings and Hide Old Bookings options to manipulate the list.

7. Select the booking detail(s) (you can click Select All to select all the displayed bookings in a single step), and then click Finish. A message confirms the copy.

8. Click OK to close the message and return to the Navigator.
CHAPTER 45: Delete Booking Details Wizard

You use the Delete Booking Details Wizard to delete one or more booking details that do not have invoiced items from multiple bookings in a single step. When you delete a booking detail from a booking, any items that have been added for the detail are also deleted.

1. Find and select the parent reservation in the Navigator, click Tools, and then click Delete Booking Details Wizard.
2. The first window of the Delete Booking Details Wizard lists all the categories (booking details) that are already in use for any of the bookings in the selected reservation.
3. Select the category of details you want to delete (or click **Select All** to select all categories in a single step), and click **Next**.

4. The next window lists all the bookings for the selected reservation. Select the booking(s) for which you want to delete details.
5. Once you have selected the bookings to which you want to apply the deleting, click **Finish**. A message confirms your changes.

6. Click **OK** to close the message and return to the Navigator.
CHAPTER 46: Delete Item Wizard

If you want to remove an item from a booking (and it has not already been invoiced), you can use the Delete Item Wizard to delete it. You can delete one item at a time or you can all the items for a booking detail. If you delete an item at the package level, this includes all the items in the package. You can also delete individual items from a package.

1. Open the Navigator.
2. Select the reservation that contains multiple bookings with items you want to delete, then click Tools, and then click Delete Item Wizard.
Access the Delete Item Wizard from the Navigator

3. In the first window of the wizard, select the category to which the items you want to delete belong, and then click Next; the drop-down list only shows categories for items that exist within this reservation.
4. The window refreshes to show items within this category that you can delete. The example below shows furniture resources that were added to bookings under the chosen reservation.
Resource Drop-Down List of the Delete Items Wizard

**TIP:** You can narrow the list using the Grouping field and Delete Empty Categories option.

5. Select items in the list you want to delete, then click Next.
6. The next screen lists all bookings under the reservation to which you can apply the deletion.
7. Select the booking(s) for which you want to delete the resource items (you can click Select All to select all the displayed bookings in a single step), and then click Finish. A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.
CHAPTER 47: Add Item Wizard

1. Open the Navigator and select the bookings to which you want to add the same items.

2. In the Bookings pane, click **Tools** and then click **Add Item Wizard**.
3. On the first window of the Add Item Wizard, the Select Category window displays categories that are already in use for any of the bookings in the reservation.

![Select Category Window]

4. Select the category to which you want to add items.

5. Click **Next**.

6. Proceed to one of the following:
   » [Adding non-resource category items](#)
   » [Adding resource, service order, or catering category items](#)
CHAPTER 48: Comments and Reminders in the Navigator

Concept: Comments Explain Details and Reminders Have Associated Due Dates

» A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a service order.

» A reminder is a comment that has a due date associated with it, and if it is attached to a reservation, booking, group, or service order, then it is called an attached reminder.

In the Navigator, you can add comments/reminders directly to a reservation, booking, or service order, and you can edit or delete them and view their history. When adding a comment or reminder, you can select from a pre-configured list, or you can create your own.

1. Open the parent reservation in the Navigator.

2. In left pane the Navigator, select the reservation or booking with which you want to work.

3. Click the Comments or Reminders tab to work with either.
**TIP:** If you prefer to add more than one pre-configured comment or reminder at once to the reservation, right-click on it in the left panel and choose Add Reminders and Comments. A popup window will guide you through adding multiple reminders and comments at once.

4. To delete or change or view history for an existing one, select it in the list then click Delete or Edit. (The Edit popup window provides a History tab).

5. To add a new comment or reminder, click the New button.

a. If you clicked the New button, a dialog box prompts you to enter details, like the example below.
b. On the Comment Type or Reminder Type drop-down list, select the type of comment or reminder you want to add, or select "(user-specified comment)," and enter a Description.

c. If you are creating a new reminder, set a Due Date and specify the user who should be reminded in the Responsible User field.

d. If you are creating a new comment, you can alert any EMS user when they open this reservation, booking, or service order by selecting the Alert Users option.

e. In the Notes field, enter the comment or reminder.

f. Click OK. The Comment dialog box closes. The comment is added to the reservation, booking, or service order. The Comments tab remains open.
CHAPTER 49: Add Multiple Comments and Reminders to a Reservation

When you add a comment or a reminder to a reservation from the Comments tab or Reminders tab, respectively, then you can add only a single comment or reminder at a time. To add multiple comments or reminders to a reservation in a single step, you must use an option on the context menu for reservations in the Navigator.

**TIP:** When you add multiple reminders and comments to a reservation, your only option is to select from a pre-configured list of comment types and reminder types. To add a user-specified comment type or reminder type, you must add each comment or reminder individually. See [Working with Comments and Reminders in the Navigator](#).

1. Open the reservation to which you are adding multiple comments and/or reminders in the Navigator. See:
» Opening a reservation directly in the Navigator
» Opening a reservation through the Reservation Book
» Opening a reservation through a group

2. In the left pane of the Navigator, right-click the reservation, and on the context menu that opens, click Add Reminders and Comments. The Add Reminders and Comments window opens. This window lists all the available pre-configured reminder and comment types in the Available list.

Add Reminders and Comments window
3. In the **Available** list, select the comment/reminder type, or CTRL-click to select the multiple comment/reminder types that you are adding to the reservation, and then click the Move (>) button to move the selected comment/reminder types to the **Selected** list.

4. To enter the text for the selected comment/reminder types, select a comment/reminder type in the **Selected** list, and then click **Edit**. A Notes dialog box opens in which you can enter the text for the selected comment/reminder type.

5. After you have entered the text for a selected comment/reminder type, click **OK** to close the Notes dialog box and return to the Add Reminders and Comments window.

6. Repeat Step 4 and Step 5 for each selected comment/reminder type.

7. Click **Finish**. A message appears indicating that the comment/reminder types were added successfully.

8. Click **OK** to close the message and return to the Navigator.
CHAPTER 50: User Defined Fields in the Navigator

The User Defined Fields tab displays additional fields for custom data for a reservation, booking, or a booking detail that is a service order. Your Administrator configures these fields and their allowed values. If you have permissions, you can add new User Defined Fields to a reservation or booking, edit the value for a User Defined Field, and delete User Defined Fields. You can also view the history for a User Defined Field.

1. Open the parent reservation in the Navigator.

2. In left pane the Navigator, select the reservation or booking detail with which you want to work (remember, the booking detail must be a service order), and then in the top right pane of the Navigator, click the User Defined Fields tab.
3. To change or delete an existing field, click the Edit or Delete buttons (field History is a tab under the Edit option). Use the New button to add a new one.

   a. In the User Defined Field window that appears, define values for the field.
b. Select the type of Field you are adding, an allowed Value for the field (such as a date, number, or text field). If you selected a dependent or multi-select type of field, you might need to select additional information to complete the form:

» **Multi-Select**—You will see a list of values appear below. Pick one or multiple of the choices.

» **Dependency**—You will see another box appear below with another User Defined Field. Pick the answer to that User Defined Field.

4. Click **OK** to save your changes.
CHAPTER 51: Attachments in the Navigator

Concept: An attachment is a file that you upload and store with a reservation or booking.

A drawing is different in that it is a file referenced from your database.

Tip: To add an attachment to a group record, See Configuring Additional Information for a Group.

1. Open the parent reservation in the Navigator.
2. In left pane the Navigator, select the reservation or booking with which you want to work.
3. In the top right pane of the Navigator, click the Attachments tab.
4. To work with an existing attachment, select it and use the Edit, Delete, and View buttons. To add a new attachment, click the New button.

For new attachments, in the Attachment popup window that opens, enter a Description (or leave blank to use the filename), choose a Type (if any), add your own Notes, and if you want for the attachment to show for Everyday Users, click the Display on Web option. Attach a file by clicking the Search icon. Click OK when finished.
CHAPTER 51: Attachments in the Navigator
CHAPTER 52: Drawings in the Navigator

The term drawing is used to describe a file (text-based or image file) that you can add to a booking. The file can be stored on your organization's network, or you can create a drawing "on the fly" in the default drawing program on your EMS client, and then add it to a booking. Typically, a drawing is a setup diagram of the booking room. You can also detach a drawing from a booking, and view and edit a drawing.

WORK WITH DRAWINGS IN THE NAVIGATOR

1. Open the reservation in the Navigator.
2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible, and then select the booking.
3. In the right pane of the Navigator, open the Drawing tab.
4. Continue to one of the following:
   - Attach a stored drawing to a booking
   - Create a drawing "on the fly" and attach it to a booking
   - Detach a drawing from a booking
ATTACH A STORED DRAWING TO A BOOKING

1. Click New > Attach. The Drawing dialog box opens.

2. In the Description field, enter a name or description for the drawing (maximum of 50 characters, including spaces). If you leave this field blank, then the Description field is populated with the name of the file after you attach it to the booking.
3. Click the Search icon to open the Find Drawing dialog box, and then browse to and select the drawing. The Find Drawing dialog box closes. The file name for the drawing is displayed in the Drawing field.

4. Optionally, do one or both of the following:
   - If you left the Description field blank, then the name of the attached file is used by default for the file description, and you can edit this if needed.
   - Click **Spelling** to spell check the description before you attach the drawing to the booking.

5. Click **OK**. The Drawing dialog box closes. The drawing is attached to the booking. The **Drawing** tab remains open.

CREATE A DRAWING "ON THE FLY" AND ATTACH IT TO A BOOKING

1. Click **New > Create**. The application you selected as your default drawing application for your EMS client opens, for example, Microsoft Paint.

   **TIP:** You specify your default drawing application in your user preferences. See **Set User Preferences and Default Values**.

2. Create and save the drawing.
DETACH A DRAWING FROM A BOOKING

1. Select the drawing, or CTRL-click to select the multiple drawings that you are detaching from the booking.
2. Click Detach. A message appears asking you if it is OK to detach the selected drawings.
3. Click Yes. The selected drawings are detached from the booking. The Drawing tab remains open.

EDIT A DRAWING FOR A BOOKING

1. Select the drawing that you are editing, and then click Edit. The Drawing dialog box opens.
2. Do one or both of the following as needed:
   » Edit the description (maximum of 50 characters, including spaces).
   » Click the Search icon to open the Find Drawing dialog box and scroll to and select a different drawing.
3. Optionally, click Spelling to spell check the description before you attach the drawing to the booking.
4. Click OK. The Drawing dialog box closes. The Drawing tab remains open.
VIEW A DRAWING FOR A BOOKING

TIP: Your computer must have the appropriate application installed to view drawings of a specific type. For example, to open a .vsd file that is attached to a booking, Microsoft Visio must be installed on your computer.

1. Select the drawing that you are opening, and then click Open. The file opens in the appropriate application.
2. Close the application after viewing the drawing, or if the application allows it, edit the drawing as needed, and then save the drawing. The next time you open the drawing in the Navigator, you can see your changes.
CHAPTER 53: Resource Utility Conflicts Tool

Resource conflicts can occur if bookings for the same date and time require the same resource, and there are insufficient quantities of the resource to accommodate all the bookings. When you reserve any resource for which the inventory is maintained (for example, equipment, personnel, and so on), EMS Desktop Client checks the available quantity and automatically notifies you in an Inventory Conflict message if there is an insufficient quantity of the selected resource to accommodate your event.

You can dismiss this message and over-commit the resource, however, although you are aware that the resource has been over-committed, other users will not necessarily be aware of this. If you need to confirm that an over-commitment of resources does not exist for a single reservation, then you can
manually run the Resource Inventory Conflicts tool from the Navigator to generate an onscreen report that lists the resources that are in conflict by booking for the reservation.

**TIP:** You can check if resources are over-committed across multiple reservation by running usage reports.

See Also: Generate Reports and Statistics Reports.
1. **Open the Navigator** and select the reservation for which you want to run the wizard. Click **Tools** and then click **Resource Inventory Conflicts**.
2. The next window to display shows the Resource Inventory Conflicts report, which lists the resources that are in conflict by booking. The report provides options for printing a hard copy of the report, for emailing the report, and so on.

<table>
<thead>
<tr>
<th>Date</th>
<th>Start</th>
<th>End</th>
<th>Location</th>
<th>Booking ID</th>
<th>Category</th>
<th>Opt. Used</th>
<th>Used Start</th>
<th>Used End</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/1/2020</td>
<td>9:00 AM</td>
<td>11:00 AM</td>
<td>OHS Lobby</td>
<td>27930</td>
<td>Audio Visit</td>
<td>1</td>
<td>9:00 AM</td>
<td>11:00 AM</td>
</tr>
<tr>
<td>12/1/2020</td>
<td>9:00 AM</td>
<td>10:00 AM</td>
<td>OHS Pool</td>
<td>27930</td>
<td>Audio Visit</td>
<td>1</td>
<td>9:00 AM</td>
<td>10:00 AM</td>
</tr>
</tbody>
</table>

3. You can use this report to edit the booking details for the involved bookings to resolve the conflict.
CHAPTER 54: Approve or Deny Reservation Requests

To approve reservations submitted from EMS Web App, you typically use the Change Status option on the Reservation Summary tab in the Navigator. Your EMS administrator must grant you the appropriate security access to change the status of a booking, which includes canceling a booking.

Tip: To approve multiple requests using the Change Booking Status Wizard,
See Also: Editing Multiple Bookings in the Navigator.

1. Open the reservation in the Navigator.
2. In left pane in the Navigator, select the request you are approving or denying, and then on the Reservation Summary tab, click Change Status.
3. The Change Booking Status or Change Reservation Status window opens. Select the new Status for the request.
Tip: If you select any type of Canceled status, three additional required fields display: Reason, Who Canceled and Notes. For status changes to bookings, you can leave Update Reservation Status selected to change the parent reservation status to match. You can select Send Confirmation If Successful to trigger an email to the group or individual for whom the reservation was made (depending on your Confirmation Settings).

4. Enter a Reconfirm Date (if required) for the new status you selected.
5. Click Next. The Select Bookings window opens, listing all the current and upcoming bookings for the reservation that do not have invoiced items. All the bookings are automatically pre-selected. You can use the Hide Cancelled Bookings and Hide Old Bookings options to manipulate the list.
6. Select the booking(s) for which you want to change the status, and then click Finish. The Change Booking Status Results window displays to show booking status changes for this reservation.

Tip: To see only bookings that were not changed, select Show Unchanged Only. To view the details for a specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens when you Close this window. You can manually run a Resource Inventory Conflict report: in the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
7. Click Close to close the Change Status Results window and return to the Navigator.
CHAPTER 55: The Calendar

You can use the calendar window to search for reservations, bookings, and service orders in your EMS database. The results are listed in a calendar view.

The following topics provide more information about the calendar:

» Search with the Calendar
» Search with the Resource Calendar
CHAPTER 56: Search with the Calendar

You use this window to search for reservations, bookins, and service orders in your EMS database. The results are listed in a calendar view. You can perform a basic search or an advanced search:

» In a basic search, you specify basic information for a reservation when you first create it, such as the starting time, the end time, the group for which the event was scheduled, the group contact name, and so on.

» An advanced search is a field-level search that is carried out at the reservation level, the booking level, the booking detail level, the booking detail item level, or any combination of these. For example, in an advanced search, you can specify criteria as granular as who added a specific booking detail item.

SEARCH IN THE CALENDAR

1. On the EMS toolbar, click the Calendar icon. The Calendar window opens. When the Calendar window first opens, it defaults to the Results tab, set to the current month and year.
**TIP:** The Options menu lets you set the Calendar to always display results when it first opens. Click the **Get Data When Calendar Opens** option.

2. Click the **Filter** tab (if needed) to begin setting criteria for your search. You can toggle between a **Basic** or **Advanced** using toggle button.
BASIC SEARCH

1. On the Browse For field, set the search to focus on Reservations, Bookings, or Service Orders.

2. Enter search criteria using the fields as defined below.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>The default value is the current month and year, but you can change one or both of these values if</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Year</td>
<td>needed.</td>
</tr>
<tr>
<td>Include</td>
<td>By default, search results are not set to show canceled bookings. Select this option if you want to search for canceled bookings as well.</td>
</tr>
<tr>
<td>Cancel</td>
<td>For canceled bookings as well.</td>
</tr>
<tr>
<td>Group</td>
<td>If the pre-defined list of groups is too extensive to scroll, then click the Search icon to open the Groups window and search for a specific group. See <a href="#">Search for a group and/or contact</a>.</td>
</tr>
<tr>
<td>1st Contact</td>
<td>Enter a search string by which to filter your search. The search is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a search string of ed returns include Ed, Edward, Eddie, and so on, but not Ted or Fred.</td>
</tr>
<tr>
<td>Reservation</td>
<td>Building</td>
</tr>
<tr>
<td>Event Name</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific building, area, or view.</td>
</tr>
<tr>
<td>Building/Room</td>
<td>If you select a specific building, then (all) rooms in the building are selected by default. You can select a specific room in the building.</td>
</tr>
<tr>
<td></td>
<td>If you select an area, then you can select a specific building that is contained in the area.</td>
</tr>
<tr>
<td></td>
<td>If you select a view, then Room is left blank; however, you can select a specific room to search.</td>
</tr>
<tr>
<td>Category</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific category (booking detail).</td>
</tr>
<tr>
<td>Resource</td>
<td>Available only if you select a category that is a resource or service order. The default value is set to (all). You can leave this value as is, or you can select a specific resource item.</td>
</tr>
</tbody>
</table>
3. You can click Options and set additional search options: Date/Time Filter, Number of Records to Return, Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

4. Click Get Data or Refresh. The search results are listed on the Results tab in a calendar view. The number of bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black. By default, the number of events is indicated in red unless you selected a different color for the Change Calendar Day Count Color. Any color that you pick here is carried over to the same option for the Resource Calendar.
5. Change the **Browse For** field at the top to see Reservations, Bookings, or Service Orders.

Click on a date in the upper pane to see items for the date in the lower pane of the tab.
You can do the following from this page:

» Open a reservation, booking, or service order: double-click on the item in the lower pane to open it in the Navigator.

» Click Print to print the search results.

» Email attendees: select an event and either click Email (if enabled) to start a pre-addressed SMTP email to the group for that event (see Send Email from EMS), or click Outlook > Send Invitation (if enabled) to message attendees via Outlook. Your Administrator must set a system parameter to enable these functions.

» Click Export to export the search results to a Microsoft Excel spreadsheet.
Work with Service orders: To mark Service Orders as Reviewed, select the service order, or CTRL-click to select multiple service orders, and then click **Review > Mark as Reviewed**. To change the state of Service Orders, click **Change State**. For detailed instructions in using the page that appears next, see **Search for Service Orders**.

Click **Filter** to return to the **Filter** tab, make any necessary changes to the search criteria, and then repeat the search.

Click **Refresh** to re-query the database based on the current search criteria.

6. Click **Close** to save your changes and settings.

**TIP:** To reset the columns to their default values, click the **Reset** button.

**ADVANCED SEARCH**

1. Toggle to the **Advance** search using the button.
2. Month and Year default to the current month and year. You can enter different values as needed.

3. Click **Options** if you want to add the search options: **Date/Time Filter**, **Number of Records to Return**, **Get Data when Calendar Opens**, **When Filtering By Specific Room**, and **Change Calendar Day Count Color**.

4. Set search criteria in the remaining fields as needed.
5. Click **Get Data** or **Refresh**. Search results are listed on the **Results** tab just like they were for your **Basic Search**, with the same **options** for working with the results.

6. Click **Close** to save your changes and settings.
CHAPTER 57: Search with the Resource Calendar

You use the Resource Calendar to search for a particular resource and determine how much of the resource (that is, how many individual items) is needed for a specific day or month in a specific year. For example, how many slices of key lime pie are needed in March, 2018? You can use the results of the search to assist you in managing the counts of the resources that your organization must ensure are available for scheduled events. When you carry out a search in the Resource Calendar, you can carry out a basic search or an advanced search. A basic search is based on the basic information that you specify for a resource item when you first create it, such as its category and status. An advanced search is a field level search that is carried out the booking level, the booking detail level, the booking detail item level, the reservation level, the service order level, or any combination of these. For example, in an advanced search, you can specify criteria as granular the date that the service order reminder was added. You can open a resource item that has been returned in the search results in the Navigator, and edit the item if needed.
TO SEARCH IN THE RESOURCE CALENDAR

1. On the EMS menu bar, click Reservations > Reservations > Resource Calendar. The first time that the Resource Calendar opens, the Filter tab is set by default to a Basic search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you last carried out.

2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and then continue to one of the following:
   - Basic search in the Resource Calendar
   - Advanced search in the Resource Calendar
BASIC SEARCH IN THE RESOURCE CALENDAR

1. Leave the Month and Year set to the default values (current month and year), or optionally, enter different values as needed.

2. Enter the search criteria.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include</td>
<td>By default, search results are not set to show resource items for canceled reservations. Select this option to search for resource items in canceled reservations as well.</td>
</tr>
<tr>
<td>Canceled</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Select a specific category (booking detail).</td>
</tr>
<tr>
<td>Resource</td>
<td>Available only if you select a category that is a resource or service order. Select a specific resource item.</td>
</tr>
<tr>
<td>Status</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific booking status.</td>
</tr>
</tbody>
</table>

3. Optionally, click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, Specific Room Filters, and Change Calendar Day Count Color.

4. Click Get Data or Refresh. The search results are displayed on the Results tab in a calendar view. The total number of resources in all bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black.
Tip: By default, the number of resources is indicated in red unless you selected a different color for the Change Calendar Day Count Color. Any color that you pick here is carried over to the same option for the Calendar.

5. Optionally, do one or more of the following:

   » Click on a date in the upper pane of the Results tab to view a list of bookings for the date in the lower pane of the tab.
The lower pane on the Results tab is an EMS Browser window. See An EMS Browser Window for all the features that are available for this pane.

- Double-click an event entry on the Results tab to open the event in the Navigator.
- Click Print to print the search results.
- Click Export to export the search results to a Microsoft Excel spreadsheet.
- Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.
- Click Refresh to requery the database based on the current search criteria.
6. Click Close. Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see Resetting Column Settings.

ADVANCED SEARCH IN THE RESOURCE CALENDAR

1. Optionally, do one or both of the following:
   - The default values for the month and year are the current month and year. You can enter different values as needed.
   - Click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, Specific Room Filters, and Change Calendar Day Count Color.
2. For each field level option by which to carry out the search:
   
   » Select the field level option, and then click the Move button (>).

   Tip: To filter the list of available fields, in the Field Search field, enter a search string. Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of add returns Added by, Date Added, and Group Address Line 1. The list of fields that meet your search criteria is dynamically updated as you enter your search criteria.

   » When prompted, enter a value or define the limits for the option, and then click OK.

   The option is moved to the Filter Summary list.

   Tip: If you have specific fields and/or values by which you always want to carry out a search, then you can set up these fields to be your Favorite fields. See To set up favorite fields for a Resource Calendar search.
Note: To view a selected field option in its entirety in the Filter Summary list, rest the mouse pointer on the entry. A tooltip showing the complete field option information opens.

**Viewing a selected field option in the Filter Summary list**

3. Click Get Data or Refresh. The search results are displayed on the Results tab in a calendar view. The total number of resources in all bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black.

Tip: By default, the number of resources is indicated in red unless you selected a different color for the Change Calendar Day Count Color.
4. Optionally, do one or more of the following:

   - Click on a date in the upper pane of the Results tab to view a list of bookings for the date in the lower pane of the tab.
The lower pane on the Results tab is an EMS Browser window. See the EMS Browser Window for all the features that are available for this pane.

- Double-click an event entry on the Results tab to open the event in the Navigator.
- Click Print to print the search results.
- Click Export to export the search results to a Microsoft Excel spreadsheet.
- Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.
- Click Refresh to requery the database based on the current search criteria.
5. Click Close. Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see Resetting Column Settings.

TO SET UP FAVORITE FIELDS FOR A RESOURCE CALENDAR SEARCH

If you have specific fields and/or values by which you always want to carry out a Resource Calendar search, you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Resource Calendar, and make sure that the Advanced search features are displayed.
2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then click Add to Favorites. The field is added to the Favorite Fields tab.
3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog box. The next time that you carry out a search, you can simply open the Favorite Fields tab or the Saved Values tab to carry out a search based on your customized list of search fields.
CHAPTER 58: The Reservation Wizard

You can use the Reservation Wizard to check for available space for an event and to make a reservation for the event. The Reservation Wizard helps you search for rooms that are available for a particular time on one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You can also create a series reservation by selecting one date and time, but multiple rooms.

The following topics provide more information about the Reservation Wizard:

» Reservation Wizard Fields
» The Everyday User Reservation Browser
  » Search with the Everyday User Reservations Browser
» Create a Reservation in the Reservation Wizard
» Book a Video Conference
CHAPTER 59: Reservation Wizard Fields

This section explains the fields on the reservation wizard.

### EVENT SECTION

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Name</td>
<td>A name or description for the event.</td>
</tr>
<tr>
<td>Event Type</td>
<td>The classification for the event.</td>
</tr>
<tr>
<td>VIP Event</td>
<td>Select this option to mark the event as a Very Important event.</td>
</tr>
<tr>
<td>Source</td>
<td>The reservation source.</td>
</tr>
<tr>
<td>Video Conference</td>
<td>Select this option for a video conference event.</td>
</tr>
</tbody>
</table>

### GROUP/CONTACT SECTION

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Drop-down list of all groups that are available in your system for hosting/sponsoring an event.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong></td>
<td>If the pre-configured list of groups is too extensive to scroll, then click the Search icon to open the Groups window and search for a specific group. See <a href="#">Search for a group and/or contact</a>. If the group that you want to select for the reservation is not available on the pre-configured list, then you can add the group.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Optionally, after you select a group for the event, you can click Group Info to open a dialog box that provides information (Properties, User Defined Fields, and Comments) about the group.</td>
</tr>
</tbody>
</table>

#### 1st Contact
- When you select a group, if a default contact has been defined for the group, then this field is automatically populated with the name of the contact; otherwise, the field is blank. You have several options for defining the 1st Contact for a reservation:
  - **If the field is blank, but contacts have been configured for the group, you can select a contact from the pre-configured list.**
  - **If the field is populated with a default value, but other contacts have been configured for the group, you can select a different contact from the pre-configured list.**
  - **If the field is blank, and no contacts have been configured for the group, or the contact that you want to select for the group is not available on the pre-configured list, you can click the Contact icon to open the Contact dialog box and create a permanent contact for the group. See [Configure Contacts](#).**
  - **If you want to create a temporary contact just for this event, then select (temporary contact), and in the Temp Contact field, enter the name for the temporary contact.**

**NOTE:** If a default contact has been configured for the group, then any modifications that you make for the contact apply to this reservation only. The next time you or anyone else creates a reservation
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>One more of these fields might be automatically populated depending on how a selected contact has been configured. You can manually edit these values if needed.</td>
</tr>
<tr>
<td>Fax</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td><strong>NOTE:</strong> The Phone and Fax fields have a drop-down list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.</td>
</tr>
<tr>
<td>Address</td>
<td></td>
</tr>
<tr>
<td>2nd Contact</td>
<td>Define if necessary for the event.</td>
</tr>
<tr>
<td>Temp Contact</td>
<td></td>
</tr>
</tbody>
</table>
ROOM SETUP TAB

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is set to (default). You can edit this value.</td>
</tr>
<tr>
<td>Type</td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is set to (default). You can edit this value.</td>
</tr>
<tr>
<td>Setup</td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can enter a value in this field.</td>
</tr>
<tr>
<td>Count</td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can enter a value in this field.</td>
</tr>
</tbody>
</table>

BILLING TAB

**TIP:** Depending on the group that you select, one or more of these fields might be automatically populated with default values. You can edit these default values but any modifications that you make apply to this reservation only. The next time you or anyone else creates a reservation for the same group, these fields are again automatically populated with the default billing information.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pricing Plan</td>
<td>Indicates what type of pricing is to be used for the event.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Billing</td>
<td>The internal alphanumeric billing code that is associated with the group. You can manually enter a value in this field, or if a master list of billing reference numbers has been configured for the group, you can click the Search icon to open a Billing Reference Numbers dialog box, and select the appropriate value from this list.</td>
</tr>
<tr>
<td>Reference Number</td>
<td>Search icon to open a Billing Reference Numbers dialog box, and select the appropriate value from this list.</td>
</tr>
<tr>
<td>Sales Category</td>
<td>How the group is sorted for purposes of tracking sales figures, for example, local, regional, national, and so on.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Indicates how the group paid for the event (cash, check, charged, and so on).</td>
</tr>
<tr>
<td>PO Number</td>
<td>The internal alphanumeric purchase order number that is associated with the group. You can manually enter a value in this field, or if a master list of PO numbers has been configured for the group, you can click the Search icon to open a PO Number dialog box, and select the appropriate value from this list.</td>
</tr>
<tr>
<td>Salesperson</td>
<td>The user who &quot;sold&quot; the event to the group.</td>
</tr>
</tbody>
</table>

**NOTE:** To search for a specific billing reference number, enter a search string in the Find field, and then click Display. Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive and it can appear anywhere in the search results. For example, if you enter CO as the search string, the search results can include CO-123, and 123-CO.
OTHER TAB

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Coordinator</td>
<td>The Event Coordinator who is assigned to the event.</td>
</tr>
<tr>
<td>Estimated Event</td>
<td>The estimated number of people who are expected to attend the event.</td>
</tr>
<tr>
<td>Attendance</td>
<td></td>
</tr>
<tr>
<td>Calendar Style</td>
<td>Drop-down list of all the available formats for printing this event on the Event Calendar and Event Schedule reports.</td>
</tr>
<tr>
<td>URL</td>
<td>The event URL.</td>
</tr>
</tbody>
</table>

VIRTUAL TAB

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web User</td>
<td>To specify the web users who can view/manage this reservation in VEMS, click the Search icon to open the Web Users dialog box and search from a list of registered web users.</td>
</tr>
</tbody>
</table>

- You can search by User Name or Email Address.
- To search a list of all available web users, leave the Search field in the Web Users dialog box blank, and then click Display.
- To search for a specific web user, enter a search string in the Search field, and then click Display.

**NOTE:** The string is not case-sensitive, but your search is limited to the exact order of characters in
the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bob.worth@dea.com but not dbobbett@dea.com.

To return this field to the (no change) value at any time, click Reset.

Web Process Template

The web process template that defines the functions that are available for the selected web user.

NOTE: A web user might be assigned to more than one web process template, so make sure to select the template that is applicable for this reservation.

USER DEFINED FIELDS TAB

User-defined fields are additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields.

To enter or edit a value for a field, select the field, and then click Set Value.

To clear a value for a field, select the field, and then click Clear Value.

NOTE: If a user-defined field is not required here, you can always supply a value for it at a later date in the Navigator. See User Defined Fields in the Navigator.
CHAPTER 59: Reservation Wizard Fields

VIDEO CONFERENCE TAB

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Displayed only if you selected the Video Conference option on this window. N/A for a Best Fit room or Specific Room meeting assignment. You identify the host endpoint for the video conference on this tab.</td>
</tr>
</tbody>
</table>

**NOTE:** Not available in EMS Professional.
CHAPTER 60: The Everyday User Reservation Browser

You can use the Everyday User Reservations Browser to search at a very detailed level for reservations, bookings, service orders, resources, everyday user reservations, and pre-defined queries. The results are listed in a calendar view. You can perform a basic search or an advanced search:

» In a basic search, you specify basic information for a reservation when you first create it, such as the starting time, the end time, the group for which the event was scheduled, the group contact name, and so on.

» An advanced search is a field-level search that is carried out at the reservation level, the booking level, the booking detail level, the booking detail item level, or any combination of these. For example, in an advanced search, you can specify criteria as granular as who added a specific booking detail item.

To search using the Everyday User Reservation Browser, see Search with the Everyday User Reservations Browser.

Concept: An everyday user reservation is any reservation that a user has submitted through EMS Web App.

The Everyday User Reservations searching tool is identical to the Everyday
User Reservations Browser searching tool with one exception: when the Everyday User Reservations Browser opens for the first time, the Browse For function is set to all Reservations in your organization's database, whereas the Everyday User Reservation tool is set to show only Everyday User Reservations.
CHAPTER 61: Search with the Everyday User Reservations Browser

To search using the Everyday User Reservations Browser, do the following:

1. On the EMS toolbar, click the Everyday User Reservations Browser icon, the Everyday User Reservations Browser window opens. When the Everyday User Reservations Browser window first opens, it defaults to the Results tab, set to the current month and year.
2. Click the **Filter** tab (if needed) to begin setting criteria for your search. You can toggle between a **Basic** or **Advanced** using toggle button.
BASIC SEARCH

1. Toggle for a Basic search. On the Browse For field, set the search to focus on reservations, bookings, service orders, resources, everyday user reservations, or a pre-defined query.
2. Enter search criteria using the fields as defined below.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Date</td>
<td>These fields set the date range for the search. The default value is the current month and year, but you can change these values if needed.</td>
</tr>
<tr>
<td>Ending Date</td>
<td></td>
</tr>
<tr>
<td>Use Specific Times</td>
<td>Clicking this option adds specific Starting Time and Ending Time fields to your search criteria.</td>
</tr>
</tbody>
</table>

3. You can specify fields from the booking, reservation, service order, and so forth as part of your search criteria by using the arrow buttons to move them from the left panel to the right panel. The level of the field is noted in the list, for example, the "Booking... Room Design" field means your search will pull all events that have the value you specify in the Room Design field at the booking level.
When you move a field to the right panel, you will be prompted to enter a field value for which to search.

**TIP:** Click *Add to Favorites* to save a field on the *Favorite Fields* tab for future searches. You can also move items from the right panel into the *Favorite Fields* or *Saved Values* tabs in the left panel.
4. Click **Options** to set additional search options.

5. Click **Get Data** or **Refresh**. The search results are listed on the **Results** tab in a calendar view.
You can do the following from this page:

» Change the **Browse For** field at the top to refresh the results to focus on reservations, bookings, service orders, resources, everyday user reservations, or pre-defined queries.

» Open a reservation, booking, service order, etc.: double-click on the item in the results tab to open it in the **Navigator**.

» Click **Print** to print the search results.

» Email attendees: select an event and either click **Email** (if enabled) to start a pre-addressed SMTP email to the group for that event (see **Send Email from EMS**), or click **Outlook > Send Invitation** (if enabled) to message attendees via Outlook. Your Administrator must set a system parameter to enable these functions.

» Click **Export** to export the search results to a Microsoft Excel spreadsheet.

» Work with Service orders: To mark Service Orders as Reviewed, select the service order, or CTRL-click to select multiple service orders, and then click **Review > Mark as Reviewed**. To change the state of Service Orders (when used), click **Change State**. For detailed instructions in using the page that appears next, see **Manage Service Orders**.
Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

Click Refresh to re-query the database based on the current search criteria.

6. Click Close to save your changes and settings.

TIP: To reset the columns to their default values, click the Reset button.
ADVANCED SEARCH

1. Toggle to the Advanced search using the button.

2. Starting Date and Ending Date default to the current month and year. Enter your date range as needed.
3. Click **Options** if you want to add the search options: **Date/Time Filter**, **Number of Records to Return**, **Get Data when Calendar Opens**, **When Filtering By Specific Room**, and **Change Calendar Day Count Color**.

4. Enter search criteria using the fields as defined below.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Date</td>
<td>The default value is the current month and year, but you can change these values if needed.</td>
</tr>
<tr>
<td>Ending Date</td>
<td></td>
</tr>
<tr>
<td>Use Specific Times</td>
<td>Clicking this option adds specific Starting Time and Ending Time fields to your search criteria.</td>
</tr>
<tr>
<td>Include Canceled</td>
<td>Deselected by default. Select this option to include canceled bookings in the search.</td>
</tr>
<tr>
<td>Group</td>
<td>Your Administrator might have re-labeled this field to Customer or Employee. If the pre-defined list of groups is too extensive to scroll, then click the Search icon to open the Groups window and search for a specific group. See <a href="#">Search for a group and/or contact</a>.</td>
</tr>
<tr>
<td>1st Contact Reservation</td>
<td>Enter a search string by which to filter your search. The search is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event Name</td>
<td>the information for which you are searching. For example, a search string of ed returns include Ed, Edward, Eddie, and so on, but not Ted or Fred.</td>
</tr>
<tr>
<td>Building</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific building, area, or view.</td>
</tr>
<tr>
<td>Room/Building</td>
<td>» If you select a specific building, then (all) rooms in the building are selected by default. You can select a specific room in the building.</td>
</tr>
<tr>
<td></td>
<td>» If you select a area, then you can select a specific building that is contained in the area.</td>
</tr>
<tr>
<td></td>
<td>» If you select a view, then Room is left blank; however, you can select a specific room to search.</td>
</tr>
<tr>
<td>Category</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific category (booking detail).</td>
</tr>
<tr>
<td>Resource</td>
<td>Available only if you select a category that is a resource or service order. The default value is set to (all). You can leave this value as is, or you can select a specific resource item.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Booking Status</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific booking status.</td>
</tr>
</tbody>
</table>

5. Click **Get Data** or **Refresh**. Search results are listed on the Results tab just like they were for your Basic Search, with the same options for working with the results.

6. Click **Close** to save your changes and settings.
CHAPTER 62: Create a Reservation in the Reservation Wizard

You use the Reservation Wizard to check for available space for an event and to make a reservation for the event.

Concept: Reservations are containers for multiple bookings; bookings are individual meetings

When you "make a reservation" in EMS, you are creating the broader rules for events that take place with a similar purpose and involving most of the same people, services, resources, and spaces. When you "book" a meeting, you are creating a meeting within a reservation. See Also: Reservation Structure.

The Reservation Wizard helps you search for rooms that are available for a particular time on one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You can also create a series reservation by selecting one date and time, but multiple rooms.

To make a reservation using the Reservation Wizard, you will:

» Set the event date, time, and status.
» Set the event location.
» Set the event information.

**TIP:** The following procedure describes how to make a reservation by selecting values for the required and optional fields.

» If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard Template drop-down list is displayed at the top of the Reservation Wizard. You can streamline the booking process by choosing from these templates, which automatically sets the default values for many of the fields in the Reservation Wizard.

» If your job entails making multiple reservations that require the same information, and you are not using reservation wizard templates, then you can set your own default values for many of the fields in the Reservation Wizard.

**SETTING THE EVENT DATE AND TIME**

1. On the toolbar, click the Wizard icon. The Reservation Wizard opens. All required fields in the wizard are marked with a red dot. Your EMS administrator configures the required fields.
2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different month (< or >) or for a different year (< or >>). You can also click a month at the top of the calendar to open a drop-down list from which you can select a different month and you can also click a year at the top of the calendar to open a drop-down list from which you can select a different year.

3. If the event dates do not follow a pattern, use one or more of the following options for entering a date; otherwise, go to the next step. Click to pick dates on the calendar. To select all five days in a work week, click in the blank space to the left of the week. To select all seven days in a week, double-click in the blank space to the left of the week.
To select every occurrence of a specific day of the week for the displayed month (for example, all Tuesdays in November, 2012), click the heading (S, M, T, and so on) for the day. To select every occurrence of a specific day of the week shown (regardless if the day falls within the same month), double-click the heading (S, M, T, and so on) for the day. If you need to clear a single selected date, click the date again. To clear multiple selected dates in a single step, click Clear Month to clear all currently selected dates for the currently displayed month or click Clear All to clear all currently selected dates regardless of month or year.

If the event dates do follow a recurrent pattern, (for example, the third Friday of every month), click Date Pattern to open the Date Pattern dialog box and enter your event date information. The steps that you use to create a date pattern in EMS
are very similar to the steps that you use to create a date pattern in Microsoft Outlook or in any other calendaring product.

As you specify the event dates, the Selected Dates tab is automatically updated with the selected dates. Dates that are closed are displayed in red on the Calendar tab, holidays are green. These are linked to information about the closure (in the Selected Dates tab, click Holidays). To remove the date your selection, open the Selected Dates tab, select the date, or CTRL-click to select multiple dates, and then click Remove. When you make a reservation for multiple dates, the process is easier if you first remove all holidays or closed dates from the list of selected dates; however, be very careful when selecting dates for removal as you are not prompted to confirm your selection before you click Remove.
4. Specify the start time and end time for the event:
   
   ▷ Select a time from the drop-down list for each field.
   
   ▷ Manually enter the time in each field. When you manually enter the time, you can use a shortcut. For example, for 9:00 am, you need to enter only “9a” and for 2:00 pm, you need to enter only “2p,” and so on. If you enter an end time that is earlier than the start time, then the system assumes that the end time is the next day and the phrase “Next Day” is displayed to the right of the End time field.

5. Specify Setup and Teardown times. To use the default setup and teardown times that your EMS administrator has assigned to the rooms in your system, leave Use Default selected. To override the default setup/teardown times, clear Use Default, select Minutes or Hours, and then enter your own setup and teardown times. Remember, setup and teardown times are the hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up
after the event. For example, for a 30 minute setup time, you can enter 30 minutes or 0.5 hours.

6. Select the status for the event. Depending on the status that you select, for example, Tentative or Hold, you might be required to enter a reconfirm date. You can monitor reservations that must be reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See EMS Dashboard.

SETTING THE EVENT LOCATION

You have three options for selecting the event location on the first window of the Reservation Wizard:

<table>
<thead>
<tr>
<th>SEARCH METHOD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Use this option to display a list of all the available rooms that meet all the requested dates.</td>
</tr>
<tr>
<td></td>
<td>Note: Standard search is required for Video Conference room assignments.</td>
</tr>
<tr>
<td>Best Fit</td>
<td>Use this option if no one room can meet all the requested dates. The system lists the available rooms along with the number of bookings for which you can reserve each room. You can piece together the entire reservation using Best Fit, or just part of it.</td>
</tr>
<tr>
<td>Specific Room</td>
<td>Use this option to confirm the availability and reserve of one specific room for the scheduled event.</td>
</tr>
</tbody>
</table>
TIP: By default, EMS looks for an available room or rooms in only the first 50 rooms that it finds in the pre-configured Rooms list. To search more than 50 rooms, before you begin any search, click Options > Max. Number of Rooms to Search, and then select a different number of rooms to search.

FINDING A STANDARD ROOM

By default, when you search for a standard room, rooms that are available all day are marked with an asterisk (*). To set or clear this option, click Options > Standard Search > Show Available All Day Indicator.

1. Select Standard.
2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to search for a standard room. Your selection on the Building drop-down list determines the options that are available on the Time Zone drop-down list. If you select (all) buildings, then you can select a time zone. If you select a specific building, then by default, a time zone is selected for the building, and you cannot select a different value.
3. If applicable, select the appropriate time zone for the event.
4. Specify one or more room settings:
   » Type is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type drop-down list.
   » Floor is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down list.
   » Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type drop-down list.
   » Setup count is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count. The selected setup type and setup count are applied to all the bookings that you add to this reservation. If any of the bookings require a different setup type or count, you can change this information after you complete the reservation.

5. You can add optional Features on the Features tab.

6. Click Next. Up to two tabs are displayed:
   » The Available tab, which is the active tab and is always displayed, lists all the rooms that meet all your event criteria. If you have elected to show
the Available All Day Indicator, the rooms that are available all day are marked with an asterisk (*). By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

The Conflicts tab is displayed only if there are rooms that are not available for the requested dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling as well as list of the events that are scheduled for each room.
Example of standard room search results

7. Select the room, or CTRL-click to select the multiple rooms you are scheduling for the event. If the reservation is for a video conferencing meeting, then you must select a minimum of two rooms. You must designate one of these rooms as the Host Location on the Video Conference tab on the last page of the Reservation Wizard.
8. Optionally, do one or both of the following; otherwise, go to Step 9.
   
   » Click Room Info to open the Room Info dialog box and view information about any bookings for the room, the room properties, its pricing, and/or to view an image of the room.

   » Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

9. Click the Move button (>) to move the rooms to the Selected list.

   **TIP:** If you select more than one room, all the selected rooms are booked for all the event dates.

10. Click Next.

**FINDING A BEST FIT ROOM**

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to search for a standard room.

3. If applicable, select the appropriate time zone for the event.
TIP: Your selection on the Building drop-down list determines the options that are available on the Time Zone drop-down list. If you select (all) buildings, then you can select a time zone. If you select a specific building, then by default, a time zone is selected for the building, and you cannot select a different value.

4. Do one or more or all of the following for room specifications:
   - Type is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type drop-down list.
   - Floor is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down list.
   - Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type drop-down list.
   - Setup count is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count. The selected setup type and setup count are applied to all the bookings that you add to this reservation.
If any of the bookings require a different setup type or count, you can edit the reservation later.

5. You can add optional Features for the room on the Features tab.

6. Click Next. Up to two tabs are displayed:

   » The Available tab, which is the active tab and is always displayed, has two lists. The list in the left pane is a list of all the rooms that meet some or all of your event criteria. The list in the right pane is a list of all the event dates that must be fulfilled. By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

   » The Conflicts tab is displayed only if there are rooms that are not available for the requested dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling for the event as well as list of the events that are scheduled for each room.
**Example of best fit room search results**

![Reservation Wizard](image)

7. Optionally, do one or both of the following; otherwise, go to the next step.

   - To see detailed room information, click Room Info (such as the room properties, pricing, and/or to view an image of the room).
   - To see building hours, click Building Hours (which shows hours when the selected room/building is open on the reserved date).
8. If a room is available, select the single room that is available for all the requested dates, and then click the Move button (>) to move the room to the Event Dates list. If a room is not available, select a room that is available for some of your requested dates, and then click the Move button (>) to move the room to the Event Dates list. Repeat this step as needed to fulfill all the event dates.
9. Click Next to continue.

FINDING A SPECIFIC ROOM

You can use the specific room search to book a standard EMS room or a room or area that is not managed in EMS. An override room, or “override description,” is used to book an event in a space that has not been configured in your EMS system. For example, your EMS administrator might have configured an override room named “Other Area” in the Engineering building. To book an event in Dr. Wilson's office, which is a room that is not defined in EMS, in the Engineering building, you can select the “Other Area” room and specify “Dr. Wilson's Office” for the location. EMS does not track availability for events booked in override rooms; however, EMS reports on events that are scheduled in an override room just like any other event scheduled for any other room.

1. Select Specific Room. The Room Selector dialog box opens.
2. To choose a room from list of all rooms in all available buildings, select (all) on the Building drop-down list; then select a room, and then click OK. To select a room in a specific building, area, or view, select it on the Building drop-down list, select the room, and then click OK. If the room is configured as an override room, go to the next step, otherwise, go skip to Step 4.

3. In the Location field, enter the location of the override room, and then click Next skip the remaining steps in this subsection.

4. Click Next. If the event is scheduled for a single date and the room is available, then continue. In all other cases, (for example, the event is scheduled for a single
date but the room is not available or it is a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific room is available. You can open the Conflicts tab to view the list of dates for which the specific room is not available as well as list of the events that are scheduled for the room.

5. Optionally, do one or both of the following; otherwise, go to the next step.

   » To see detailed room information, click Room Info (such as the room properties, pricing, and/or to view an image of the room).

   » To see building hours, click Building Hours (which shows hours when the selected room/building is open on the reserved date).

6. If the specific room is available for all the event dates, then click the Move All button (>>) to schedule the room for all the event dates. If the specific room is not available, try another approach such as reserving a different specific room, or using the Standard or Best Fit search method.

7. Click Next to continue.

SPECIFYING EVENT INFORMATION

After you select an event location or locations, you must specify other information for the event. You must enter information in the required fields.
1. Enter event information using the elements in this window (see **Reservation Wizard Fields**).

2. Click Finish. The Navigator window opens. The reservation information appears in the window. You use this window to add booking details and to make any needed modifications to the reservation and its bookings.
**NOTE:** A reservation is not complete and rooms are not removed from the Available list until you click Finish. Although unlikely, it is possible for another user to select and reserve a room during the time period after you have selected the room but before you have finalized the reservation. If this occurs, after you click Finish, a message appears stating that your reservation conflicts with an existing reservation.
CHAPTER 63: Book a Video Conference

Booking a video conference is basically the same as making a standard reservation, except for a few differences:

1. On the first screen of the Reservation Wizard, choose a video conference template option from the Wizard Template drop-down, as shown in the example below.

Your Administrator configures these templates; if none are available, contact your Administrator. Additionally, set the Search method to "Standard."
2. You select at least two rooms for video conferences; one is the "host" where the presenter drives the video conference, and the other room(s) are "endpoints" where attendees participate in the video conference. You can have multiple rooms and one host. On the second screen of the wizard where you select rooms for the booking, select all rooms involved including your host room.
3. An additional "Video Conference" tab is available for video conferencing on the third screen of the wizard where you designate one of the rooms as the host.

4. Once you finalize your reservation the host room shows in the Navigator with "Yes" under the VC Host column. Each room shows as a booking under the reservation, and if your Administrator has configured it, resources needed for a video conference, such as a Video Conference cart, are automatically included as details under the bookings.
CHAPTER 63: Book a Video Conference
CHAPTER 64: The Browser

You can use the Browser to search at a very detailed level for reservations, bookings, service orders, resources, everyday user reservations, and pre-defined queries. The results are listed in a calendar view.

**Browser Tool**

Using the Browser, you can perform a basic search or an advanced search:

- In a basic search, you specify basic information for a reservation when you first create it, such as the starting time, the end time, the group for which the event was scheduled, the group contact name, and so on.
- An advanced search is a field-level search that is carried out at the reservation level, the booking level, the booking detail level, the booking detail item level, or any combination of these. For example, in an advanced search, you can specify criteria as granular as who added a specific booking detail item.

To search using the Browser, see [Search with the Browser](#).

**Concept:** An everyday user reservation is any reservation that a user has submitted through EMS Web App.

The Everyday User Reservations searching tool is identical to the Browser
searching tool with one exception: when the Browser opens for the first time, the Browse For function is set to all Reservations in your organization's database, whereas the Everyday User Reservation tool is set to show only Everyday User Reservations. Basically, although this section is written from the perspective of using the Browser, all the information can be applied when using the Everyday User Reservation searching tool.
CHAPTER 65: Search with the Browser

To search using the browser, do the following:

1. On the EMS toolbar, click the Browser icon. The Browser window opens. When the Browser window first opens, it defaults to the Results tab, set to the current month and year.
2. Click the **Filter** tab (if needed) to begin setting criteria for your search. You can toggle between a **Basic** or **Advanced** using toggle button.
1. Toggle for a Basic search. On the **Browse For** field, set the search to focus on reservations, bookings, service orders, resources, everyday user reservations, or a pre-defined query.
2. Enter search criteria using the fields as defined below.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Date</td>
<td>These fields set the date range for the search. The default value is the current month and year, but you can change these values if needed.</td>
</tr>
<tr>
<td>Ending Date</td>
<td></td>
</tr>
</tbody>
</table>

Use Specific Times

Clicking this option adds specific Starting Time and Ending Time fields to your search criteria.

3. You can specify fields from the booking, reservation, service order, and so forth as part of your search criteria by using the arrow buttons to move them from the left panel to the right panel. The level of the field is noted in the list, for example, the "Booking... Room Design" field means your search will pull all events that have the value you specify in the Room Design field at the booking level.
When you move a field to the right panel, you will be prompted to enter a field value for which to search.

**TIP:** Click Add to Favorites to save a field on the Favorite Fields tab for future searches. You can also move items from the right panel into the Favorite Fields or Saved Values tabs in the left panel.
4. You can click Options and set additional search options.

5. Click Get Data or Refresh. The search results are listed on the Results tab in a calendar view.
You can do the following from this page:

» Change the **Browse For** field at the top to refresh the results to focus on reservations, bookings, service orders, resources, everyday user reservations, or pre-defined queries.
- Open a reservation, booking, service order, etc. by double-clicking on the item in the results tab to open it in the Navigator.

- Click **Print** to print the search results.

- Email attendees by selecting an event and either click **Email** (if enabled) to start a pre-addressed SMTP email to the group for that event (see [Send Email from EMS](#)), or click **Outlook > Send Invitation** (if enabled) to message attendees via Outlook. Your Administrator must set a system parameter to enable these functions.

- Click **Export** to export the search results to a Microsoft Excel spreadsheet.

- Work with Service orders: To mark Service Orders as **Reviewed**, select the service order, or CTRL-click to select multiple service orders, and then click **Review > Mark as Reviewed**. To change the state of Service Orders (when used), click **Change State**. For detailed instructions in using the page that appears next, see [Manage Service Orders](#).
» Click **Filter** to return to the **Filter** tab, make any necessary changes to the search criteria, and then repeat the search.

» Click **Refresh** to re-query the database based on the current search criteria.

6. Click **Close** to save your changes and settings.

**TIP:** To reset the columns to their default values, click the **Reset** button.
ADVANCED SEARCH

1. Toggle to the Advance search using the button.

2. Starting Date and Ending Date default to the current month and year. Enter your date range as needed.
3. Click **Options** if you want to add the search options Date/Time Filter, Number of Records to Return, Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

4. Enter search criteria using the fields as defined below.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Date</td>
<td>The default value is the current month and year, but you can change these</td>
</tr>
<tr>
<td>Ending Date</td>
<td>values if needed.</td>
</tr>
<tr>
<td>Use Specific</td>
<td>Clicking this option adds specific Starting Time and Ending Time fields to</td>
</tr>
<tr>
<td>Times</td>
<td>your search criteria.</td>
</tr>
<tr>
<td>Include Canceled</td>
<td>Deselected by default. Select this option to include canceled bookings in</td>
</tr>
<tr>
<td></td>
<td>the search.</td>
</tr>
<tr>
<td>Group</td>
<td>Your Administrator might have re-labeled this field to Customer or Employee.</td>
</tr>
<tr>
<td></td>
<td>If the pre-defined list of groups is too extensive to scroll, then click</td>
</tr>
<tr>
<td></td>
<td>the Search icon to open the Groups window and search for a specific group.</td>
</tr>
<tr>
<td></td>
<td>See <strong>Search for a group and/or contact</strong>.</td>
</tr>
<tr>
<td>1st Contact</td>
<td>Enter a search string by which to filter your search. The search is not</td>
</tr>
<tr>
<td>Reservation</td>
<td>case-sensitive, but your search is limited to the exact order of characters</td>
</tr>
<tr>
<td></td>
<td>in the string and it must begin with</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event Name</td>
<td>the information for which you are searching. For example, a search string of ed returns include Ed, Edward, Eddie, and so on, but not Ted or Fred.</td>
</tr>
<tr>
<td>Building</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific building, area, or view.</td>
</tr>
<tr>
<td>Room/Building</td>
<td>» If you select a specific building, then (all) rooms in the building are selected by default. You can select a specific room in the building.</td>
</tr>
<tr>
<td></td>
<td>» If you select a area, then you can select a specific building that is contained in the area.</td>
</tr>
<tr>
<td></td>
<td>» If you select a view, then Room is left blank; however, you can select a specific room to search.</td>
</tr>
<tr>
<td>Category</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific category (booking detail).</td>
</tr>
<tr>
<td>Resource</td>
<td>Available only if you select a category that is a resource or service order. The default value is set to (all). You can leave this value as is, or you can select a specific resource item.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Booking</td>
<td>The default value is set to (all). You can leave this value as is, or you</td>
</tr>
<tr>
<td>Status</td>
<td>can select a specific booking status.</td>
</tr>
</tbody>
</table>

5. Click **Get Data** or **Refresh**. Search results are listed on the **Results** tab just like they were for your Basic Search, with the same options for working with the results.

6. Click **Close** to save your changes and settings.
CHAPTER 66: People: Groups and Contacts

A group is an entity for which reservations are made at your facilities. A group is one of the four core data items that your EMS administrator must configure so that you can make reservations. A group can be an internal or external entity and it can be an organization or an individual. A contact is a person who serves as the coordinator or focal point for a group.

Concept: Attendees= Invitees; Group = Meeting Organizers

Attendees get invited, and groups and/or first contacts get notices about changes to the meeting on the Dashboard. Additionally, your Administrator sets the label for the Group field, so the name might vary; in the example below, it is labeled "Customer." A Group is responsible for the meeting, and can designate a First Contact to oversee questions, changes, and updates to the meeting.
CHAPTER 67: Search for People

Your organization might have re-labeled this button, "Customers" or "Employees." A group is an entity for which reservations are made at your facilities. A group can be an internal or external entity and it can be an organization or an individual. A group must be defined EMS Desktop Client before you can make reservations for it. Optionally, if you want to first confirm that a group has not already been configured, then you can search for the group.

**TIP:** Typically, your EMS administrator carries out basic configuration of the groups for which you need to make reservations. You always have the option of modifying any group that your EMS administrator has configured and you always have the option of configuring new groups when needed.

1. On the toolbar, click the **Groups** icon. The Groups window opens on the Results tab is the active tab, which lists the first 1000 groups in your EMS database that are Active.
TIP: Optionally, to change the number of records that are displayed in the Groups window, click **Options**, and then on the Group Options dialog box, select a different number of records to return.

2. Open the **Filter** tab and set your search criteria.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| Display Groups—Display all groups that meet your search criteria on the Results tab.
<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts</td>
<td>Display all contacts that meet your search criteria on the Results tab.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When a list of contacts is displayed, the contact's group is also displayed.</td>
</tr>
<tr>
<td>Search Fields</td>
<td>Starts with—The string is not case-sensitive, but your search is limited to the exact order of the characters in the string, and the string must begin with the information for which you are searching. For example, Assoc returns Association of Broadcasters but not Biomedical Student Association.</td>
</tr>
<tr>
<td></td>
<td>Contains—Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive, and the string can be found anywhere in your search results. For example, Assoc returns both Association of Broadcasters and Biomedical Student Association.</td>
</tr>
<tr>
<td>Group</td>
<td>Fields are available if you select Groups for Display. Enter values as needed in any or all fields.</td>
</tr>
<tr>
<td>Contact</td>
<td>Fields are available only if you select Contacts for Display. Leave all fields set to their default search values to search for all active contacts that are currently configured in your EMS database, or enter values as needed in any or all fields.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select Contact, then both the Group fields and the Contact fields are available for searching. If you enter data in both sets of fields when you are searching for a contact, then your search criteria must be met for both the contact and the contact's group to be displayed on the Results tab.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To reset the Filter at any time to its default settings, click Reset Filter.</td>
</tr>
</tbody>
</table>
3. Click **Get Data**. The **Results** tab opens with a list of search results that meet all your search criteria.

4. To further filter the display on the **Results** tab, in the Search field, enter a search string. The list of groups is dynamically updated as you enter your search string.

**TIP:** Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of Assoc returns both Association of Broadcasters and Biomedical Student Association.
CHAPTER 68: Add or Edit Profile Information for People and Groups

If authorized, you might be able to add or change profile information about groups or individuals in EMS Desktop Client.

To work with group or individual user profile information, you will:

» Open the Groups window.
» Search for existing Groups or Individuals.
» Add or Modify Basic Profile Information.
» Add or Modify Details for Groups/Individuals.
  » Contacts
  » Reminders
  » Comments
  » Reservations
  » Calculations
  » Everyday Users
  » Assign a Group to an Everyday User

Concept: Information on a Group or Individual Profile Is Used For
Reservations for That Group or Individual

The values you specify here are become available when a new reservation is made for the group or individual. A user can change these values if needed during the booking process.

OPEN THE GROUPS WINDOW

1. On the toolbar, click the Groups icon.

The Groups window opens on the Results tab is the active tab, which lists the first 1000 groups in your EMS database that are Active.
TIP: For instructions in filtering and navigating the list of groups shown above, See Also: Search for People.

SEARCH FOR EXISTING GROUPS OR INDIVIDUALS

The profile page for the group or individual displays, dividing information into a left panel of hierarchical details about the group or individual, and a right panel
showing basic information divided into four tabs: Summary, Billing Information, Other, and Audit.

2. From the Groups window:
   - To create a new group or individual profile, click the New button.
   - To edit an existing one, find and select the group or individual profile you want to Edit and then click Open, and on the profile page, click Edit.

The following dialog appears, where you can begin working with the basic profile information for the group or individual.
ADD OR MODIFY BASIC PROFILE INFORMATION

3. On each tab on the dialog shown above, and enter or change information as needed.

GROUP TAB

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required field. The name of the group.</td>
</tr>
</tbody>
</table>
### GROUP TAB

**NOTE:** The name can be a maximum of 50 characters, including spaces.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The street or mailing address for the group.</td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>ST</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td></td>
</tr>
<tr>
<td>Zip</td>
<td></td>
</tr>
<tr>
<td>International</td>
<td>Select this option to drop the State and Zip fields for an international group.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number and fax number for the group.</td>
</tr>
<tr>
<td>Fax</td>
<td><strong>NOTE:</strong> The Phone and Fax fields have a drop-down list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.</td>
</tr>
<tr>
<td>Email Address</td>
<td>The email address for the group.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL for the group's website.</td>
</tr>
</tbody>
</table>

**NOTE:** If your computer is connected to a network, click Search to open a Global Address Lookup dialog box and search for the email address.
GROUP TAB

Note: Web users can link to this group's website on the EMS Web App.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Contact</td>
<td>Populated with the name of the default contact for the group after you have defined default contacts for the group.</td>
</tr>
<tr>
<td>Require Contacts</td>
<td>Select this option if the group is to always require a contact when a reservation is being made for the group.</td>
</tr>
<tr>
<td>VIP</td>
<td>Select this option if the group is to be designated as a VIP group.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave this option blank to add the group as an active group. Select this option to inactivate the group.</td>
</tr>
</tbody>
</table>

BILLING INFORMATION TAB

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pricing Plan</td>
<td>Pick a pricing plan.</td>
</tr>
<tr>
<td>Account</td>
<td>Pick an account.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Pick a payment type.</td>
</tr>
</tbody>
</table>
### BILLING INFORMATION TAB

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salesperson</td>
<td>Pick the salesperson for the event.</td>
</tr>
<tr>
<td>Event Coordinator</td>
<td>Pick the event coordinator for the group.</td>
</tr>
<tr>
<td>Sales Category</td>
<td>Pick a sales category.</td>
</tr>
<tr>
<td>Status</td>
<td>The status is a way to indicate the standing or ranking of the group. The default values are the following:</td>
</tr>
<tr>
<td>OK</td>
<td>A reservation can be made for the group. (In your organization, this status could indicate that the group is current in payments due.)</td>
</tr>
<tr>
<td>Warning</td>
<td>If a group status is set to Warning, then a Warning message opens when you make a reservation for the group. It does not, however, prevent a reservation from being made for the group.</td>
</tr>
<tr>
<td>Bad</td>
<td>If a group status is set to Bad, then reservations cannot be made for the group.</td>
</tr>
<tr>
<td>Billing Reference Number</td>
<td>You can manually enter data into the field, or you can click the Search icon to open a master list of billing reference numbers and select a reference.</td>
</tr>
<tr>
<td>PO Number</td>
<td>You can manually enter data into the field, or you can click the Search icon to open a master list of PO Numbers and select a PO number.</td>
</tr>
<tr>
<td>External Reference</td>
<td>Links the group to an outside EMS Desktop Client, if needed.</td>
</tr>
</tbody>
</table>
### OTHER TAB

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network ID</td>
<td>The Windows login for the group.</td>
</tr>
<tr>
<td>Personnel Number</td>
<td>Organization number for the group.</td>
</tr>
<tr>
<td>Badge Number</td>
<td>Badge number for the group.</td>
</tr>
<tr>
<td>Other ID</td>
<td>Any secondary ID for the group.</td>
</tr>
</tbody>
</table>

4. After you finalize the information, click **OK**. You return to the Group profile window with the group still selected.

### ADD OR MODIFY DETAILS FOR GROUPS/INDIVIDUALS

5. To begin this process, navigate to the group or individual profile page you want to work with (see Step 2 above).
From the profile page for the group or individual, you can work with details about a group from the left panel.
**NOTE:** Adding and modifying information for a group or individual becomes fairly self-explanatory after the first few tries. This topic provides guidance and tips only where the workflow or field definitions might not be obvious, on the following types of information:

1. Contacts
2. Reminders
3. Comments
4. Reservations
5. Calculations

**ADD OR MODIFY CONTACTS**

1. In the left pane, select **Contacts**. Contacts for the group show in the right pane of the window. When a reservation is being made for this group or individual, the contacts defined here will be available for selection.
To add a new contact, click New.

To modify an existing contact, select the contact and click Edit.

2. Enter or edit information for the contact as needed using the field definitions below.
**TIP:** You can set this contact as the default (First Contact) on new reservations for this group or individual using the Set as Default checkbox here or the Set Default button on list of contacts (above).
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>The name of the contact.</td>
</tr>
</tbody>
</table>

**NOTE:** The name can be a maximum of 50 characters, including spaces.

<table>
<thead>
<tr>
<th>Title</th>
<th>The title (Mr., Ms., Dr., and so on) of the contact.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Populated with the name of the group that you selected. You cannot change this value.</td>
</tr>
<tr>
<td>Address</td>
<td>Populated with the address of the group that you selected. If the contact address is not the same as the group address, then clear Use Group Address and enter the appropriate values in the Address fields.</td>
</tr>
<tr>
<td>International</td>
<td>Select this option to drop the State and Zip fields for an international group.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number and fax number for the group.</td>
</tr>
</tbody>
</table>

**NOTE:** The Phone and Fax fields have a drop-down list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.

<table>
<thead>
<tr>
<th>Fax</th>
<th></th>
</tr>
</thead>
</table>

| Email Address | The email address for the contact.                                                          |

**NOTE:** If your computer is connected to a network, you can click Search to open a Global...
### FIELD DESCRIPTION

- **Address**
  - Address lookup.

- **External Reference**
  - Links the contact to an outside program if needed.

- **Notes**
  - Any other information that is pertinent for the contact.

- **Set as Default**
  - Select this option if the contact is to be the default contact for the selected group.

  **NOTE:** If a default contact has been defined for a group, then when you specify the group information for a reservation, the Contact field is automatically populated with the name of the default contact. You can always specify a contact as the default contact for a selected group at a later date. To do so, select the contact in the right pane, click Set Default, and then click Yes at the prompt to set the selected user as the default contact.

- **Inactive**
  - Leave this option blank to add the contact as an active contact. Select this option to inactivate the contact.

3. When finished, click **OK** to return to the group profile page.

### ADD OR MODIFY REMINDERS

1. In the left pane, select **Reminders**; all reminders for the group or individual show on the right pane.
2. Edit an existing reminder or create a New one.
TIP: Leave Date Completed blank so that the reminder shows on the Dashboard for the group or individual you are editing. In the Notes field, enter any further explanation or information about the reminder.

3. When finished, click OK to return to the group profile page.

ADD OR MODIFY COMMENTS

1. In the left pane, select Comments; all reminders for the group or individual show on the right pane.
2. Edit an existing comment or create a New one.
**TIP:** Choose a pre-configured Comment Type. If none of the pre-configured comment types meets your working needs, select (user specified comment), and then in the Description field, enter a description for the comment type. Select the **Alert Users** checkbox if you want the Alert to be highlighted on the group/individual dashboard.

3. When finished, click **OK** to return to the group profile page.

**ADD OR MODIFY RESERVATIONS**

1. In the left pane, select **Reservations**; all events for the group or individual show on the right pane.
**TIP:** Clicking **New** launches the Reservation Wizard. Selecting a reservation and clicking **Open** launches the Navigator. Clicking **Reassign** launches the dialog below, where you can assign the reservation to another Group or Individual.
2. When finished, click OK to return to the group profile page.

**ADD OR MODIFY CALCULATIONS**

Calculations are additional charges that can be applied to billable items (a category, a group, a group type, a resource, or a room) such as gratuity or sales tax. Both pricing methods and calculations determine the final cost for a billable item; however, unlike pricing, which is applied when a billable item is reserved (and retained, even if the price for the item later changes), calculations are figured each time a confirmation or an invoice is generated. Assigning calculations to a Group or Individual profile means that they will be included automatically in any invoicing for this group or individual. See Also: Configure Calculations.
1. In the left pane, select **Calculations**, and then click **Edit**. The Calculations dialog box opens.

2. On the Available list, use the Move arrows to move the selected calculations to the Selected list or visa versa.

3. When finished, click **OK** to return to the group profile page.
ADD OR MODIFY EVERYDAY USERS

Concept: Creating an Everyday User From a Group

An everyday user is a registered user who can submit requests for reservations or schedule reservations in EMS Web App. When you add a new group or individual in your database, you decide the “level” of the group that you are adding. For a group that is added at the individual (personnel/employee) level, you might also need to create an everyday user from the group. This user can then create and view reservations on behalf of a group or groups in EMS Web App.

You can create only one everyday user from a group. When you create an everyday user, you can also specify one or more delegates for the everyday user. A delegate is an everyday user who can create and view reservations on behalf of another everyday user.

1. On the toolbar, click the Groups icon.
2. Select the group for which you are creating the everyday user, then click **Tools > Create Everyday User**. A dialog box opens on the **Everyday User** tab.
3. Enter the information for the everyday user.

**TIP:** Ideally, you should enter all the necessary information before saving; however, if you need to access your everyday user, on the EMS menu bar, click **Configuration > Web > Everyday Users**.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Automatically populated after you select the group from the Groups window.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that an everyday user must enter to log in to EMS Web App.</td>
</tr>
<tr>
<td>Email address</td>
<td>If this information has been entered in the Groups window for the group, then this field is automatically populated after you select the group from the Groups window. If the field is blank, you must enter the full email address for the user. (The user must enter this address to log in to EMS Web App.)</td>
</tr>
<tr>
<td>Phone/Fax</td>
<td>Optional fields. If this information has been entered for the group, then these fields are automatically populated after you select the group from the Groups window. If the fields are blank, you can enter values if needed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional field.</td>
</tr>
<tr>
<td>External Reference</td>
<td>Optional field. Links the everyday user to a group and/or HR Toolkit.</td>
</tr>
<tr>
<td>Network ID</td>
<td>Optional field. The everyday user’s network ID.</td>
</tr>
<tr>
<td>Email Opt Out</td>
<td>Select this option if the everyday user is not to receive automatic emails (such as reservation summary emails) from EMS Web App. The user will still receive manually sent emails.</td>
</tr>
<tr>
<td>Status</td>
<td>Required field. Select the status for the everyday user:</td>
</tr>
</tbody>
</table>
### FIELD | DESCRIPTION
--- | ---
Active | The everyday user can log in to EMS Web App.
Inactive | The user cannot log in to EMS Web App and is instructed to contact the EMS administrator.
Pending | The everyday user cannot log in to EMS Web App and is informed that he/she must check back at a later time.

<table>
<thead>
<tr>
<th>Security Template</th>
<th>Required field. This determines the everyday user’s access to the system—the menu items that the user can see and the information that the user can view in a tooltip when ‘rolling-over’ an event in EMS Web App.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Zone</td>
<td>Required field. Select the time zone for the user.</td>
</tr>
</tbody>
</table>

**TIP:** Ideally, you should enter all the necessary information before saving; however, if you need to access your everyday user, on the EMS menu bar, click **Configuration > Web > Everyday Users.**

4. Open the Process Templates tab and on the Available list, use the arrows to move button templates to the Selected list. An everyday user process template defines the functions that are available to each type of everyday user in EMS Web App when the user is submitting a request for a reservation.
5. Open the Groups tab and do one of the following to specify the groups on whose behalf the everyday user can view and make reservations in EMS Web App.
   
   > The group (everyday user) is selected by default. You can leave this group in the Selected list, or you can select the group and click the Remove button (<).
   
   > Specify any combination of search criteria for the Find field and Group Type, and then click Display to produce a list of all groups that meet the criteria. In the Available list, select a group, or CTRL-click to select multiple groups, and then click the Move button (>\) to move the selected groups to the Selected list.

   **TIP:** If you leave the Find field blank, then a list of all currently active groups for the selected group type is displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, And returns Anderson, Scott, but not Cooper, Anderson.

6. Open the **Delegates** tab, and on the Search by drop-down list, do one of the following to specify the delegates for the everyday user:
   
   > Leave the Find field blank, and then click **Display** to open a list of all currently available Everyday Users. Select a user, or CTRL-click to select multiple
Everyday Users, and then click the Move button (>) to move the selected Everyday Users to the Selected list.

On the Search By drop-down list, select the option by which to search (Email Address or User Name), and in the Find field, enter the string by which to filter your search, and then click Display. Select an everyday user, or CTRL-click to select web multiple users, and then click the Move button (>) to move the selected users to the Selected list.

**TIP:** The string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bob.worth@emssoftwarea.com but not dbobbett@emssoftware.com.

7. You can click **Spelling** to spell check any information that you manually entered for the everyday user.

8. Click **OK**. The dialog box for creating an everyday user closes and a message opens indicating that the everyday user was created successfully.

9. Click **OK** to close the message and return to the Groups window.
ASSIGN A GROUP TO AN EVERYDAY USER

When you add a new group in your EMS database, you should also assign the group to an everyday user. This everyday user can then create and view reservations on behalf of the group in EMS Web App. You can assign a group to one or more Everyday Users.

1. On the toolbar, click the Groups icon.
2. Select the group you want to assign to Everyday Users, and then click **Tools** > **Assign to Everyday Users**. The Assign Group dialog box opens.

![Assign Group - Anderson, Scott](image)

3. To assign Everyday Users to the group, find the users. Click **Display** to open a list of all currently active Everyday Users or Search By Email Address or User Name.

4. Once you have found and selected the everyday user to assign, click the Move button (>) to move the selected users to the Selected list.

5. Click **Finish**. A message opens indicating that the group was assigned successfully.

6. Click **OK** to close the message and return to the Groups window.
CHAPTER 69: Create an Everyday User from a Group

Concept: An everyday user is a registered user who can submit requests for reservations or schedule reservations in EMS Web App.

When you add a new group or individual in your database, you decide the "level" of the group that you are adding. For a group that is added at the individual (personnel/employee) level, you might also need to create an everyday user from the group. This user can then create and view reservations on behalf of a group or groups in EMS Web App. You can create only one everyday user from a group. When you create an everyday user, you can also specify one or more delegates for the everyday user. A delegate is an everyday user who can create and view reservations on behalf of another everyday user.

1. On the toolbar, click the Groups icon.
2. Select the group for which you are creating the everyday user, then click **Tools > Create Everyday User**. A dialog box opens on the **Everyday User** tab.
3. Enter the information for the everyday user.
**TIP:** Ideally, you should enter all the necessary information before saving; however, if you need to access your everyday user, on the EMS menu bar, click **Configuration > Web > Everyday Users.**

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Automatically populated after you select the group from the Groups window.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that an everyday user must enter to log in to EMS Web App.</td>
</tr>
<tr>
<td>Email</td>
<td>If this information has been entered in the Groups window for the group, then this field is automatically populated after you select the group from the Groups window. If the field is blank, you must enter the full email address for the user. (The user must enter this address to log in to EMS Web App.)</td>
</tr>
<tr>
<td>Phone/Fax</td>
<td>Optional fields. If this information has been entered for the group, then these fields are automatically populated after you select the group from the Groups window. If the fields are blank, you can enter values if needed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional field.</td>
</tr>
<tr>
<td>External Reference</td>
<td>Optional field. Links the everyday user to a group and/or HR Toolkit.</td>
</tr>
<tr>
<td>Network ID</td>
<td>Optional field. The everyday user's network ID.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email Opt</td>
<td>Select this option if the everyday user is not to receive automatic emails (such as reservation summary emails) from EMS Web App. The user will still receive manually sent emails.</td>
</tr>
<tr>
<td>Status</td>
<td>Required field. Select the status for the everyday user:</td>
</tr>
<tr>
<td></td>
<td>➢ <strong>Active</strong>—The everyday user can log in to EMS Web App.</td>
</tr>
<tr>
<td></td>
<td>➢ <strong>Inactive</strong>—The user cannot log in to EMS Web App and is instructed to contact the EMS administrator.</td>
</tr>
<tr>
<td></td>
<td>➢ <strong>Pending</strong>—The everyday user cannot log in to EMS Web App and is informed that he/she must check back at a later time.</td>
</tr>
<tr>
<td>Security</td>
<td>Required field. This determines the everyday user's access to the system—the menu items that the user can see and the information that the user can view in a tooltip when 'rolling-over' an event in EMS Web App.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Required field. Select the time zone for the user.</td>
</tr>
</tbody>
</table>

**TIP:** Ideally, you should enter all the necessary information for your everyday user before you save the everyday user; however, at any time if you need to access your everyday user, on the EMS menu bar, click **Configuration > Web > Everyday Users.**

4. Open the **Process Templates** tab and on the Available list, use the arrows to move button templates to the Selected list. An everyday user process template defines
the functions that are available to each type of everyday user in EMS Web App when the user is submitting a request for a reservation.

5. Open the Groups tab and do one of the following to specify the groups on whose behalf the everyday user can view and make reservations in EMS Web App.

- The group (everyday user) is selected by default. You can leave this group in the **Selected** list, or you can select the group and click the Remove button (<).
- Specify any combination of search criteria for the Find field and Group Type, and then click **Display** to produce a list of all groups that meet the criteria. In the **Available** list, select a group, or CTRL-click to select multiple groups, and then click the Move button (>) to move the selected groups to the **Selected** list.

**TIP:** If you leave the Find field blank, then a list of all currently active groups for the selected group type is displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, **And** returns Anderson, Scott, but not Cooper, Anderson.

6. Open the **Delegates** tab, and on the Search by drop-down list, do one of the following to specify the delegates for the everyday user:
Leave the Find field blank, and then click **Display** to open a list of all currently available Everyday Users. Select a user, or CTRL-click to select multiple Everyday Users, and then click the Move button (>) to move the selected Everyday Users to the Selected list.

On the Search By drop-down list, select the option by which to search (Email Address or User Name), and in the Find field, enter the string by which to filter your search, and then click **Display**. Select an everyday user, or CTRL-click to select web multiple users, and then click the Move button (>) to move the selected users to the Selected list.

**TIP:** The string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bob.worth@emssoftwarea.com but not dbobbett@emssoftware.com.

7. You can click **Spelling** to spell check any information that you manually entered for the everyday user.

8. Click **OK**. The dialog box for creating an everyday user closes and a message
opens indicating that the everyday user was created successfully.

9. Click **OK** to close the message and return to the Groups window.
CHAPTER 70: Assign Everyday Users to a Group

When you add a new group in your EMS database, you should also assign an everyday user to the group. This everyday user can then create and view reservations on behalf of the group in EMS Web App. You can assign a group to one or more Everyday Users.

1. On the toolbar, click the Groups icon.
2. Select the group you want to assign to Everyday Users, and then click Tools > Assign to Everyday Users. The Assign Group dialog box opens.
3. To assign Everyday Users to the group, find the users. Click Display to open a list of all currently active Everyday Users or Search By Email Address or User Name.

4. Once you have found and selected the everyday user to assign, click the Move button (>) to move the selected users to the Selected list.

5. Click Finish. A message opens indicating that the group was assigned successfully.

6. Click OK to close the message and return to the Groups window.
CHAPTER 71: Configure Contacts for a Group

A contact is a person who serves as the coordinator or focal point for a group. You have two options for configuring a contact for a group. You can configure a "free form" contact, which requires you to manually enter the contact information, or you can configure a contact from another group, which means that you do not have to manually enter the contact information. Instead, the group information is automatically used for the contact.

**TIP:** You can also configure and edit a contact "on the fly" during the reservation process. See [Create a Reservation in the Reservation Wizard](#) for details.

### CONFIGURE CONTACTS

1. Open the Groups window and search for the group for which you are configuring the contact. See [To search for a group and/or contact](#).
2. Select the group, and then click Open. A group-specific window opens. The group is automatically selected in the window.
3. In the left pane of the group-specific window, select Contacts. A list of all currently active contacts for the group is displayed in the right pane of the group-specific window.

**TIP:** Optionally, to display all group contacts regardless of status, click **Show Inactive.** Any inactive contacts are displayed in red italics in the right pane.
4. Continue to one of the following:

» Configure a contact manually
» Configure a contact from a group

CONFIGURE A CONTACT MANUALLY

1. Click New. The Contact dialog box opens.
2. Enter the information for the new contact.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>The name of the contact.</td>
</tr>
<tr>
<td>Title</td>
<td>The title (Mr., Ms., Dr., and so on) of the contact.</td>
</tr>
<tr>
<td>Group</td>
<td>Populated with the name of the group that you selected. You cannot change this value.</td>
</tr>
<tr>
<td>Address</td>
<td>Populated with the address of the group that you selected. If the contact address is not the same as the group address, then clear Use Group Address and enter the appropriate values in the Address fields.</td>
</tr>
<tr>
<td>International</td>
<td>Select this option to drop the State and Zip fields for an international group.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number and fax number for the contact. By default, they are set to the phone number and fax number for the group, but you can always edit these values.</td>
</tr>
<tr>
<td>Fax</td>
<td>The Phone and Fax fields have a drop-down list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.</td>
</tr>
<tr>
<td>Email</td>
<td>The email address for the contact.</td>
</tr>
</tbody>
</table>

NOTE: The name can be a maximum of 50 characters, including spaces.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td><strong>NOTE:</strong> If your computer is connected to a network, click the Search icon to open a Global Address Lookup dialog box and search for the email address.</td>
</tr>
<tr>
<td>External Reference</td>
<td>Links the contact to an outside program, for example, HR Toolkit, if needed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any other information that is pertinent for the contact.</td>
</tr>
<tr>
<td>Set as Default</td>
<td>Select this option if the contact is to be the default contact for the selected group.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave this option blank to add the contact as an active contact. Select this option to inactivate the contact.</td>
</tr>
</tbody>
</table>
3. Optionally, do one or both of the following:
   » Click Spelling to spell check the information for the contact before you save it.
   » Make sure that the newly created contact is selected so that you can create a everyday user from the contact.

4. Click OK. The Contact dialog box closes. The contact is added to the group. The group-specific window remains open.

CONFIGURE A CONTACT FROM A GROUP

1. Click Tools > Click Create Contact from Another Group. A second Groups window opens.
2. Search for the group that is to be the source of the contact, and then click 
   Select. The Contact dialog box opens. The name of the group (contact source) is displayed in the Group field and you cannot edit this value. The remainder of the fields (Contact Name, Address, Phone, and so on) display the information for the group that you selected when you Configured Contacts.

  **TIP:** See Search for a group and/or contacts.
3. If needed, edit the information for the contact.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>The name of the contact.</td>
</tr>
</tbody>
</table>

**NOTE:** The name can be a maximum of 50 characters, including spaces.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title (Mr., Ms., Dr., and so on) of the contact.</td>
</tr>
<tr>
<td>Group</td>
<td>Populated with the name of the group that you selected first (the group for which you are configuring the contact). You cannot change this value.</td>
</tr>
<tr>
<td>Address</td>
<td>Populated with the address of the contact. If the contact address is the same as the group address, then select Use Group Address to populated the address fields with the group address; otherwise, you can edit these values.</td>
</tr>
<tr>
<td>International</td>
<td>Not applicable if Use Group Address is selected. Select this option to drop the State and Zip fields from the address for an international contact.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number and fax number for the group.</td>
</tr>
<tr>
<td>Fax</td>
<td><strong>NOTE:</strong> The Phone and Fax fields have a drop-down list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.</td>
</tr>
<tr>
<td>Email Address</td>
<td>The email address for the contact.</td>
</tr>
</tbody>
</table>

**NOTE:** If your computer is connected to a network, click the Search icon to open a Global Address Lookup dialog box and search for the email address.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Reference</td>
<td>Links the contact to an outside program, for example, HR Toolkit, if needed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any other information that is pertinent for the contact.</td>
</tr>
<tr>
<td>Set as Default</td>
<td>Select this option if the contact is to be the default contact for the selected group.</td>
</tr>
</tbody>
</table>

**NOTE:** If a default contact has been defined for a group, then when you specify the group information for a reservation, the Contact field is automatically populated with the name of the default contact.

**NOTE:** You can always specify a contact as the default contact for a selected group at a later date.

| Inactive | Leave this option blank to add the contact as an active contact. Select this option to inactivate the contact. |

4. Optionally, do one or both of the following:
   - Click Spelling to spell check the information for the contact before you save it.
   - Make sure that the newly created contact is selected so that you can create an everyday user from the contact. See [To create a everyday user from a contact](#).

5. Click OK. The Contact dialog box closes. The contact is added to the group. The group-specific window remains open.
CREATE AN EVERYDAY USER FROM A CONTACT

An everyday user is a registered user who can submit requests for reservations or schedule reservations in EMS Web App. When you add a contact to a group in your EMS database, you might also need to create a user from the contact. This user can then create and view reservations on behalf of the contact's group in EMS Web App. You can create only one user from a contact. When you create a user, you can also specify one or more delegates for the user. A delegate is a user who can create and view reservations on behalf of another user.

1. If needed, open the group that contains the contact from which you are creating the everyday user in the group-specific window. See Configure Contacts.
2. In the left pane of the group-specific window, make sure that Contacts is selected.
3. In the right pane of the window, select the contact from which you are creating the everyday user.
4. Click Tools > Create Everyday User from Contact. A contact-specific dialog box opens. The everyday user tab is the active tab.
**TIP:** The User Defined Fields tab displays the questions that a everyday user was required to answer when the user requested to create an account through EMS Web App and it is not relevant to the procedure that is described below.
5. Enter the information for the everyday user.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Automatically populated after you select the contact. You can edit this information.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that a everyday user must enter to log in to EMS Web App.</td>
</tr>
<tr>
<td>Email Address</td>
<td>If this information has been entered for the contact, then this field is automatically populated after you select the contact. If the field is blank, you must enter the full email address for the user. (The user must enter this address to log in to EMS Web App.)</td>
</tr>
<tr>
<td>Phone/Fax</td>
<td>Optional fields. If this information has been entered for the contact, then these fields are automatically populated after you select the contact. If the fields are blank, you can enter values if needed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional field.</td>
</tr>
<tr>
<td>External Reference</td>
<td>Optional field. Links the everyday user to an outside program if needed.</td>
</tr>
<tr>
<td>Network ID</td>
<td>Optional field. The everyday user's network ID.</td>
</tr>
<tr>
<td>Email Opt Out</td>
<td>Select this option if the everyday user is not to receive automatic emails (such as reservation summary emails) from EMS Web App. The user will still receive manually sent emails.</td>
</tr>
<tr>
<td>Status</td>
<td>Required field. Select the status for the everyday user:</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>The everyday user can log in to EMS Web App.</td>
</tr>
<tr>
<td>Inactive</td>
<td>The user cannot log in to EMS Web App and is instructed to contact the EMS administrator.</td>
</tr>
<tr>
<td>Pending</td>
<td>The everyday user cannot log in to EMS Web App and is informed that he/she must check back at a later time.</td>
</tr>
</tbody>
</table>

**Security Template**

Required field. This determines the everyday user’s access to the system’s menu items that the user can see and the information that the user can view in a tooltip when ‘rolling-over’ an event in EMS Web App.

**Time Zone**

Required field. Select the time zone for the user.

6. Open the Process Templates tab and on the Available list, select the everyday user process template or CTRL-click to select the multiple templates to which this user is to be assigned, and then click the Move button (>) to move the selected templates to the Selected list.

**TIP:** An everyday user process template defines the functions that are available to each type of everyday user in EMS Web App when the user is submitting a request for a reservation.
7. Open the Groups tab and do one of the following to specify the groups on whose behalf the everyday user can view and make reservations in EMS Web App.

- The contact's group is selected by default. You can leave this group in the Selected list, or you can select the group and click the Remove button («).
- Specify any combination of search criteria for the Find field and Group Type, and then click Display to produce a list of all groups that meets the criteria. In the Available list, select a group, or CTRL-click to select multiple groups, and then click the Move button (>) to move the selected groups to the Selected list.

**TIP:** If you leave the Find field blank, then a list of all currently active groups for the selected group type is displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is limited to the exact order of the characters in the string and the string must begin with the information for which you are searching. For example, AAA returns AAA Colorado, but not Colorado AAA.

8. Open the Delegates tab, and on the Search by drop-down list, do one of the following to specify the delegates for the everyday user:

- Leave the Find field blank, and then click Display to open a list of all currently available everyday users. Select a everyday user, or CTRL-click to select
multiple everyday users, and then click the Move button (>) to move the selected everyday users to the Selected list.

On the Search By drop-down list, select the option by which to search (Email Address or User Name), and in the Find field, enter the string by which to filter your search, and then click Display. Select a everyday user, or CTRL-click to select multiple everyday users, and then click the Move button (>) to move the selected everyday users to the Selected list.

**TIP:** The string is not case-sensitive, but your search is limited to the exact order of the characters in the string and the string must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

9. Optionally, click Spelling to spell check any information that you manually entered for the user.
10. Click OK. The dialog box for creating a everyday user closes and a message opens indicating that the everyday user was created successfully.
11. Click OK to close the message and return to the group-specific window.
CHAPTER 72: Import Groups

You can import groups into your EMS database from a tab-delimited text file. (See Import File Specification in the EMS Desktop Client Configuration Guide for the file specifications.)

1. On the EMS toolbar, click the Groups icon. The Groups window opens.
2. Click Import. The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that you are importing. A dialog box opens, indicating the number of groups that you are about to import, and asking you if you want to continue.

4. Click Yes. A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups window.
CHAPTER 73: Print and Export Everyday User Information

You can print a variety of information for selected everyday users and you can also export a list of selected everyday users (name and email address) to an Excel spreadsheet.

TO PRINT OR EXPORT EVERYDAY USER INFORMATION

1. On the EMS menu bar, click Configuration > Everyday User Applications > Everyday Users. The Everyday Users dialog box opens. In the upper left corner, the number of everyday users currently in use for EMS Web App is displayed. In the example below, "Group" has been relabeled "Employee."
Everyday Users Dialog Box

2. Enter any combination of the following search criteria:
   - On the Group Type drop-down list, leave the group type set to the default value of (all), or select a specific group type.
   - On the Search by drop-down list, select User Name or Email Address.
   - On the Status drop-down list, select the user status by which to search.
   - On the Process Template drop-down list, leave the default value of (all), or select a specific web process template.
3. To further filter the displayed search results do one or both of the following:
   » To filter the search results based on either the User Name or Email Address, in the Filter field, enter a search string.
   » To filter the search results based on city, in the City field, enter a search string.

4. Click **Display**. The everyday users who meet your search criteria are displayed in the lower pane of the everyday users window.

5. Continue to one of the following:
   » **Print everyday user information**
   » **Export a list of everyday users to an Excel spreadsheet**

### PRINT EVERYDAY USER INFORMATION

1. On the everyday users window, click Print. A list with a variety of options for printing information for the everyday users that are currently displayed in the everyday users window opens.

2. Select the information that you want to print for the displayed everyday users.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List</strong></td>
<td>Opens an onscreen preview of a list of all the everyday users (user name, email address, status, security template, process template, and last login) who are currently displayed in the everyday users window. The list is sorted alphabetically by everyday user name.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delegates</td>
<td>Opens an onscreen preview of a list of all the delegates (delegate name, delegate email address, delegate status, everyday user, everyday user email address, and everyday user status) for all the active everyday users who are currently configured in your EMS database. The list is sorted alphabetically by web delegate name and then by everyday user name for everyday users that have multiple delegates.</td>
</tr>
<tr>
<td>Delegates by everyday user</td>
<td>Opens an onscreen preview of a list of all the delegates (user name, everyday user email address, everyday user status, delegate name, delegate email address, and delegate status) for all the active everyday users who are currently configured in your EMS database. The list is sorted alphabetically by everyday user name and if a everyday user has multiple delegates, the delegate is then sorted alphabetically by delegate name.</td>
</tr>
</tbody>
</table>

**NOTE:** A variety of options is available from an onscreen preview, including the options to print a hard copy of the information, to export the information to a .pdf, and to email the printed information.

**EXPORT A LIST OF EVERYDAY USERS TO AN EXCEL SPREADSHEET**

On the everyday users window, click Export. A Save As dialog box opens for naming the file and selecting the location in which to save the file. (The file contains the name and address for each everyday user that is currently displayed in the everyday users window.) By default, the file is named everyday user List.xls, and the file location is your Document Library, but you can change the
name if needed, and you can also select a different location in which to save the file. After you name and save the file, you have the option of previewing the exported file.

**TIP:** To preview the file, Microsoft Excel must be installed on your EMS client.
CHAPTER 74: Print and Export Group Information

You can print a variety of information for selected groups such as contact summary information, status exceptions, group import format information, and billing information, and you can also export a list of selected groups and the summary information for each group (type, name, address, and so on) to an Excel spreadsheet.

PRINT GROUP INFORMATION

1. Search for the groups for which you are printing the information. See Search for a group and/or contact.
2. On the Groups window, click Print. A list with a variety of options for printing information for the groups that are currently displayed in the Groups window opens.
3. Select the information that you want to print for the displayed groups.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Opens an onscreen preview of all groups (group name, address, phone number, email address, pricing plan, and status) that are currently displayed in the Groups window. The groups are sorted by group type.</td>
</tr>
<tr>
<td>Contact Summary</td>
<td>Opens an onscreen preview of all the contacts (group name, group phone number, contact name, and contact phone number) that have been configured for all the groups that are currently displayed in the Groups window.</td>
</tr>
<tr>
<td>Status Exceptions</td>
<td>Opens an onscreen preview of a list of groups that is derived from all the groups that are currently displayed in the Groups window that have any status other than OK.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Import Format</td>
<td>Opens an onscreen preview of the required format for the tab-delimited file that is to be used when importing groups.</td>
</tr>
</tbody>
</table>

**Note:** A variety of options are available from an onscreen preview, including the options to print a hard copy of the information, to export the information to a .pdf, and to email the printed information.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>See Generate an EMS Billing Report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Report</td>
<td></td>
</tr>
<tr>
<td>Statements</td>
<td></td>
</tr>
<tr>
<td>Voided Transaction Report</td>
<td></td>
</tr>
<tr>
<td>Ageing Report</td>
<td></td>
</tr>
<tr>
<td>General Ledger Distribution</td>
<td></td>
</tr>
</tbody>
</table>
Example of an onscreen preview of printed group information

<table>
<thead>
<tr>
<th>Group</th>
<th>Address</th>
<th>Phone 1</th>
<th>Phone 2</th>
<th>Email Address</th>
<th>Pricing Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CU Alumni Association</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Registrar</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sarah Colley</td>
<td>123 e. 5th St  Denver, CO 80218</td>
<td>303-912-7677</td>
<td></td>
<td><a href="mailto:sarah.colley@dea.com">sarah.colley@dea.com</a></td>
<td></td>
</tr>
<tr>
<td>(none)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Big Brothers Charity</td>
<td>3561 S. Harlan St  Denver, CO 80236</td>
<td>555.555.6002</td>
<td>555.555.7934</td>
<td><a href="mailto:heatherfors@dot.com">heatherfors@dot.com</a></td>
<td>External Non</td>
</tr>
<tr>
<td>Bryan Sorrentino</td>
<td>6613 DTC Parkway, Suite 1200  Greenwood Village, CO 80111</td>
<td>303-796-7429</td>
<td></td>
<td><a href="mailto:bryan.sorrentino@dea.com">bryan.sorrentino@dea.com</a></td>
<td>External Fort</td>
</tr>
<tr>
<td>Colorado Association of Geologists</td>
<td>3023 S Penn Ave  Rifle, CO 80212</td>
<td>303-655-1232</td>
<td>303-655-4322</td>
<td><a href="mailto:geologist@dea.com">geologist@dea.com</a></td>
<td>External Non</td>
</tr>
<tr>
<td>Dean Evans &amp; Associates, Inc</td>
<td>6613 DTC Parkway, Suite 1200  Greenwood Village, CO 80111</td>
<td>800-440-3994</td>
<td>303-796-7429</td>
<td><a href="mailto:sales@dea.com">sales@dea.com</a></td>
<td>External Fort</td>
</tr>
<tr>
<td>Dr. James House</td>
<td>4504 Broadway  Denver, CO 80210</td>
<td>303-655-9999</td>
<td>303-655-0000</td>
<td><a href="mailto:james@dea.com">james@dea.com</a></td>
<td>External Fort</td>
</tr>
</tbody>
</table>

**EXPORT A LIST OF GROUPS TO AN EXCEL SPREADSHEET**

1. Search for the groups that are you exporting to an Excel spreadsheet. See [Search](#) for a group and/or contact.
2. On the Groups window, click [Export](#). A Save As dialog box opens for naming the file and selecting the location in which to save the file. (The file details the
summary information—type, name, address, and so on—for each group.) By default, the file is named Groups.xls, and the file location is your Document Library, but you can change the name if needed, and you can also select a different location in which to save the file. After you name and save the file, you have the option of previewing the exported file.

TIP: To preview the file, Microsoft Excel must be installed on your EMS client.
CHAPTER 75: Work with Reservations for a Group

You have a variety of options for working with the reservations for a group. You can:

- Search for and make a reservation for a group from the Groups window.
- Search for and make a reservation for a group from the group-specific window.
- Search for reservations by group, and then open and view any existing reservations in the Navigator for a group from the group-specific window.
- Reassign the reservations for a group or contact from the group-specific window.

In EMS Workplace, you can also make a group reservation from the Group Reservation window.

WORK WITH RESERVATIONS FOR A GROUP

1. Open the Groups window and search for the appropriate group.
2. On the Groups window, select the group, and then do one of the following:
   - Click **New Reservation** at the top of the window to open the Reservation Wizard, and then continue to [Create a Reservation in the Reservation Wizard](#).
Click **Open** to open the group-specific window (the group is automatically selected in the window), and then continue to one of the following:

- **Search for and view reservations by group from the group-specific window**
- **Search for and make a reservation for a group from the group-specific window**
- **Reassign a reservation for a group from the group-specific window**

### SEARCH FOR AND VIEW RESERVATIONS BY GROUP FROM THE GROUP-SPECIFIC WINDOW

1. In the left pane of the group-specific window, select **Reservations**. All reservations that have been made for the group in your EMS database and that have a date greater than or equal to the current day’s date are displayed in the right pane of the group-specific window.

   **TIP:** Optionally, to show all reservations that have been made for the group, click **Show Old**.
2. In the right pane of the group-specific window, select the appropriate reservation, and then click **Open**. The reservation opens in the Navigator.

3. Continue to the **Navigator**.

SEARCH FOR AND MAKE A RESERVATION FOR A GROUP FROM THE GROUP-SPECIFIC WINDOW

1. In the left pane of the group-specific window, select **Reservations**. All reservations that have been made for the group in your EMS database and that have a date greater than or equal to the current day’s date are displayed in the right pane of the group-specific window.

   **TIP:** Optionally, to show all reservations that have been made for the group, click **Show Old**.

2. Click **New**. The Reservation Wizard opens.

3. Continue to **Create a Reservation in the Reservation Wizard**.
REASSIGN A RESERVATION FOR A GROUP FROM THE GROUP-SPECIFIC WINDOW

1. In the left pane of the group-specific window, select Reservations. All reservations that have been made for the group in your EMS database and that have a date greater than or equal to the current day’s date are displayed in the right pane of the group-specific window.

   **TIP:** Optionally, to show all reservations that have been made for the group, click Show Old.

2. In the right-pane of the group-specific window, select the appropriate reservation, or CTRL-click to select multiple reservations, and then click Reassign. The Reassign Group/Contact on Reservations dialog box opens.
3. On the Group drop-down list, select the group to which you are reassigning the reservation, or click the Search icon to open the Groups window and search for the group.

4. Optionally, edit any and/or all of the group information as needed.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Contact</td>
<td>The contact for the group to which you are reassigning the reservation.</td>
</tr>
<tr>
<td>2nd Contact</td>
<td>NOTE: If none of the pre-configured contacts is appropriate, then select (temporary contact) and in the Temp Contact field, enter the name of the temporary contact.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone, fax, and email address for the contacts for the group to which the reservation is being reassigned. If you selected from the list of the pre-configured contacts, then some or all of this information might be auto-</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Fax</td>
<td>matically populated, but you can still edit the values. If you selected a (temporary contact), then you must enter this information for the contact.</td>
</tr>
<tr>
<td>Email Address</td>
<td></td>
</tr>
<tr>
<td>Web User</td>
<td>The web user for the group. Initially, this field is set to (no change) which means that the web user for the group to which you are reassigning the reservation is to remain as is; however, if needed, you can click the <strong>Search</strong> icon to open the Web Users dialog box and select a different web user.</td>
</tr>
</tbody>
</table>

- You can search by User Name or Email Address.
- To search a list of all available web users, leave the Search field in the Web Users dialog box blank, and then click **Display**.
- To search for a specific web user, enter a search string in the Search field, and then click **Display**.

---

**NOTE:** The string is not case-sensitive, but your search is limited to the exact order of characters in the string and the string must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bobworth@emssoftware.com but not dbobbett@emssoftware.com.

---

**NOTE:** To return this field to the (no change) value at any time, click **Reset**.
5. Click **OK**. A Reassign Reservations message opens, asking you if it is OK to reassign the selected reservations to the group.

6. Click **Yes**. The Reassign Reservations message closes and a second Reassign Reservations message opens, indicating the reservations were successfully reassigned.

7. Click **OK**. The message closes, and the reassigned reservations are no longer displayed in the group-specific window.

**TIP:** You might have to click **Reservations** in the left-pane of the group-specific window to refresh the display.

**TO MAKE A GROUP RESERVATION FROM THE GROUP RESERVATION WINDOW (EMS WORKPLACE ONLY)**

1. On the EMS Workplace toolbar, click the Group Reservation icon.

   ![Group Reservation Icon](image)

   The Group Reservation window opens. The **Results** tab is the active tab.
2. Open the **Filter** tab, and search for the group for which you are making a reservation. See **Search for a group and/or contact**.

3. Select the group for which you are making the reservation, and then click **Reservation**. A drop-down list of the available Reservation Wizard templates opens.
4. Select the appropriate template. The Reservation Wizard opens. The name of the group for which you are making the reservation is displayed in the title bar of the Reservation Wizard. The Reservation Wizard template that you selected is displayed on the Wizard Template drop-down list at the top of the Reservation Wizard. (You can always select a different template if needed.)

**TIP:** Depending on how your EMS administrator has configured the template that you selected, you might be prompted to select a reservation start date before the Reservation Wizard opens.
5. Continue making the reservation as you normally would. See Create a Reservation in the Reservation Wizard.
CHAPTER 76: Email a Group

Whether your organization uses Microsoft Outlook or SMTP, you can always email an EMS group.

Tip: If your organization uses Microsoft Outlook, you can continue to use this email system to send emails to EMS groups; otherwise, to email an EMS group using the SMTP option, your user account must have an email address.

TO EMAIL A GROUP

1. Search for the group that you are emailing.
2. Do one of the following:
   » On the Groups window, select the group and then click Email. Depending on how your system is configured, either a pre-addressed Outlook email form or a pre-addressed SMTP email form opens. The To field is populated with the email address that is defined for the group, but you can edit this value if needed.
   » On the Groups window, select the group, and then click Open.
3. The group-specific window opens.
4. On the group-specific window, make sure that the group is selected in the left pane, and then click Email. Depending on how your system is configured, either a
pre-addressed Outlook email form or a pre-addressed SMTP email form opens. The To field is populated with the email address that is defined for the group, but you can edit this value if needed.

5. Complete and send the email as you normally would.
CHAPTER 77: The Dashboard

The Dashboard is a window that centralizes critical information about reservations in a single location. The information that is displayed on this window, including notifications, reminders, web reservations, and so on, provides you with the necessary input to manage your work in EMS.
CHAPTER 78: Overview of the Dashboard

The Dashboard is often used by administrative users to supervise, review, process, and approve many types of activities in the system. When the window first opens, it has the following tabs:

» Notifications Tab
» Reminders Tab
» Everyday User Reservations Tab
» Guest Requests Tab
» Wait List Tab
» Reconfirm Dates Tab
» Building Hours Exceptions Tab
» Analytics Tab
» At A Glance Tab

You can sort columns on a tab in ascending or descending order, and you can rearrange columns by dragging the column heading, and you can change their widths.
**TIP:** Click the Dashboard icon at any time to open the Dashboard window.

See Also: [Managing Requests for Managed Space](#).

**Dashboard Window**
CUSTOMIZING YOUR DASHBOARD OPTIONS

You can customize the appearance and behavior of your Dashboard under Options in the upper-right corner.

*Dashboard Options Dialog*
**Dashboard Options Dialog Fields**

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Dashboard At Startup If Items Exist</td>
<td>Selected by default. The Dashboard window opens automatically after you log into EMS if any tab displays at least one item.</td>
</tr>
</tbody>
</table>

- Show Reminders
- Show Everyday User Reservations
- Show Guest Requests
- Show Analytics
- Show Wait List
- Show Reconfirm Dates
- Show Building Hours Exceptions
- Show At A Glance

“Thru Today” includes xx Days Prior to Today Indicates how far into the past that reminders are to be displayed in the “Thru Today” view. The default value is seven.

Activate Flashing Indicator For: Set on a per tab basis. Indicates when the Dashboard icon on the EMS toolbar is to flash if at least one item is displayed on any tab. Values are:

- Notifications  Automatically–Immediately when there is at least one record that is displayed on
<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reminders</td>
<td>the indicated tab, even when you are working in EMS.</td>
</tr>
<tr>
<td>Everyday User Reservations</td>
<td>At Startup Only</td>
</tr>
<tr>
<td>Guest Requests</td>
<td>Never</td>
</tr>
</tbody>
</table>

Activate Flashing Indicator For:

- Wait List
- Reconfirm Date Reminders
- Building Hours Exceptions

Set on a per tab basis. Indicates when the Dashboard icon on the EMS toolbar is to flash if tasks on the tab require your attention. Values are:

- At Startup Only
- Never
CHAPTER 79: Notifications Tab

Concept: Changing Events Can Automatically Notify Users

Your Administrator can automate alerts to be sent to you (or groups of which you are a member) when changes or additions have been made in EMS for bookings and reservations, service orders, room types, setup types, user accounts, and so on. When you create a reservation or booking that has these notifications turned on, users will receive these alerts without requiring additional effort from you. Be sure to review these notification settings during the process of creating or modifying events.

If your EMS Web App implementation uses the Integration to Microsoft Exchange, you can handle notifications using Outlook.

Concept: Integration to Microsoft® Exchange Enables You to Use Outlook®

If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of meeting rooms and attendees, and send Microsoft® Outlook meeting invitations, all from within EMS Web App.
You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange in order to configure and use this capability. If you are unsure if your organization is licensed for Integration to Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account Executive.

NOTIFICATIONS TAB OVERVIEW

When the Notifications tab first opens, all the notification rules that include you are listed in the Notification Rule pane (upper left pane) of the tab. Next to each rule, the number of new notifications (notifications with the current day's date) is displayed.
The **Notifications** tab is interactive. For Notification Rules, you can:

- Select a rule, and under Show, select **Unreviewed** to view all unreviewed notifications for future bookings.
- Select a rule, and under Show, select **Reviewed** to view all reviewed notifications for future bookings.
- Select a rule, and under Show, select **Old** to view all notifications for past bookings.

For Notifications, you can:
Select a notification to view detailed information about the notification (such as new bookings, the changes made to a booking, and the users who were notified of the changes) in a pane at the bottom of the window.

Select **Show New Only** to show only new notifications (notifications with the current day's date) for the notification rules.

Select a notification, and then click **Reviewed** to mark a notification as "Reviewed."

Select a notification and then click **Go To** to open the item to which the notification refers.

If the notification is attached to a reservation, booking, or booking detail, then the reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically selected.

If the notification is attached to a group, then the Group window opens with the group information displayed in the window.

Click **Refresh** to check for notifications that have been issued since you opened the Dashboard.

Select a notification, or CTRL-click to select multiple notifications, and then click **Delete** to delete the notifications from the **Notifications** tab.
CHAPTER 80: Confirmations vs. Notifications, What's the Difference?

CONFIRMATIONS

» These are either sent out automatically after a booking is made in EMS Web App, or manually from the EMS desktop client.

» They contain the date/time/resources for the booking that was created.

» These usually go to end users so they know when their event is and if they owe any money.

NOTIFICATIONS

» These are sent out automatically based on the filters on the notification rule:

» There are five types of notification rules:

  - Bookings
  - Service Orders
  - Anything On A VIP Event
  - New Web Users
  - User Defined Field

» These are mostly sent out X days before a booking. They are triggered when a change occurs on a booking, service order, and so forth within that range of days.
CHAPTER 81: Reminders Tab

A comment is a text entry that explains or clarifies a reservation, booking, group, or service order. A reminder is a comment that has a due date associated with it. The Reminders tab displays all the reminders for which you are the responsible user and that, by default, have a due date through the current day’s date.

To work with reminders, you can:

» Change the Reminders View
» Create Unattached Reminders
» Change a Reminder
» Delete a Reminder
» Print a Reminder
» View an Item to Which a Reminder is Attached
» Mark a Reminder Complete
» Reassign Multiple Reminders Between EMS Users

CHANGING THE REMINDERS VIEW

By default, when the Dashboard window first opens, the Reminders tab displays all the reminders for which you are the responsible user and that have a due date through the current day’s date. You can do one or more of the following to change this view:

» To view the reminders for which other users are responsible, simply select the user or users in the Responsible User pane.
» To view only a specific group of reminders for which you or others are the responsible users, change the viewing criteria.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View reminders that have the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reminder Type</td>
<td>The default value is (all).</td>
</tr>
<tr>
<td>Attached To</td>
<td>The default value is (all). To view reminders that are not attached to any item (reservation, booking, group, or service order), select (none). See <a href="#">To create an unattached reminder</a>.</td>
</tr>
<tr>
<td>Search in Text</td>
<td>Enter the string by which to search for specific reminders. (The search is carried out on the Notes field for the reminder.) Your search is limited to the exact order of the characters in the string, but the search string is not-case sensitive and it can appear anywhere in the search results. For example, a search string of cat returns reminders that have &quot;catering&quot; or &quot;Mary's catering&quot; in the Notes field.</td>
</tr>
<tr>
<td>Date Completed</td>
<td>Available only if Exclude Complete is not checked.</td>
</tr>
<tr>
<td>Exclude Completed</td>
<td>Selected by default. Clear this option to display completed reminders in the Reminders list. To display completed reminders that meet the other viewing criteria, regardless of their completion dates, leave the Date Completed fields blank; otherwise, to view completed reminders that were completed by a specific date, you can enter a Starting date or a date range in the Date Completed fields.</td>
</tr>
<tr>
<td>Hide Canceled</td>
<td>Not selected by default. Select this option to display canceled reminders in the Reminders list.</td>
</tr>
</tbody>
</table>
CREATING UNATTACHED REMINDERS

When you create reminder on the Navigator, the reminder is attached to a specific reservation, booking, or booking detail. Similarly, when you create a reminder on the Groups window, the reminder is attached to a specific group. If needed, however, you can create a reminder that addresses just your general business needs and is not attached to any specific item. For example, you can create a reminder about “preparing for your organization’s yearly safety inspection.” Any reminder that you create from the Reminders tab on the Dashboard window is an unattached reminder.

1. Click New. The Reminder dialog box opens.

![Reminder dialog box](image)

2. Do one of the following:
Select a Reminder Type.
If none of the pre-configured Reminder Types meets your working needs, then select (user-specified), and in the Description field, enter a description for the reminder type.

The Responsible User field is populated with your User ID and the Date Due field is populated with the current day's date.

3. Optionally, change the Responsible User, Date Due, or both.
4. If you are completing the reminder today, select a Date Completed; otherwise, leave this field blank. (This field is populated automatically when you or another user completes the reminder.)
5. Optionally, in the Notes field, enter any further explanation or information about the reminder. Click Spelling to spell-check the reminder before you save it.
6. Click OK. The Reminder dialog box closes. The newly created reminder is not attached to an item. It might or might not be displayed in the Reminders list depending on the values that you have set for filtering the display.

CHANGING A REMINDER

1. On the Reminders list, select the reminder that you are editing, and then click Edit. The Reminder dialog box opens. The dialog box is populated with the current information for the reminder.
2. Edit the reminder as needed. Optionally, click Spelling to spell-check the reminder before you save the edited reminder.
3. Click OK. The Reminder dialog box closes. If the reminder is attached to an item such as a reservation, then the reminder remains attached; otherwise, it is saved as an unattached reminder.

DELETING A REMINDER

You can delete any reminder (attached or unattached) regardless of its due date and regardless if it is completed.

1. On the Reminders list, select the reminder that you are deleting, and then click Delete. A message opens asking you if it is OK to delete the reminder.
2. Click Yes. The message closes and the reminder is deleted.

PRINTING A REMINDER

1. On the Reminders list, select the reminder that you are printing, and then click Print. An onscreen preview of the reminder opens. The preview window contains options for printing a hard copy of the reminder, for emailing the reminder, and so on.

Onscreen preview for a printed reminder
2. Select the option or options that best fit your working needs.

VIEWING AN ITEM TO WHICH A REMINDER IS ATTACHED

On the Reminders list, select a reminder, and then click Go To. The Attached To column for the reminder must state anything other than “Unattached.”

» If the reminder is attached to a reservation, booking, or booking detail, then the reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically selected.

» If the reminder is attached to a group, then the Group window opens, with the group information displayed in the window.

MARKING A REMINDER COMPLETE

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are completing.
2. Click Completed. A message opens asking you if it is OK to set the selected reminders as completed.

3. Click Yes. The message closes. The reminders are completed with a date equal to the current day’s date. The reminders might or might not be displayed in the Reminders list depending on the values that you have set for filtering the display.

REASSIGNING MULTIPLE REMINDERS BETWEEN EMS USERS

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are reassigning.

2. Click Reassign. The Select User dialog box opens. This dialog box lists all the users for your EMS implementation.
3. Select the user to whom you are reassigning the reminder.

Tip: To search for a user, enter a search string in the Search field. The search string is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of Admin returns both Admin users and SysAdmin. The list of users that meet your search string is dynamically updated as you enter the string.

4. Click OK. A message opens, asking you if you are sure that you want to reassign the selected reminders to the user.

5. Click Yes. The Select User dialog box and message close and the reminder is reassigned.
CHAPTER 82: Everyday User Reservations Tab

The Everyday User Reservations tab displays any reservation that was submitted through EMS Web App made in Self Serve mode.

You can select options to filter the reservations list. Status and Building/Area/View filters show on the left pane of the tab. You can select one or
more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step. Date filters show on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional. After you select or edit the filtering options, click Refresh.

Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
CHAPTER 83: Guest Requests Tab

The Guest Requests tab displays requests for space that require supervisory approval. Such requests are submitted through EMS Web App using process templates designated for "Unauthenticated Users." An unprocessed request is in Pending status.

Once your system administrator has configured facilities (rooms, categories, services, resources, and so on), he or she can configure special process templates for "managed space," which is meeting space that might require additional oversight and an approval process to finalize a reservation. For example, your organization might need specialized space like the President's Conference room, or a large banquet hall, to be treated as managed space to ensure that any request to use it is approved by a supervisor. Typically, managed space involves services, expenses, and invoicing that affect multiple stakeholders and departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web App. By contrast, such templates are not available for EMS for Outlook users since Microsoft® Outlook does not show the request status of such a reservation.
The tab enables you to filter the list by status, building, room, and to work with the requests. If you filter the list by Status or Building (on the left panel), click Refresh.
CHAPTER 84: Manage Requests for Managed Space

This topic guides you in approving "pending requests," which are requests for space that require supervisory approval and appear in your Dashboard.

Concept: You Use the Request/Approval Model to Oversee "Managed Space"

Once your system administrator has configured facilities (rooms, categories, services, resources, and so on), he or she can configure special process templates for "managed space," which is meeting space that might require additional oversight and an approval process to finalize a reservation. For example, your organization might need specialized space like the President's Conference room, or a large banquet hall, to be treated as managed space to ensure that any request to use it is approved by a supervisor. Typically, managed space involves services, expenses, and invoicing that affect multiple stakeholders and departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web App. By contrast, such templates are not available for EMS for Outlook users since Microsoft® Outlook does not show the request status of such a reservation.
See Also: How Does EMS Classify Different Types of Users?

1. Click the Dashboard icon in the EMS Desktop Client toolbar.

2. Click the Guest Requests tab, which displays requests for space that require supervisory approval. Such requests are submitted through EMS Web App using process templates designated for "Unauthenticated Users." An unprocessed request is in Pending status.
The tab enables you to filter the list by status, building, room, and to work with the requests. If you filter the list, click Refresh.
APPROVING OR WORKING WITH A PENDING REQUEST

1. Select the request you want to work with, and click Edit to launch the Guest Request dialog box, which shows all the information submitted for the request through EMS Web App. The dialog box always has a Description tab, a Web Questions tab, and an Audit tab. If the request included resources or setup notes, it also has a Services tab.
2. To ask the requester for further clarification before approving the request, edit the request without processing it:
   » You can ask questions and add comments about the request (for example, "Will alcohol be served at the event?") in the Notes field on the Description tab. When the user checks the request in EMS Web App, these notes will display.
   » To indicate to the guest user that you are reviewing the request, you can set the Request Status to In Progress.
   » To see the guest's answers to any predefined questions in EMS Web App, open the Web Questions tab.
   » To see service requests, click the Services tab. Double-click a category to see details on the right.

3. When you have finished interacting with the request, click OK to save your changes and notify the requester.

4. To process the request and create a reservation, change the Request Status field to a new status (such as Approved) and click Process on the Description tab. The reservation opens in the Reservation Wizard and you must finish making the reservation in the Reservation Wizard window that appears.
   » If the reservation includes services, the Process Guest Request Details window opens next. To process the services immediately, use the options on this window, or to process the services later, click Cancel. (You can later open the
reservation on the Dashboard > Guest Requests tab, and on the Services tab, click Process).

DELETING A REQUEST

1. Select the guest request, or CTRL-click to select the multiple requests, and then click Delete.
2. Click Yes. The message closes. The selected guest requests are deleted.

PRINTING A REQUEST

1. Select the guest request, or CTRL-click to select the multiple requests, and then click Print. An preview of the selected requests opens, with options to print a hard copy, export the requests to a .pdf, and email the requests.
2. Select the option or options that best fit your working needs.
CHAPTER 85: Wait List Tab

The Wait List tab provides you a way of monitoring wait-listed reservations. It also provides an indicator when the requested room becomes available.

The tab is interactive. You can:

» Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.
» Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

» Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

» Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
CHAPTER 86: Reconfirm Dates Tab

The Reconfirm Dates tab displays reservations that have been booked in a status that requires the Reconfirm Date option (for example, a Tentative or Hold status). The list of reservations is automatically sorted in ascending order by Reconfirm Date. You use this tab as a reminder to reconfirm such reservations.
The tab is interactive. You can:

» Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.

» Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.
» Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

» Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
CHAPTER 87: Building Hours Exceptions Tab

The Building Hours Exceptions tab displays reservations that occur outside of configured building hours.

The tab is interactive. You can:
» Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.

» Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

» Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

» Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
CHAPTER 87: Analytics Tab

The Analytics tab provides quick access for queries that have been defined using the Query builder and to which you have access as a user. You can run these queries from the Analytics tab.

TO RUN A QUERY FROM THE ANALYTICS TAB

1. In the upper left corner of the Analytics tab, click Select Queries. The Queries dialog box opens. This dialog box lists the queries that have been defined using the Query builder and to which you have access.
2. Select the queries that you want to run, and then click OK. The Queries dialog box closes. The selected queries are displayed in the Queries pane (upper left) on the Analytics tab.

3. In the Queries pane, select the query that you want to run, and then select the date for which the data in your EMS database is to be queried.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>The starting date is set to the first day of the month and the ending date is set to the last day of the month but you can edit one or both of these dates. Note: For some queries, if you select Custom, a Use Specific Times option becomes available. If you enter the same date for the starting date and ending date, you can select Use Specific Times, and then enter a starting time and ending time to query the data for in specific time range on the same day.</td>
</tr>
<tr>
<td>Last Month</td>
<td>The starting date is set to the first day of the previous month and the ending date is set to the last day of the previous month.</td>
</tr>
<tr>
<td>Last Quarter</td>
<td>Quarters are based on a calendar year:</td>
</tr>
<tr>
<td>This Quarter</td>
<td>First quarter is 1/1 through 3/31.</td>
</tr>
<tr>
<td>This Quarter To Date</td>
<td>Second quarter is 4/1 through 6/30.</td>
</tr>
<tr>
<td></td>
<td>Third quarter is 7/1 through 9/30.</td>
</tr>
<tr>
<td></td>
<td>Fourth quarter is 10/1 through 12/31.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For example, if the current day's date is 11/22/2010, and you select Last Quarter, then the starting date is set to 7/1/2010 and the ending date is set to 9/30/2010.</td>
</tr>
<tr>
<td>Last Year</td>
<td>The starting date is set to 1/1 of the previous year, and the ending date is set to 12/31 of the previous year.</td>
</tr>
<tr>
<td>This month</td>
<td>The starting date is set to the first day of the current month and the ending date is set to the last day of the current month.</td>
</tr>
<tr>
<td>This Year</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to 12/31 of the current year.</td>
</tr>
<tr>
<td>This Year to Date</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to the current day's date.</td>
</tr>
</tbody>
</table>

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data. If the query returns data, then the results are displayed in the Results pane on the Analytics tab.

6. Optionally, do one or more of the following:

   » To export the query results to an Excel spreadsheet or to an XML file, click Export, and then select the appropriate file type. A dialog box opens in which you can specify
the file name (the default file name is the name of the query, but you can always edit this), and the location to which to save the file.

Tip: The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The file type for an XML file is .xml and you cannot change this.

To generate an onscreen preview of the printed query results, click Print. The preview window contains options for printing a hard copy of the query results, for emailing the results, and so on. Select the option or options that best fit your working needs.

Onscreen preview of a query results

If the query has been defined with a Chart, the Chart option is enabled. Click Chart to generate an onscreen preview of the charted data. The preview window contains options for printing a hard copy of the chart, for emailing the chart, and so on. Select the option or options that best fit your working needs.

Onscreen preview of query results that are charted/graphed
CHAPTER 88: Analytics Tab

The Analytics tab provides quick access for queries that have been defined using the Query builder and to which you have access as a user. You can run these queries from the Analytics tab.

TO RUN A QUERY FROM THE ANALYTICS TAB

1. In the upper left corner of the Analytics tab, click Select Queries. The Queries dialog box opens. This dialog box lists the queries that have been defined using the Query builder and to which you have access.
2. Select the queries that you want to run, and then click OK. The Queries dialog box closes. The selected queries are displayed in the Queries pane (upper left) on the Analytics tab.

3. In the Queries pane, select the query that you want to run, and then select the date for which the data in your EMS database is to be queried.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>The starting date is set to the first day of the month and the ending date is set to the last day of the month but you can edit one or both of these dates.</td>
</tr>
</tbody>
</table>

Note: For some queries, if you select Custom, a Use Specific Times option becomes available. If you enter the same date for the starting date and ending date, you can select Use Specific Times, and then enter a starting time and ending time to query the data for in specific time range on the same day.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Month</td>
<td>The starting date is set to the first day of the previous month and the ending date is set to the last day of the previous month.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Quarter</td>
<td>Quarters are based on a calendar year:</td>
</tr>
<tr>
<td></td>
<td>➤ First quarter is 1/1 through 3/31.</td>
</tr>
<tr>
<td>This Quarter</td>
<td>➤ Second quarter is 4/1 through 6/30.</td>
</tr>
<tr>
<td>This Quarter</td>
<td>➤ Third quarter is 7/1 through 9/30.</td>
</tr>
<tr>
<td>To Date</td>
<td>➤ Fourth quarter is 10/1 through 12/31.</td>
</tr>
</tbody>
</table>

For example, if the current day’s date is 11/22/2010, and you select Last Quarter, then the starting date is set to 7/1/2010 and the ending date is set to 9/30/2010.
<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Year</td>
<td>The starting date is set to 1/1 of the previous year, and the ending date is set to 12/31 of the previous year.</td>
</tr>
<tr>
<td>This Month</td>
<td>The starting date is set to the first day of the current month and the ending date is set to the last day of the current month.</td>
</tr>
<tr>
<td>This Year</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to 12/31 of the current year.</td>
</tr>
<tr>
<td>This Year to Date</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to the current day's date.</td>
</tr>
</tbody>
</table>

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data. If the query returns data, then the results are displayed in the Results pane on the Analytics tab.

6. Optionally, do one or more of the following:

   - To export the query results to an Excel spreadsheet or to an XML file, click Export, and then select the appropriate file type. A dialog box opens in which you can specify the file name (the default file name is the name of the query, but you can always edit this), and the location to which to save the file.
Tip: The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The file type for an XML file is .xml and you cannot change this.

» To generate an onscreen preview of the printed query results, click Print. The preview window contains options for printing a hard copy of the query results, for emailing the results, and so on. Select the option or options that best fit your working needs.

Onscreen preview of a query results

If the query has been defined with a Chart, the Chart option is enabled. Click Chart to generate an onscreen preview of the charted data. The preview window contains options for printing a hard copy of the chart, for emailing the chart, and so on. Select the option or options that best fit your working needs.

Onscreen preview of query results that are charted/graphed
CHAPTER 89: At A Glance Tab

Page tags: article:topicpersona:Usersinglesourcereused
CHAPTER 90: Manage Services

You use Manage Services to search for and view the resources with and without service orders for all bookings on a particular day as well as the current state of the resources and their Reviewed status. After viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you can mark a resource as un-reviewed. You can also open a resource in the Navigator, and edit it if necessary.

Concept: What is a Service Order, Category, and Resource?

In EMS, you might hear these terms used interchangeably at times; however, they are different concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture, Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources Without Service Orders. These types cause the service to behave slightly differently when added to a booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it and there is nothing for a person to select from these types of services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource without a Service Order Category, will require the Administrator to create items under it. For example, an "AV Equipment" service category (configured as a Resource without a Service Order Category type) might have items under it such as a flip chart, whiteboard, (under AV Equipment). The person requesting the service for this meeting would then select AV equipment; then flipchart and whiteboard would be typical options to add to the event.

**TIP:** The following Category Types allow Production Items: Catering, Resources with Service Orders, and Resources Without Service Orders.

Furthermore, a Category can be configured to "Use States" so that when a service is requested with a meeting, it can be managed through a review and approval process in the Manage Services toolbar option in the EMS Desktop Client.
To manage service orders, you will:

» Navigate to the Manage Services browser by clicking the Manage Services icon from the toolbar in EMS Desktop Client.

» Search for Service Orders.

» Review, Edit, and/or Print Service Orders.
TIP: If you are managing Catering services, watch the video tutorial, Manage Catering Services.

SEARCH FOR SERVICE ORDERS

1. On the toolbar, click the Manage Services icon. The Service Order Management window opens.

*Service Order Management window*
If states are assigned to any of the resources in a booking, the name of the state and if applicable, its color, is displayed in the State column for the booking. If a service order is part of a category that has been configured to "Use States," but none has been assigned, then (none) is displayed in the State column for the booking. If your Administrator has not configured categories in your system to use states, then the State column will be blank.

If a resource has been reviewed for a booking, "Yes" appears in the Reviewed column for the booking.

If your Options are set to show deleted service orders/items, an "X" appears next to the booking for which the orders/items were deleted and a single line through the booking is displayed.
TIP: You can change how data is listed: click **Options** in the upper right corner of the Service Order Management window. The Options dialog box opens; make adjustments as needed and then click **OK** to apply these changes.

2. Use filters to search for service orders:
   
   » Leave the Date set to the default value (the current day's date), or select a different date.
   
   » On the Building drop-down list, leave the value set to the default value (all buildings), or select a specific building, area, or view.
   
   » On the Category drop-down list, select the category by which to search.
In the Status pane, select one or more specific booking statuses, or select (all) statuses.

**REVIEW AND EDIT SERVICE ORDERS**

1. You can see pending service orders and details about each order, review them, change their details, change their states, and print a list of all the orders in the list:
   - To view the individual service orders for a booking, click on the booking; detailed items show below in the **Items** tab. You can view changes made to the service order, in the **Changes** tab in the lower pane of the window. You can rearrange the column order by dragging a column to a new location using the column heading, you can change the width of the data columns, and you can sort the data columns on a tab in either ascending or descending sort order.
   - See [An EMS Browser Window](#).
   - To change the state of the service order, select it, or CTRL-click to select multiple
To change details for a service order, double-click on it or select it and click **Open**; this launches the item in the Navigator. If you edit any information for a resource (quantity, notes, and so on) or the service order (service order time, estimated count, or so on) for a booking, then a Changed icon is displayed next to the booking.
To Review a service order, select it, or CTRL-click to select multiple orders, and then click **Reviewed** or **Unreviewed**. A message opens asking you if you are sure that you want to mark the resource as reviewed. Click **Yes** to close the message. "Yes" is displayed in the Reviewed column for the booking orders of the same category, and then click **Change State**. A Change State window opens, which lists all available states for the service order. Select the new state for the resource on the State drop-down list.

To print the list of service orders that are displayed, click **Print**. An onscreen preview of the Service Orders list opens. The preview window contains options for printing a hard copy of the list, for emailing the list, and so on.

**Onscreen preview for a printed reminder**

2. When you are finished working with Service Orders, click **Close**. Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you do.
CHAPTER 91: Manage Services

You use Manage Services to search for and view the resources with and without service orders for all bookings on a particular day as well as the current state of the resources and their Reviewed status. After viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you can mark a resource as un-reviewed. You can also open a resource in the Navigator, and edit it if necessary.

Concept: What is a Service Order, Category, and Resource?

In EMS, you might hear these terms used interchangeably at times; however, they are different concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture, Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources Without Service Orders. These types cause the service to behave slightly differently when added to a booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it and there is nothing for a person to select from these types of services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource without a Service Order Category, will require the Administrator to create items under it. For example, an "AV Equipment" service category (configured as a Resource without a Service Order Category type) might have items under it such as a flip chart, whiteboard, (under AV Equipment). The person requesting the service for this meeting would then select AV equipment; then flipchart and whiteboard would be typical options to add to the event.

**TIP:** The following Category Types allow Production Items: Catering, Resources with Service Orders, and Resources Without Service Orders.

Furthermore, a Category can be configured to "Use States" so that when a service is requested with a meeting, it can be managed through a review and approval process in the Manage Services toolbar option in the EMS Desktop Client.
To manage service orders, you will:

» Navigate to the Manage Services browser by clicking the **Manage Services** icon from the toolbar in EMS Desktop Client.

» **Search for Service Orders.**

» **Review, Edit, and/or Print Service Orders.**
TIP: If you are managing Catering services, watch the video tutorial, Manage Catering Services.

SEARCH FOR SERVICE ORDERS

1. On the toolbar, click the Manage Services icon. The Service Order Management window opens.

Service Order Management window
If states are assigned to any of the resources in a booking, the name of the state and if applicable, its color, is displayed in the State column for the booking. If a service order is part of a category that has been configured to "Use States," but none has been assigned, then (none) is displayed in the State column for the booking. If your Administrator has not configured categories in your system to use states, then the State column will be blank.

If a resource has been reviewed for a booking, "Yes" appears in the Reviewed column for the booking.

If your Options are set to show deleted service orders/items, an "X" appears next to the booking for which the orders/items were deleted and a single line through the booking is displayed.
TIP: You can change how data is listed: click **Options** in the upper right corner of the Service Order Management window. The Options dialog box opens; make adjustments as needed and then click **OK** to apply these changes.

2. Use filters to search for service orders:
   - Leave the Date set to the default value (the current day's date), or select a different date.
   - On the Building drop-down list, leave the value set to the default value (all buildings), or select a specific building, area, or view.
   - On the Category drop-down list, select the category by which to search.
In the Status pane, select one or more specific booking statuses, or select (all) statuses.

REVIEW AND EDIT SERVICE ORDERS

1. You can see pending service orders and details about each order, review them, change their details, change their states, and print a list of all the orders in the list:

   To view the individual service orders for a booking, click on the booking; detailed items show below in the Items tab. You can view changes made to the service order, in the Changes tab in the lower pane of the window. You can rearrange the column order by dragging a column to a new location using the column heading, you can change the width of the data columns, and you can sort the data columns on a tab in either ascending or descending sort order. See An EMS Browser Window.

   To change the state of the service order, select it, or CTRL-click to select multiple
To change details for a service order, double-click on it or select it and click **Open**; this launches the item in the Navigator. If you edit any information for a resource (quantity, notes, and so on) or the service order (service order time, estimated count, or so on) for a booking, then a Changed icon is displayed next to the booking.
To Review a service order, select it, or CTRL-click to select multiple orders, and then click **Reviewed** or **Unreviewed**. A message opens asking you if you are sure that you want to mark the resource as reviewed. Click **Yes** to close the message. "Yes" is displayed in the Reviewed column for the booking orders of the same category, and then click **Change State**. A Change State window opens, which lists all available states for the service order. Select the new state for the resource on the State drop-down list.

To print the list of service orders that are displayed, click **Print**. An onscreen preview of the Service Orders list opens. The preview window contains options for printing a hard copy of the list, for emailing the list, and so on.

---

**Onscreen preview for a printed reminder**

![Onscreen preview for a printed reminder](image)

2. When you are finished working with Service Orders, click **Close**. Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you do.
CHAPTER 92: Search for Reservations, Bookings, Resources, and Service Orders

EMS has a variety of options available to you for searching for reservations, bookings, service orders, resources, and queries. These options include the Browser, the Everyday Reservation tool, the Calendar, the Navigator, a Group, the Resource Calendar, and the Service Order Management browser.

Concept: What are Categories? Click for more...

» Booking details are also called categories.

» Booking detail items, also called resources, are the individual items (coffee, sandwich, projector, and so on) that you add to a booking detail.

» A booking detail might include a service order.

In this section:

» Searching with the Browser
» Searching with the Calendar
» Searching with the Resource Calendar
» Search with the Everyday User Reservations Browser
**TIP:** A fast way to view and edit bookings is through the Reservation Book. See [Viewing and Editing Reservations in the Reservation Book](#).

For information about searching with the Navigator, see [The Navigator](#).
CHAPTER 93: Booking Check-in

Organizations with a mobile workforce or flexible work arrangements often adopt a "workspace (hoteling or hot-desking) strategy—allotting workspace on an as-needed basis to accommodate more people in less space. EMS is a facility scheduling system for managing workspace requirements, as well as the booking of meeting/event space and resources.

Sometimes meeting hosts don't use the space they reserved. In organizations where meeting space or workspace is in high demand, or when the reservation is for a significant period of time, the lost utilization of space adds up to a lot of waste. Using this feature, you can set up each room to require that the meeting host check in to the space. When the time comes to check in, the host will receive an email with a link they can click to check in. If you have EMS Kiosk, the host can check in via the touch-screen room sign (if available), or if you have EMS Mobile App, by tapping "Check in" on the event on their mobile phone. You'll also be able to set up what happens if the host fails to check in more than 10 minutes (or whatever time you want) after the meeting starts. You might want to settle for a warning—at least for the first few months—and then automatically free up the space so that someone else can use it. The result? Better use of your space and happier users.
Booking level check in helps maintain room use levels and ensure accurate space usage reports. Check in at the booking level allows users to check into a single space booking. Additionally, this feature triggers no-show notifications in order to free up spaces that have no check ins. To enable users to check in this way, you must first enable it for each user; see Enable Booking Check In.

**NOTE:** Older versions of EMS had "building-level check-in;" this has been replaced with booking-level check-in.

See Also:

- [Understanding Booking-Level Check In?](#)
- [Enabling Booking Check In](#)
- [Managing Check In](#)
- [Ways to Check In](#)
CHAPTER 94: Enable Booking Check In

**TIP:** For an explanation of this feature, see Understand Booking Level Check In. To manage space that uses booking check in, see Manage Booking Level Check-In.

1. On the EMS menu bar, click Configuration > Facilities > Rooms.
2. On the filter drop-down fields along the top, select options by which to filter the list, such as a building, area, or view.

![Filter Fields](image)

**TIP:** Make sure the Inactive checkbox in the lower right corner is cleared to further narrow your list.

3. Select the room for which booking-level check in needs to be enabled and click the *Edit* button.

4. On the room configuration page that presents, check the box for *Requires Check In*. The *Minutes Prior to Booking Event Start* is the amount of time before a booking in the specified room will be open for check in.
CHAPTER 94: Enable Booking Check In

[Image of a software interface showing a checkbox for "Requires Check In" and an option to allow check-in 50 minutes prior to the booking event start.]
TIP: This type of check-in can be done to multiple rooms at the same time using the Wizard on the Rooms screen. Anyone with access to the desktop client can check into a booking earlier than the time assigned to the room.

Additionally, to allow Everyday Users (such as for EMS Web App, EMS for Outlook, EMS Kiosk, and EMS Mobile App) to select this room during the booking process, select Available to Everyday Users in the Everyday User Application Settings section.

5. Finish configuring the room using the tabs along the top.

6. To enable Everyday Users to select the room when using an Everyday User Process Template, open this tab and move the room to the Reserve and Request panels as needed.
7. Click **OK** to save.
CHAPTER 95: Ways to Check In

CHECKING IN FROM THE BOOKING CHECK IN DASHBOARD

1. Select Booking Check In from the menu bar in EMS Desktop Client.

2. Set filters to search for bookings you want to check into.
3. Select an event from the list of results that displays and click the Check In button.
Tip: This feature replaces the Building and Booking Check In tools in previous releases.

CHECKING IN FROM THE RESERVATION BOOK

Bookings in the Reservation Book can be checked into by right-clicking on the booking and selecting Check In.
CHECKING IN FROM EMS WEB APP

1. If authorized by your administrator, you can check into bookings in EMS Web App.
CHECKING IN WITH EMS MOBILE APP

1. From the Calendar on the Home page, locate the event you want to check in to.

2. If it is with in the pre-determined check-in time period, a Check In option will appear when you swipe right. The meeting organizer or booking template usually determines how soon before a meeting you can check in.

3. You can also Check In by opening and/or editing an event.
4. Tap on the event and click Edit in the upper right-hand corner.

5. Click Check In.

Tip: See Also: Inviting People
CHECKING IN WITH EMS ROOM SIGN

Checking in on EMS Room Sign can be done at the Glance monitor by selecting the Check In button.

CHECKING IN WITH EMS KIOSK

Checking in on EMS Kiosk can be done at the Kiosk by selecting the Check In icon on the My Reservations screen.
CHAPTER 96: Managing Check In

When check in is enabled for room bookings, there are multiple ways to check in to those bookings. Since users can check into a booking from these various methods, this calls for oversight and management of the booking. This topic guides you in managing check ins for your room bookings.

USING THE BOOKING CHECK IN DASHBOARD

This dashboard is where EMS administrators manage bookings and each booking’s check in status.

**NOTE:** This dashboard is separate from the EMS Dashboard and replaces the separate Building Check In and Group Check-In Status dashboards that were available in older versions of EMS.

1. On the EMS menu bar, click **Reservations > Other > Booking Check In** to open the Booking Check In dashboard, or click the Booking Check In icon on the Tool- bar.
NOTE: You can add the Booking Check In icon to the Toolbar by right-clicking on the toolbar, then selecting Customize, and moving the Booking Check In to the Show Buttons side.

2. The Booking Check In window provides multiple options for EMS administrators to manage booking check in. It displays bookings and shows whether they have check ins. Use the options to view, modify, and control check ins for each booking.
OPTIONS ON THE BOOKING CHECK IN DASHBOARD

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building/Area/View</td>
<td>The default value is (all), but you can select a specific Building, an area, or a view.</td>
</tr>
<tr>
<td>Room Type</td>
<td>The default value is (all), but you can select a specific room type.</td>
</tr>
<tr>
<td>Event Type</td>
<td>The default value is (all), but you can select a specific event type.</td>
</tr>
<tr>
<td>Room</td>
<td>The default value is (all), but you can select a specific room.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Floor</td>
<td>The default value is (all), but you can select a specific floor.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The default value is the current day’s date, but you can select a different value.</td>
</tr>
<tr>
<td>End Date</td>
<td></td>
</tr>
<tr>
<td>Group Type</td>
<td>The default value is (all), but you can select a specific Group type.</td>
</tr>
<tr>
<td>Group Name</td>
<td>Allows the user to search for a Group to check in to their booking.</td>
</tr>
<tr>
<td>Not Checked In</td>
<td>Select this option to search only for bookings that have not been checked into.</td>
</tr>
<tr>
<td>Display</td>
<td>Shows bookings in rooms that are set up for check in and match the filters.</td>
</tr>
<tr>
<td>Check In</td>
<td>This will check in a booking for a user that has not checked in using another method.</td>
</tr>
<tr>
<td>End Now</td>
<td>This will end a selected booking that is in progress, which will free the room up for another booking.</td>
</tr>
<tr>
<td>Go To</td>
<td>This will take the administrator to the navigator for the highlighted booking to view further information.</td>
</tr>
<tr>
<td>Print</td>
<td>This will print the information being displayed for the filters that are set above.</td>
</tr>
<tr>
<td>Export</td>
<td>This will export the information to a Microsoft Excel file.</td>
</tr>
</tbody>
</table>
CHAPTER 97: Reports and Queries

EMS provides more than 110 reports and a custom query builder for use throughout the meeting and event lifecycle—from setup and invoicing to billing and utilization analysis. These "one-way integration" reports generate static reservation, service, billing, resource, and other information in .xml, .xls, comma-delimited, and .txt formats. This data can be read and parsed by many other software applications. These reports are categorized as follows:

» Daily: Summary, service, and other reports that describe activities over one or more days.
» Sales: Details of sales associated with reservations, resources, and more.
» Statistics: Insights you need to understand use and organizational activity.
» Exception: Clarifies the incorrectly run or allocated resources, templates, or systems.
» Billing: All reports for transactions, invoices, and other statements.
» Hoteling: Reports specific to office hoteling practices and QR codes for room cards.
» Other: Summary reports on cancelations and reservations.

The reports that you can send automatically include Reservation and Sales/Statistics Queries and all Saved Daily and Statistics Reports. You can send reports according to whatever frequency, time, time zone, and reporting period
you choose, and you can customize the sender, subject, and message information. To set up Automated Reports, your organization will need to install and configure the EMS Automated Report service.

The application also contains a **Query Builder** function which you can use to define custom criteria for searching for information in your organization’s EMS database.

Note: Reports that are specific for the Billing function in EMS are detailed in **Billing**.
CHAPTER 98: Report Descriptions and Options

This section describes EMS reports by category, and defines especially important fields and settings for each report. The following provide information about the various reports:

» Daily Reports
» Sales Reports
» Statistics Reports
» Other Reports
» Exceptions Reports
» Hoteling Reports
» Invoice Reports
» General Reports
DAILY REPORTS

Daily reports are able to be set to send as an email automatically. To learn more about Automated Reports, see Create Automated Reports.

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>A summary of the events that are scheduled at your facility, sorted by date and event start time. The report shows event start and end time, group name, event name, and location. You typically print and post the</td>
<td>Use Page Breaks - If the report is run across multiple days, then each day starts on a new page.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event</td>
<td>Schedule in a lobby or entry way to help visitors find their events.</td>
<td>Show Bookings on Start Date Only–If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3pm Thursday through 10am Friday. If this option is selected, then the booking is displayed only for Thursday in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Holidays–Displays any holidays that are configured in the EMS database on the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Building Hours–Displays building hours on the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIP Events Only–Only the events that are marked as a “VIP” are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use Calendar Styles: Events are displayed in the font/color of the Calendar Style that is associated with each event.</td>
</tr>
</tbody>
</table>

Event Calendar

A chronological list of scheduled events in a wall calendar format.

Use Calendar Styles–Events are displayed in the font/color of the Calendar Style that is associated with each event.
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A list of events that is designed to be posted outside a room or event space.</td>
<td>Weekly Calendar—One week per page is displayed in the report.</td>
</tr>
<tr>
<td>Room Cards</td>
<td>The report notes the date, event time, and location for events, as well as</td>
<td>Show Adjacent Calendar Days—Works in conjunction with the Weekly</td>
</tr>
<tr>
<td></td>
<td>the group sponsoring each event. The report can be a single list of all</td>
<td>Calendar option to display events that occur on Saturday and Sunday in</td>
</tr>
<tr>
<td></td>
<td>events that are scheduled for the room on a particular date, or it can be a</td>
<td>the report.</td>
</tr>
<tr>
<td></td>
<td>single page per event.</td>
<td>Grey Out Adjacent Calendar Days—Works in conjunction with the “Show</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adjacent Calendar Days” option to display events that occur on adjacent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>days in gray instead of in black.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hide Holidays—By default, holidays are displayed on the Daily Calendar</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Report. Select this option to hide holidays in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>By Room—Displays events one room at a time in a calendar view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Bookings on Start Date Only—If a booking is scheduled overnight,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>then only the start date of the booking is displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, a booking exists for 3pm Thursday through</td>
</tr>
</tbody>
</table>
### Report Descriptions and Options

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10am Friday. If this option is selected, then the booking is displayed only for Thursday in the report.</td>
<td>» Print Blank Room Cards—Prints a room card for a space that does not have any events scheduled.</td>
</tr>
<tr>
<td></td>
<td>» Print Logo—Prints the facility logo on each room card. You can specify the logo location on the right or left side of the room card.</td>
<td>» Sort Room Cards By Book Sequence—If Book Sequencing is being used on Room Configuration, then a facility can print room cards in the Book Sequence order.</td>
</tr>
<tr>
<td></td>
<td>» Print Combo Room Components—Prints an individual room card for each component of a combo room.</td>
<td>» Suppress End Time—Do not show the end times for bookings in the report.</td>
</tr>
</tbody>
</table>

<p>| Activity        | A list of bookings in all rooms in a building, or just in a specific room in the building. The report, which shows | Use Page Breaks—A new page is generated for each date or for |
| Schedule        |                                                                                                              |                                                          |</p>
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>An internal report that setup crews, custodial, or operations personnel use to ensure that each room is arranged properly for each event. The report displays detailed information about each booking, including setup type, setup notes, required resources, user defined fields, special instructions and resource item notes.</td>
<td>each building.</td>
</tr>
<tr>
<td>Worksheet</td>
<td>event start and end times, event name, group name and room, can be generated for a range of dates. The report can generated in one of two formats–by Date or by Building.</td>
<td>Show Bookings on Start Date Only–If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3pm Thursday through 10am Friday. If this option is selected, then the booking is displayed only for Thursday in the report.</td>
</tr>
</tbody>
</table>

- Show Bookings on Start Date Only
- Use Page Breaks–If this report is run across multiple days, then each day starts on a new page.
- Highlight Changes Made Within: (days)–Changes that have been made within the specified number of days are highlighted in the report.
- Limit Bookings To Those With Details In Selected Categories–Only bookings with a booking detail from the specified categories are displayed in the report.
- Show Bookings on Start Date
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
</table>

Only—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3pm Thursday through 10am Friday. If this option is selected, then the booking is displayed only for Thursday in the report.

» Keep Detail Together—If an event has booking details, the details are kept together on one page instead of being split across two pages.

» Show Holidays—Holidays are displayed in the report.

» Show Building Hours—Building hours that are associated with each building are displayed in the report.

» Show Item Notes—Any notes that have been entered for a booking detail item are displayed in the report.

» Show Item Special Instructions—Any special instructions that have been entered in EMS Web App for a booking detail item are dis-
### Report Descriptions and Options

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Order</td>
<td>Lists the service orders that are scheduled for a date or date range. Produced by category.</td>
<td>Show User Defined Fields—Any user defined fields and their answers for a reservation are displayed in the report.</td>
</tr>
<tr>
<td>Schedule</td>
<td></td>
<td>Show Booking Changes Only—Bookings that have been edited within the specified number of days are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use Page Breaks—If this report is run across multiple days, then each day starts on a new page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Details—Booking item details that associated with each event are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Highlight Changes Made Within: (days)—Changes that have been made within the specified number of days are highlighted in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Pricing—Any pricing that is associated with an item is displayed in the report.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Orders</td>
<td>Separate pages for each service order in a date range.</td>
<td>Show Item Notes—Any notes that have been entered for a booking detail item are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td>The report provides information on the event and the items or services needed. Produced by category.</td>
<td>Show Item Special Instructions—Any special instructions that have been entered in EMS Web App for a booking detail item are displayed in the report.</td>
</tr>
</tbody>
</table>

- **Highlight Changes Made Within:** (days)—Changes that have been made within the specified number of days are highlighted in the report.
- **Footer Message**—Used to specify the Footer message that is displayed on each page of the report.
- **Show Item Notes**—Any notes that have been entered for a booking detail item are displayed in the report.
- **Show Item Special Instructions**—Any special instructions that have been entered in EMS Web App for a booking detail item are dis-
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banquet Event Order</td>
<td>Separate pages for each booking that occurs on a date or within a date range that has the “Primary Category” specified. Service orders, resource information, notes, and information for resource with order type categories are included in the report.</td>
<td>Highlight Changes Made Within: (days)—Changes that have been made within the specified number of days are highlighted in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Pricing—Any pricing that is associated with an item is displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limit Bookings To Those With Details In Selected Categories—Only bookings with a booking detail from the specified categories are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Item Notes—Any notes that have been entered for a booking detail item are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Item Special Instructions—Any special instructions that have been entered in EMS Web App for a booking detail item are displayed in the report.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Lists by category and date, how many of each resource item is needed, as well as the event time, event name, location, and group.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Item Selection Notes—Any notes that have been entered for a booking detail item selection are displayed in the report.</td>
</tr>
<tr>
<td>Show Service User Defined Fields—Any user defined questions and their answers for any listed category are displayed in the report.</td>
</tr>
<tr>
<td>Set Page Numbers By Booking—Resets page number for every unique booking.</td>
</tr>
<tr>
<td>Use Page Breaks—If this report is run across multiple days, then each day starts on a new page.</td>
</tr>
<tr>
<td>Use Page Breaks—If this report is run across multiple days, then each day starts on a new page.</td>
</tr>
<tr>
<td>Highlight Changes Made Within: (days)—Changes that have been made within the specified number of days are highlighted in the report.</td>
</tr>
<tr>
<td>Show Overbooked Resources Only—Only those bookings where...</td>
</tr>
<tr>
<td>REPORT</td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>Service Order</td>
</tr>
<tr>
<td>Attendee Visitor Report</td>
</tr>
<tr>
<td>Production Report</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
## SALES REPORTS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales by Group</td>
<td>Lists the sales for each group type for a date or</td>
<td>Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td>Type</td>
<td>date range.</td>
<td>Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Group</td>
<td>Lists the sales for each group, divided by group type,</td>
<td>Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td>for a date or date range.</td>
<td>Include Report Criteria—The filter set-</td>
</tr>
</tbody>
</table>

A booking detail item are displayed in the report.

» Show Item Selections—Any selections that have been entered for a booking detail item are displayed in the report.
### REPORT DESCRIPTION OPTIONS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales by Category</td>
<td>Lists the revenue generated by each resource category for a date or date range.</td>
<td><strong>Display Amount</strong>—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Include Report Criteria</strong>—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Show Zero Amounts</strong>—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Resources</td>
<td>Lists the sales for each resource item for a date or date range.</td>
<td><strong>Display Amount</strong>—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Include Report Criteria</strong>—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Show Zero Amounts</strong>—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sales by Reservation</td>
<td>Lists the reservations that have bookings for a specified date or date range and shows the charges, by category, for the reservation. Also gives a grand total for all reservations. If a reservation also has bookings that fall outside the specified date or date range, these figures are not included in the report.</td>
<td>- Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Billing Reference</td>
<td>Lists the total sales for a date or date range, based on the billing reference number on the reservations that have bookings in the specified range. Sales that are associated with reservations that have no billing reference number are not included in the report.</td>
<td>- Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Booking</td>
<td>Lists the sales for a particular date or for each date in a date range, broken down by booking. This report displays the following information—Start/End Times, Group, Event Name, Location, Billing Reference#, PO Number, Payment Type, Status, Reservation ID, Booking ID, and</td>
<td>- Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Status</td>
<td>Lists the sales that are associated with a reservation where the reservation or booking status was changed.</td>
<td>Show Zero Amounts–Group Types with zero sales/discounts are displayed in the report. Display Amount–Select from Net Sales, Gross Sales, or Discounts. Include Report Criteria–The filter settings for the report are displayed in the report. Show Zero Amounts–Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Changes by Booking</td>
<td>Lists the sales that are associated with bookings where the bookings status was changed.</td>
<td>Display Amount–Select from Net Sales, Gross Sales, or Discounts. Include Report Criteria–The filter settings for the report are displayed in the report. Show Zero Amounts–Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
</tbody>
</table>
STATISTICS REPORTS

All Statistics reports, except Hourly Room Utilization and Hourly Resource Inventory Utilization, provide data analysis functionality. To View and analyze data, click Analyze to open a Browser window that displays the queried data. You can group the information by column, you can export the raw data to an Excel file, and you can click Details to provide more detailed information about the queried data.

Statistics reports are able to be set to send as an email automatically. To learn more about Automated Reports, see Create Automated Reports.

**TIP:** The Room Utilization report, the Hourly Room Utilization report, and the Hourly Room Utilization report are available only in EMS Enterprise. They are not available in EMS Professional.

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Statistics</td>
<td>Lists all rooms by building and for each room, indicates the following information—</td>
<td>✪ Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td>the number of bookings for the date range selected, the reserved hours, the event hours, the estimated attendance (i.e.,</td>
<td></td>
</tr>
</tbody>
</table>

EMS Software © 2018 / V44.1 / Page 622
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Utilization</td>
<td>Lists the number of bookings, hours used, hours available, percent utilization, and hours vacant for rooms, by building, for the date range specified.</td>
<td>Day Selection—Specify which day(s) of the week to include in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Group By Utilization Category—Groups rooms by utilization (low, high, unused).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Include Cost—The cost for vacancies is displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Include Unused—Include rooms that contain no bookings in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cap Utilization at 100%?—Percent utilization cannot exceed 100%.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low Utilization—Specify what percentage equals “Low” utilization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>High Utilization—Specify what percentage equals “High” utilization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Availability Based On—Select to base availability on one of the following - Building Hours, Hours per Day, or Specific Hours.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hourly Room Utilization</td>
<td>Displays room utilization broken down by hours in the day, by percentage utilized.</td>
<td>» Day Selection—Specify which day(s) of the week to include in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>» Display Chart—Includes a chart on the final page of the report that summarizes the reported data.</td>
</tr>
<tr>
<td>Hourly Resource Inventory Utilization</td>
<td>Displays resources, and the number of items used on an hourly basis for a specified date range.</td>
<td>» Day Selection—Specify which day(s) of the week to include in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>» Display Chart—Includes a chart on the final page of the report that summarizes the reported data.</td>
</tr>
<tr>
<td>Group Statistics</td>
<td>Displays Number of Bookings, Reserved Hours, Event Hours, Estimated Attendance, and Actual Attendance by Group Type for a given date or date range. The format can be set to “Detail” to provide statistics for each specific group.</td>
<td>» Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td>Event Type Analysis</td>
<td>Provides information by event type on the following—the number of reservations, the number of bookings, the percentage of total reserved hours, the percentage of total event hours, the percentage of total</td>
<td>» Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>» Display Chart—Includes a chart on the final page of the report that summarizes the reported data.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reservation</td>
<td>Displays the number of reservations, the number of bookings with percentage, reserved hours with percentage, event hours with percentage, estimated attendance with percentage, and actual attendance with percentage by reservation source.</td>
<td><img src="image" alt="Include Report Criteria" /> The filter settings for the report are displayed in the report. <img src="image" alt="Display Chart" /> Includes a chart on the final page of the report that summarizes the reported data.</td>
</tr>
<tr>
<td>Resource Statistics</td>
<td>Lists the quantity and the hours used by category and by resource item.</td>
<td><img src="image" alt="Include Report Criteria" /> The filter settings for the report are displayed in the report. <img src="image" alt="Show Zero Quantities" /> Includes all resources even if the resource is not used during the date range specified. <img src="image" alt="Show Inactive Resources" /> Includes all inactive resources used during the date range specified.</td>
</tr>
<tr>
<td>Room Availability</td>
<td>Provides a count of room availability by room type for a given date range.</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Count Analysis</td>
<td>count.</td>
<td>▶️ Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td>Seat Occupancy</td>
<td>Displays the capacity for each room, the number of bookings for the date range, the seats available for the bookings, the total estimated attendance based on setup count on each booking, the average estimated attendance, and the estimated percentage of seats filled for the specified date range. Figures are also provided for total actual attendance, average actual attendance, and actual percentage of seats filled.</td>
<td>▶️ Days Open Per Week—Indicates the number of days per week your facility is open per week. The default value is 7. ▶️ Hours Open Per Day—Indicates the number of hours per day that your facility is open. The default value is 10.</td>
</tr>
<tr>
<td>Benchmark Metrics Report</td>
<td>Compiles metrics for a number of different areas within EMS, for example, Rooms By Number of Bookings, Reservations By Source, and so on.</td>
<td>▶️ Days Open Per Week—Indicates the number of days per week your facility is open per week. The default value is 7. ▶️ Hours Open Per Day—Indicates the number of hours per day that your facility is open. The default value is 10.</td>
</tr>
</tbody>
</table>
### OTHER REPORTS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancellation Report</td>
<td>Lists the bookings that have a status that was changed to “Cancelled” on the date or dates specified, or lists the bookings on the date or dates specified that have a status type of “Cancelled.” The report also lists the date that the booking status was changed, the date the bookings were to have taken place, and the location of the event, the name of the person who canceled the booking, the reason for the cancellation, and the booking ID. You can run the report in one of two formats--by Booking Date (the date that the bookings were to occur) or by Cancel Date (the date that the bookings were canceled).</td>
</tr>
<tr>
<td>Cancellation Summary</td>
<td>Summarizes, by reservation, all charges for bookings on a date or in a date range. The report shows the first and last bookings canceled within the reservation, the Group, the reservation number, the group contact, the event name, the event type, the total charges, and the reason for cancellation of the most recently canceled booking. Reservations that do not have charges associated with the bookings are not displayed on this report. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range.</td>
</tr>
<tr>
<td>Reservation Summary</td>
<td>A summary of reservations that occurred within a specific date range. The report also lists complete reservation information (reservation number, event name, group, contact person, and so on) and booking dates. User defined fields can also be printed in this report. You can select Use Specific times and then enter a range of times to limit the report to reservations that occurred within this specified time range.</td>
</tr>
</tbody>
</table>
# EXCEPTIONS REPORTS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined Setups</td>
<td>Lists the bookings on the selected date or date range for which no setup count has been entered. The report lists the following information for the bookings—the event name, time and location, contact name and phone number, booking status, and ID number. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.</td>
<td>Show Bookings on Start Date Only—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3pm Thursday through 10am Friday. If this option is selected, then the booking is displayed only for Thursday in the report.</td>
</tr>
<tr>
<td>Status Reminder Report</td>
<td>Lists the bookings that have a status with a reconfirm date that falls within the selected date range. You typically use the information in this report to review tentative bookings. The report can be run in one of two formats—by Status Date (the date that the event was put in a “Tentative” status) or by Booking Date (the actual date of the event). You can select Use Specific times and then enter a range of times to</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>limit the report to bookings that occurred within this specified time range. You can enter a report name or description or any pertinent information about the report in the Comment field.</td>
<td></td>
</tr>
<tr>
<td>Wait List</td>
<td>Lists all the bookings with a Wait status for the time period that you have requested. Detects situations where a booking has been canceled and there are one or more bookings with a Wait status that can now be changed to Confirmed, and indicates if the room is available. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range.</td>
<td></td>
</tr>
<tr>
<td>Booking Conflict Analysis</td>
<td>Reviews information on all bookings for a date or date range and lists any conflicts</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> EMS does not allow double-bookings, but they might exist because conversion of data from systems that do allow them, or the result of users failing to restart EMS after encountering error messages.</td>
<td></td>
</tr>
<tr>
<td>Building Hours Exceptions</td>
<td>Lists events for a date or date range that fall outside of the configured building hours. Either event time or reserved time is checked based on the &quot;Validate Building Hours on Event Time&quot; parameter. The report also shows the start and end times, group, event name, location, reservation number, and booking number. You can select Use Specific times and then enter a range of times to limit the report to</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Inactive Room With Bookings</td>
<td>Lists the bookings for a specified date or date range that are scheduled in inactive rooms. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.</td>
<td></td>
</tr>
<tr>
<td>Inactive Groups With Reservations</td>
<td>Lists the reservations for a specified date or date range that are scheduled for inactive groups. You can click View to go to the reservation for viewing and editing, including changing the status of the reservation and/or its bookings.</td>
<td></td>
</tr>
<tr>
<td>Invalid Service Orders</td>
<td>Lists the service orders that have a start time and/or end time that fall outside the reserved time for the room. Lists the category, date, reserved and event start and end times, location, group, reservation number, booking number, service order number and a description of the invalid order. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.</td>
<td></td>
</tr>
</tbody>
</table>
### REPORTS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: Service orders that fall outside the reserved time are considered invalid even if the Validate Service Order Times Against Booking parameter is set to &quot;No.&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invalid Billing References</td>
<td>Lists the bookings for a particular date or date range that are in reservations that have invalid billing reference numbers. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.</td>
<td></td>
</tr>
<tr>
<td>Note: A billing reference number is considered invalid if it has not been defined in the Billing Reference Configuration area but the Validate Billing Reference parameter is set to “Valid Only.”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactive Web Process Templates</td>
<td>Displays the inactive web process templates that are attached to reservations.</td>
<td></td>
</tr>
</tbody>
</table>

### HOTELING REPORTS

**NOTE:** In Version 44 the Early Checkout Report was removed. This category of reports is not supported for EMS Professional.
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Occupancy</td>
<td>Displays, by building and room type, the number and percentage of rooms occupied.</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Show</td>
<td>Lists the bookings for which the reservation holder did not check in.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A customer can be checked in via the EMS Kiosk, the EMS desktop client, EMS Glance, or EMS Web App.</td>
<td></td>
</tr>
<tr>
<td>Visitor</td>
<td>Lists events for groups that have cities on their group record, other than what is specified in the Exclude Locations field. If multiple locations are to be listed, they should be entered with a comma between them (for example, Denver, Houston, Tampa, and so on).</td>
<td></td>
</tr>
<tr>
<td>Booking Notice</td>
<td>Lists the total bookings for a date or date range, divided into three &quot;Amount of Notice&quot; categories, where the Amount of Notice is the time between when the booking was scheduled and the date/time for which it was scheduled. The report can be generated in one of two formats— &quot;standard&quot; or by room type.</td>
<td></td>
</tr>
<tr>
<td>Transition</td>
<td>Tracks the occupants of hoteling spaces during a specified date range. Lists by floor and room where the occupant was last, what room the occupant is moving to, and who was in the space the previous day. Typically this report is run for a two day range and the days of the week must be checked. This report can be used by personnel who are responsible for preparing hoteling spaces for each occupant.</td>
<td>Show Details—Prints the categories that are associated</td>
</tr>
</tbody>
</table>
### Groups With Multiple Bookings
Lists groups that have multiple bookings for the date or date range specified.

### Arrivals and Departures
Lists the departures and arrivals for a particular room by building and floor. The report shows the time of the departure if the customer is a departure and the time of the arrival if the customer is an arrival. Typically, this report is run for a two day timespan listing the departure date first and the arrival date second.

Highlight Changes Made Within: (days)– Changes that have been made within the specified number of days are highlighted in the report.
### REPORT DESCRIPTION OPTIONS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Bookings</td>
<td>Room, the room type, and the booking status for each booking.</td>
<td></td>
</tr>
<tr>
<td>Room Card - QR</td>
<td>Allows you to print QR Codes that can be placed outside rooms to be used</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>within EMS Mobile App.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For complete instructions in configuring and generating QR codes, See</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Also: Configure QR Codes.</td>
<td></td>
</tr>
<tr>
<td>Check In Statistics</td>
<td>Lists the percentage of bookings that have been checked-in to by building, building-room type, or room type.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** A customer can be checked in via the EMS Kiosk, the EMS Desktop Client, or EMS Web App.

### INVOICE REPORTS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Worksheet</td>
<td>Provides information on how bookings are to be invoiced. The report can include bookings within a date range, bookings within a reservation, or bookings within a date range inside a reservation. The report breaks down the charges in the same way as an invoice. The report also provides options for printing heading/footer messages and the detail for zero-dollar items.</td>
</tr>
</tbody>
</table>
# GENERAL REPORTS

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ageing Report</td>
<td>A list of outstanding invoices. Current invoices are listed first, followed by past due invoices organized by age. Ageing Reports are based on department.</td>
<td>» Currency—Select the currency for the invoices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>» Show Unapplied Deposits—Deposits that are applied to reservations that have not been invoiced are displayed on the report.</td>
</tr>
<tr>
<td>Statements</td>
<td>A list of outstanding invoices for a selected group. Current invoices are listed first, followed by past due invoices organized by age.</td>
<td>» Currency—Select the currency for the invoices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>» Report Title—Can create a title that is displayed at the top of the statement.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>» Header Message—Select a message from the pre-configured messages that is displayed at the top of every page of the statement.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>Include Transactions On Zero Balance Invoices Within [ ]days—Statements that have a zero balance within the specified number of days are displayed.</td>
<td>»</td>
</tr>
<tr>
<td></td>
<td>Show Billing Reference Number—The billing reference number is displayed under the invoice information.</td>
<td>»</td>
</tr>
<tr>
<td></td>
<td>Show Purchase Order Number—The purchase order number is displayed under the invoice information.</td>
<td>»</td>
</tr>
<tr>
<td></td>
<td>Show Transaction Notes—Any notes entered for the transaction are displayed under the invoice information.</td>
<td>»</td>
</tr>
<tr>
<td></td>
<td>Use Current group Address -</td>
<td>»</td>
</tr>
</tbody>
</table>
### Transaction Report

**Shows all the billing transactions during a specified period if you generate the report in the By Transaction Type by Date format.**

Simply enter the date or date range and click Print. The report lists the group, event name, reservation ID, transaction date, transaction type, invoice number, check number, and amount.

**Note:** If the report is generated in Standard format, deposits are not shown as transactions if they have been absorbed by the generation of an invoice.

**Note:** You can also generate the Transaction Report from within a reservation to see only transactions for the selected event and you can generate the Transaction Report from the Print option on the Payment Entries window. Click Billing > Payments > Payment Entry, and then on the Payment Entries window, click Print.

<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voided</td>
<td>Lists the payments, deposits, or adjustments that were voided on a specific date or within a date range. Lists the group, event name, invoice number, check number, and amount.</td>
<td>Currency—Select the currency for the billing transactions.</td>
</tr>
<tr>
<td>REPORT</td>
<td>DESCRIPTION</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Report</td>
<td>reservation ID, transaction date and type, invoice number (if applicable),</td>
<td>currency for the voided transactions.</td>
</tr>
<tr>
<td></td>
<td>check number, and amount.</td>
<td></td>
</tr>
<tr>
<td>Invoice Detail</td>
<td>Provides detail for all invoices that were generated within a given date</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>range.</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>See To reprint an invoice for detailed instructions about the options that</td>
<td></td>
</tr>
<tr>
<td></td>
<td>are available for the Print Invoice Detail dialog box.</td>
<td></td>
</tr>
</tbody>
</table>

| General Ledger Distribution | Shows the totals for invoices that were generated within a given date range. Entries are broken down by account, invoice, rate plan, or invoice. You can also generate this report in a Summary format. |                                                                         |

- **Currency**—Select the currency for the invoices.
- **Invoices With Payments Only**—Only invoices where payment has been received are posted on the report.
- **Show Applied Deposits/Prepayments**—Applied deposits and prepayments are posted on the report. (An applied deposit is a deposit on a reser-
<table>
<thead>
<tr>
<th>REPORT</th>
<th>DESCRIPTION</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>vation that has been invoiced.</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 99: Generate an EMS Report

All EMS reports are available under the Reports option on the menu bar. For any EMS report, you can specify the parameters, options, and format for the report, or you can generate the report according to saved settings. Not all reports require the same parameters, nor do they all have the same options available. In addition, you can generate different reports in different formats.

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option for the report that you are generating. For example, to generate the Event Schedule report, click Reports > Daily > Setup Worksheet. A report setup window displays where you can set up your report. Shown below is one for a Setup Worksheet.
2. On the Setup drop-down list, do one of the following:
   
   ➢ To generate the report according to your filter settings (parameters, options, and so on), leave (user specified) selected on the Setup list, and then go to Step 3.

   ➢ To run the report with filter settings that have been saved, select the saved report on the Setup list, and then go to Step 5.

3. On the Options list, select the **Date/Time Filter** by which to generate the report.
4. Specify the report parameters, options, and format. For brevity and ease, the parameters and options that are available for each report are discussed in Report Descriptions and Options. Billing reports are discussed in Billing. Academic reports are discussed in Academic Planning (EMS Campus).

For descriptions of each type of report, refer to:

- Daily Reports
- Sales Reports
- Statistics Reports
- Other Reports
- Exceptions Reports
- Hoteling Reports
- Invoice Reports
- General Reports

5. On the Report Setup window, you can:

- Add a comment to be printed in the report in the Report Comment field (only available on certain reports; maximum of 255 characters, including spaces).
- Click Print Preview. A preview of the report opens onscreen.
Print a hard copy of the report; specify the number of copies that you are printing and then click Print.

6. Click Close. Unless you change the filter settings, all subsequent reports are generated and printed according to the parameters, options, and format you specified. If you want to save settings so you do not have to adjust them every time you run the report, you can save the report. See Also: Work with Saved Reports.
CHAPTER 100: Generate an EMS Billing Report

All EMS Billing reports are available under the Billing option on the menu bar. For any EMS report, you can specify the parameters, options, and format for the report, or you can generate the report according to saved settings. (For detailed information about a saved report, see Work with Saved Reports.) Not all reports require the same parameters, nor do they all have the same options available. In addition, you can generate different reports in different formats.

TIP: For brevity and ease, the parameters and options that are available for each report are not discussed here. Instead, the options are discussed in Report Descriptions and Options. Contact your EMS administrator if you need assistance in generating any of these reports.

GENERATE A REPORT

1. On the EMS menu bar, click Billing to open the Billing menu, and then do one of the following:
To generate the Billing Worksheet report, click Billing > Invoices > Billing Worksheet.

To generate any other Billing report, click Billing > Reports, and then click the option for the report that you are generating. For example, to generate the Ageing report, click Billing > Reports > Ageing.

**TIP:** All Billing reports other than the Billing Worksheet report are also available from Reports > Billing.

2. On the Setup drop-down list, do one of the following:
   - To generate the report according to the filter settings that you want (parameters, options, and so on), leave user-specified selected, then go to Step 3.
   - To run the report with filter settings that have been saved, select the saved report, and then go to Step 4.

**TIP:** For detailed information about saved reports, see Work with Saved Reports.
3. Specify the report parameters, options, and format. See:
   » Invoice Reports
   » General Reports

4. Optionally, do one or both of the following:
   » Click Print Preview. A preview of the report opens onscreen.
   » To print a hard copy of the confirmation, specify the number of copies that you are printing, and then click Print.

5. Click Close. Unless you change the setup, all subsequent reports will be generated and printed according to the parameters and options that you have specified and in the format that you specified. If you want to save certain settings so that you do not have to adjust the filter settings every time you run the report, you can save the report. See Work with Saved Reports.
CHAPTER 101: Generate Attendee Visitor Reports

To generate a daily report of visitors, follow the steps below.

1. On the main menu, click **Reports > Daily > Attendee Visitor Report**.

*Access Attendee Visitor Report from the Reports Menu*
2. On the Setup drop-down list, you can select from a list of saved visitor reports for your organization, or you can set your own report parameters, options, and so on (leave "user specified" selected and populate the fields on each tab as needed). If using a saved report Setup, simply specify a date range.
Setup Drop-Down List of the Attendee Visitor Report Dialog Box
**TIP:** You can edit saved report setups from the Setups option in the upper right corner. Additionally, you can quickly specify a date range based on when bookings start or when they occur using the Options menu next to it.

To save your (user specified) report for future use (so that it is listed in the Setup drop-down): click **Save** next to the Setup field.
3. To run the report once you have specified parameters, click **Print**. When finished, click **OK** on the Print dialog and click **Close** on the Attendee Visitor Report dialog box.
CHAPTER 102: Configure Automated Reports

EMS is able to send reports daily to selected email addresses. Reports that can currently be automated to send are Reservation and Sales\Statistics Queries and all Saved Daily and Statistics Reports under the EMS Reports menu. To learn more read about creating Queries or Saved Reports. Automated Reports can be set up and emailed to selected individuals. Automated Reports use predefined Queries and Saved Reports. An email will be sent to the users defined in the Automated Report Delivery with either the information requested through the report, or with an email stating there was no data to display.

For Automated Reports to be sent, the EMS Automated Report service needs to be installed and configured. For directions on installing and configuring the service see the Installing the EMS Automated Report Service.

1. On the EMS menu bar, click Reports > Automated Report Delivery. The Automated Report Delivery window opens. This window lists all Automated Reports that are currently configured in your EMS database and that have a status of Active.
Tip: To view any deactivated Automated Reports check the "Inactive" box inside the "Show" section.

3. In the Description field, enter a name or description for the new Automated Report. The Automated Report Delivery description should specify the type of delivery, such as "Daily Event Schedule Delivery."

4. Specify if this report is a Query or Saved report.
Concept: Queries and Saved Reports

QUERY

» Query Type: limits the displayed Queries to either Reservation or Sales/Statistics.
» Query: Shows the available Queries to Automate based on either Query Type, or if no Query Type is selected it will display all Reservation and Sales/Statistics queries.

SAVED REPORT

» Report Section: Set to (all) by default, but can be modified to either Daily or Statistics to limit the Report Types that will be shown.
» Report Type: Set to (all) by default, but can be modified to a specific Daily or Statistical report to filter the saved reports.
» Saved Report: Displays the Saved Reports that are available to be automated.

5. Specify Frequency

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Daily</th>
<th>Weekly</th>
<th>Monthly</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weekdays Only</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Daily/Weekly/Monthly: Determines the frequency that the report will send.
  - Daily: will send every day at the specified time.
  - Weekly: Can be set to a single day every week or multiple days every week.
Monthly: Can specify a specific day each month (1-28) or the last day of the month.

Send Report At: Determines the time each day that the Automated Report will send.

Time Zone: Determines the time zone for the time selected for the report to send. Time and Time Zone correlate to the database server and the server on which the Automated Report Service is installed.

Reporting Period: Determines the dates which the report will be automated for. Choose from multiple options in the drop-down list to customize the reports.

6. Specify Email Settings/Recipients

   - Email From: Enter the Email From address for the Automated Report.
   - If you leave the Email From field blank, then the Email From address entered in the EMS Automated Report Service is used.
Email Subject: title for the email that will contain the Automated Report.

If the Subject line is left blank the Automated Report description will be used as the email subject.

A variable can be used to put information into the subject line as described in the Legend. %1% is the code for the Reporting Period, so "Event Schedule for %1%" results in "Event Schedule for Tomorrow" being displayed in the subject line.

Email Address: You can look up Email Addresses by clicking the Add button, which selects from the Global Address Book. In the Email Address field, for each user and/or group that is to receive the Automated Report, enter the appropriate email address, and then click Add.
CHAPTER 103: Work with Saved Reports

A saved report is a report for which the filter settings have been saved so that you do not have to adjust the filter settings every time you run the report. You can create a saved report from a new saved report, or you can copy an existing saved report, and edit the filter settings as needed to create a new saved report. If you are the owner of a saved report, you can also edit the name of an existing saved report and you can delete a saved report. To learn more about creating Automated Reports from Saved Reports with EMS, see Create Automated Reports.

| TIP: Although this topic is written from the perspective of reports, it is also applicable for working with saved confirmations and invoices. |

1. Open a report you want to save. From the EMS menu bar, click Reports to open the Reports menu, and then select the report type and the report name.
2. The Event Schedule window opens where you can set your report preferences.
3. Click **Options** in the toolbar to set the Date/Time by which to generate the report.

5. If you want to copy or edit a saved report, select it from the Setup field. The options at the top of the window change so you can **Automate**, **Edit**, or **Copy** the saved report.

6. On the dialog box that presents, click **Save** or **Copy**. The Save Report Setup dialog box opens so you can name the new saved report.
7. Enter a Description field (maximum of 50 characters). If you are an administrative user, and the report is to be available to all users, then select **Public (Available to All Users)**. If the report is to be available only to you (the owner), then leave this option unchecked. If you are not an administrative user, only your EMS administrator can make your saved reports available to all users. Contact your EMS administrator for assistance.

8. When you have set up your new or copied report, click **OK**. The Save Report Setup dialog box closes and you return to the Report dialog box. The saved report is now an option on the Setup drop-down list.

**RENAMEING OR DELETING A SAVED REPORT**

1. Open a report you want to edit or delete. From the EMS menu bar, click **Reports** to open the Reports menu, and then select the report type and the report name.
Example of an open report

2. On the report window, click **Setups**. The saved Report Setups dialog box opens. This dialog box lists all the saved report setups for which you are the owner, and therefore can edit the name and/or delete the report.
TIP: Administrative users can edit and delete all saved reports in the system, and can make reports available to all users. See Also: Manage Saved Reports.
3. Select a saved report setup, and then do one of the following:

» To rename the report, click **Edit** to rename of the report in the Description field.

» To delete the report, click **Delete**, and then click Yes to confirm.
CHAPTER 104: Work with a Query

A query is the primary mechanism for retrieving information from a database. A query consists of questions that are presented to the database in a predefined format. A Query Builder function is available from the Reports menu. You can use this function to create queries for retrieving information from your EMS database. When you create a query, you can name and save the query so that you can run the query at any time that you choose. You can create a query from a newly created query, or you can create a query by copying an existing query and editing the copied query as needed. You can also edit a query, delete a query, and view and print a query's filters.

This topic provides information about the following:

» Create a Query
» Edit a Query
» Delete a Query
» View and Print a Query's Filter
» Run a Query
CREATE A QUERY

1. On the EMS menu bar, click Reports > Queries > Query Builder. The Query Definitions dialog box opens. The dialog box displays all the queries that have been previously defined in your EMS database and that have a status of Active.

**TIP:** Optionally, to view all queries in your EMS database, regardless of status, under Show, click Inactive.
2. Do one of the following:
   
   » To create a query from scratch, click **New**.
   
   » To create a query by editing an existing query, select the query that is to be edited, and then click **Copy**.

The Query Builder Filter dialog box opens. The **Query Builder Filter** tab is the active tab. You use the options on this dialog box to name and define the query.
3. Enter or edit the needed information for the query. See:

   - Query Builder Filter tab
   - Display Fields tab
   - Filter tab
   - Sort tab
   - Chart tab
   - Users tab

4. Do one of the following:

   - Click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the **Results** tab, and then click Preview to run the query immediately and view the results on the tab. You can then click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
1. On the **Query Builder Filter** tab, name and define the query.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Name</td>
<td>Name of the query filter.</td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The name can be a maximum of 50 characters, including spaces.
<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Type</td>
<td>The type of information that the filter is to capture. The Filter Type affects the items that are available on the Display Fields tab and the Filter tab. A Filter Type of Group allows you to capture address information that can be exported and subsequently used by other programs to create mailing labels.</td>
</tr>
<tr>
<td>Display in</td>
<td>Available only for a Filter Type of Billing or Reservations. Select this option if the query that you are creating is to be available in the Browser.</td>
</tr>
<tr>
<td>Open in</td>
<td>Available only if the Filter Type is Reservations and Display in Browser is selected. Indicate what the system should open in the Navigator when a user double-clicks on an item that is retrieved by the query.</td>
</tr>
<tr>
<td>Owner</td>
<td>Available only to administrative users.</td>
</tr>
<tr>
<td>Return First “xx” Number of Records</td>
<td>To limit the number of records that the query returns, select this option, and then enter the number of records in the field.</td>
</tr>
<tr>
<td>Inactive</td>
<td>By default, a query is added as an active query. Select this option to inactivate the query.</td>
</tr>
</tbody>
</table>

Note: Only a single Filter Type, Reservation, is available in EMS Professional.

2. Continue with any other configuration for the query as needed, or do one of the following:
Click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

Open the **Results** tab, and then click **Preview** to run the query immediately and view the results on the tab. You can then click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

**DISPLAY FIELDS TAB**

*Query Builder Filter dialog box, Display Fields tab*
1. Open the **Display Fields** tab, and then do one of the following:

   - Select the field, or CTRL-click to select the multiple fields that are to be displayed in the query results, and then click the Move button (>) to move the selected fields to the Selected list.
   - In the Field Search field, enter the string by which to filter your search for available fields. Select the field, or CTRL-click to select multiple fields, and then click the Move button (>) to move the selected fields to the Selected list.
TIP: The search is limited to the exact order of characters in the string, but the string is not case-sensitive and it can be found anywhere in the search results. For example, a search string of Add returns both Added By and Date Added. As you enter the search string, the Available Fields list is dynamically updated with a list of fields that meet the search criteria.

TIP: If you are copying an existing query, then when the Display Fields tab opens, the Selected list is already populated with a list of fields. You can select one or more of these fields, and then click the Remove button (<) to move these fields back to the Available list.

2. The fields are displayed in the query results in the order in which they are listed in the Selected list. Optionally, to change the order of the fields, select a field and then click Move Up/Move Down as needed.

3. Continue with any other configuration for the query as needed, or do one of the following:

   » Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
Open the Results tab, and then click **Preview** to run the query immediately and view the results on the tab. You can then click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

**FILTER TAB**
1. Open the **Filter Fields** tab, and then do one of the following:

   - For each field that is to define the query, select the field, and then click the Move button (>) to move the fields to the Filter Summary list.
   - In the Field Search field, enter the string by which to filter your search for available fields. For each field that is to define the query, select the field, and then click the Move button (>) to move the fields to the Filter Summary list.

**TIP:** The search is limited to the exact order of characters in the strings but the string is not case-sensitive and it can be found anywhere in the search results. For example, a search string of Contact returns both Contact Name and 1st Contact. As you enter the search string, the Available Fields list is dynamically updated with a list of fields that meet the search criteria.

For each field that you select, a dialog box opens in which you must specify the allowed values for the field. After you specify the values and click **OK**, the dialog box closes, and the selected field is moved to the Filter Summary list.
**TIP:** If you are copying an existing query, then when the **Filter Summary** tab opens, the Filter Summary list is already populated. You can select one or more of these fields and then click the Remove button (\(<\)) to move these fields back to the Available list. If you want to use the same Filter Summary fields in the “new” query, but with different values, you cannot change the values directly. You must move the appropriate fields back to the Available list, then select the fields again to change their values.

2. Continue with any other configuration for the query as needed, or do one of the following:
   - Click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the **Results** tab, and then click **Preview** to run the query immediately and view the results on the tab. You can then click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
SORT TAB

1. Open the Sort tab, select the field or CTRL-click to select the multiple fields by which the query results are to be sorted, and then click the Move button (>) to move the fields to the Selected list.

2. Continue with any other configuration for the query as needed, or do one of the following:
   - Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder
Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

**CHAPTER 104: Work with a Query**

**CHART TAB**

1. Open the **Chart** tab, and specify the type of chart that is to be used to graph the query results.
2. Manually enter any information for the chart (for example, Chart Title) as needed.

3. Optionally, do one or both of the following:
   - To show a legend with the chart, select **Show Legend**, and then specify the legend information (alignment, header, footer, and marker style and size).
   - To spell check any charting information that you manually entered, click **Spelling**.

4. Continue with any other configuration for the query as needed, or do one of the following:
   - Click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the **Results** tab, and then click **Preview** to run the query immediately and view the results on the tab. You can then click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
TIP: The ability to assign specific queries to specific users is available only in EMS Enterprise. It is not available in EMS Professional.

1. Open the Users tab, and in the Available list, select the user, or CTRL-click to select the multiple users who can run this query, and then click the Move (>) button to move the selected users to the Selected list.
**TIP:** By default, all administrative users can run any query that any user creates. These users are listed in the Administrative list. You cannot remove any administrative users from this list. Additionally, if a user is assigned to a User Template, this template controls which queries they have access to here.

2. Continue with any other configuration for the query as needed, or do one of the following:
   - Click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the **Results** tab, and then click **Preview** to run the query immediately and view the results on the tab. You can then click **OK** to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
EDIT A QUERY

1. On the EMS menu bar, click Reports. The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder. The Query Definitions dialog box opens. The dialog box displays, by name, any queries that have been previously defined in your EMS application.

3. Select the query that you are editing, and then click Edit. The Query Definitions dialog box opens. All of the tabs are populated with the information for the selected query.

4. Edit the query as necessary including one or more of the following:
   
   » Renaming the query.
   
   » Changing the fields that are to be displayed in the query results.
   
   » Changing the fields that define the query.
   
   » Changing the order of the fields by which the query results are to be sorted.
   
   » Changing the charting options for the query results.
   
   » Changing the users who can run the query.

5. Do one of the following:
   
   » Click OK to close the Query Builder Filter dialog box and save the edited query. The edited query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the edited query. The edited query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

DELETE A QUERY

1. On the EMS menu bar, click Reports. The Reports menu opens.
2. On the Reports menu, click Queries > Query Builder. The Query Definitions dialog box opens. The dialog box displays any queries that have been previously defined in your EMS application.
3. Select the query that is to be deleted, and then click Delete. A message opens, asking you if it is OK to delete the selected query.
4. Click Yes. The message closes. The query is deleted.

VIEW AND PRINT A QUERY'S FILTERS

1. On the EMS menu bar, click Reports. The Reports menu opens.
2. On the Reports menu, click **Queries > Query Builder**. The Query Definitions dialog box opens. The dialog box displays any queries that have been previously defined in your EMS application.

3. Select the query that is to be printed, and then click **Print**. An onscreen preview of the selected query opens. A variety of options are available from this preview, including the options to print a hard copy of the query, to email the query, and so on.
Print Preview for a Query

4. Select the option or options that best fit your working needs.

RUN A QUERY

When you run a saved query, you can run the query from the Reports menu, or you can run the query from the Query Definitions dialog box.
1. On the EMS menu bar, click **Reports** and on the Reports menu, click **Queries**, and then do one of the following:

   » Click the name of the query that you are running.

   » Click **Queries** > **Query Builder** and on the Query Definitions dialog box, select the query that you are running, and then click **Run**.

   » The query is run and the results are displayed onscreen in the Query Results dialog box.

---

**TIP:** The Results (lower) pane on the Query Results dialog box is an EMS browser window. See **EMS Browser Window** for all the features that are available for this pane.
2. Optionally, on the Query Results dialog box, do one or more of the following, and then click **Get Data** to rerun the query according to the edited definition.

   Select the date for which the data in your EMS database is to be queried.

### OPTION | DESCRIPTION
--- | ---
Custom | The starting date is set to the first day of the month and the ending date is set to the last day of the month but you can edit one or both of these dates.
**OPTION** | **DESCRIPTION**
--- | ---
**Note:** For some queries, if you select **Custom**, a **Use Specific Times** option becomes available. If you enter the same date for the starting date and ending date, you can select **Use Specific Times**, and then enter a starting time and ending time to query the data in specific time range on the same day.

| Last Month | The starting date is set to the first day of the previous month and the ending date is set to the last day of the previous month. |
| Last Quarter | Quarters are based on a calendar year: |
|  | ➢ First quarter is 1/1 through 3/31. |
| This Quarter | ➢ Second quarter is 4/1 through 6/30. |
|  | ➢ Third quarter is 7/1 through 9/30. |
| This Quarter To Date | ➢ Fourth quarter is 10/1 through 12/31. |
| Last Year | The starting date is set to 1/1 of the previous year, and the ending date is set to 12/31 of the previous year. |
| This month | The starting date is set to the first day of the current month and the ending date is set to the last day of the current month. |
| This Year | The starting date is set to 1/1 of the current year, and the ending date is set to 12/31 of the current year. |
**OPTION** | **DESCRIPTION**
--- | ---
This Year | The starting date is set to 1/1 of the current year, and the ending date is set to the current day’s date.
to Date

» Change the Starting Date, Ending Date, or both.
» In the Report Comment field, enter a comment that is to be printed on the query.

**TIP:** The comment can be a maximum of 255 characters, including spaces.

» Click **Options** and change the settings for specific room filter and/or the number of records to return.

3. After you have run the query to your satisfaction, you can then do one or both of the following:

» To print the query results, click **Print**. An onscreen preview of the query results opens. A variety of options are available from this preview, including the options to print a hard copy of the query results, to export the query results to a .pdf, and to email the query results. Select the option or options that best fit your working needs.
To export the query results to an Excel spreadsheet, or to an XML file, click Export, and then click **Excel** or **XML** as appropriate.
CHAPTER 105: Billing

Accurate and timely billing is critical to ensuring a successful experience for organizations that schedule events at your facilities. EMS provides a variety of functions for working with invoices and transactions for reservations and bookings as well as reporting on this information.
CHAPTER 106: Overview of Billing in EMS

Billing in EMS is a two-step process:

1. **Generate Invoices**
   You can generate invoices based on reservation number, date range, or both. For example, you could generate invoices for all bookings in Reservation 1829 that occurred last month. After you have generated the invoices, EMS tracks the amount due and the age of the invoices.

2. **Process Received Payments**
   You can use the Payment Entry function to enter deposits made against a reservation before invoicing or booking and to enter adjustments.

Tip: As part of this process, you can generate the Billing Worksheet report. (See [Generating an EMS Billing Report](#).) You use this report to review the dollar amounts for the bookings for which you intend to create invoices. You can correct any discrepancies that you note in the report by editing the bookings or booking items in question.
Financial transactions in EMS are batched by department. For example, if a user who is a member of the Scheduling department applies a deposit to a reservation, then the deposit is shown on a confirmation only if the user who applied the deposit or other users in the Scheduling department print the confirmation. If a user in another department, for example, the Catering department, prints the confirmation, then the deposit is not shown on the confirmation. Similarly, invoices that are generated by a department are printed on the Ageing report only if the report is generated for the same department. If you invoice a reservation or one of its bookings, any deposit that was previously made on the reservation is then applied and is no longer shown on the confirmation. If you invoice an event, the event is locked and cannot be edited. You can edit the event only after you void the invoice. You cannot void an invoice if payments have been made against it. You must first void the payments. You can use an adjustment with a negative dollar amount to clean up your financial records. For example, you generate an invoice for $102 for a group and the group returns a check for $100. If you do not want to ask the group for a $2.00 check, an adjustment of $2.00 balances your books.
CHAPTER 107: Search for Transactions

You can find all transactions for a reservation on the Transactions tab in the Navigator. The Browse Transactions option, however, enables you to search for any transaction type with or without the reservation number, using a basic or advanced search; search results show in a list view. A basic search calls for basic information that you specify for a transaction when you first create it, such as the group to which the transaction applies, the department that generated the transaction, and so on. An advanced search goes through more specific field values in reservations, transactions, or both. For example, in an advanced search, you search by the Bill-To Contact at the reservation level.

1. On the EMS menu bar, click Billing > Other > Browse Transactions. The Browse Transactions window opens. The first time the Browse Transaction window opens, the Filter tab uses a basic search; otherwise, it uses the search type (Basic or Advanced) that you last performed.
2. Click the Basic/Advanced toggle button to switch between the search types.

**BASIC SEARCH**

A basic search calls for basic information that you specify for a transaction when you first create it, such as the group to which the transaction applies, the department that generated the transaction, and so on.

1. Enter your search criteria using the table below.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Time</td>
<td>The date range during which the transactions were carried out.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Ending Time</td>
<td>Both are optional.</td>
</tr>
<tr>
<td>Group</td>
<td>(Often re-labeled &quot;Employee&quot; or &quot;Customer&quot;). Search for a person or group for which the transactions apply.</td>
</tr>
<tr>
<td>Department</td>
<td>Leave the default value set to (all) or select a specific department that generated/issued the transaction.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Leave the default value set to (all), or select a specific transaction type for which to search.</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>If you are searching for a specific invoice or invoices, enter a search string. Note: The search is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a search string of 10 returns 1000, 1017, but not 910.</td>
</tr>
<tr>
<td>Reservation ID</td>
<td>Leave the default value set to 0 to search for a transaction regardless of reservation ID; otherwise, enter the exact value of the reservation ID.</td>
</tr>
<tr>
<td>Amount</td>
<td>Leave the default value set to 0.00 to search for transactions regardless of the transaction amount; otherwise, enter the exact amount of the transaction.</td>
</tr>
</tbody>
</table>
2. You can click Options and specify the Number of Records to Return.

3. Click Get Data or Refresh to see search results.

Browse Transactions window, Results tab

4. To work with the results, you can do one or more of the following:

   » Click Print to print the search results.
   » Click Export to export the search results to a Microsoft Excel spreadsheet.
   » Select an invoice, and then click Email to open a pre-addressed SMTP email to the group that is associated with the invoiced reservation. Complete and send the email as you would normally. (The invoice is sent as an attachment.) See Also: Sending Email.
» Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

» Click Refresh to re-query the database based on the current search criteria.

5. Click Close. Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. You can also Reset the columns to their default values.

ADVANCED SEARCH

An advanced search goes through more specific field values in reservations, transactions, or both. For example, in an advanced search, you search by the Bill-To Contact at the reservation level. Toggling to an Advanced search refreshes the Browse Transactions window with additional options.
1. You can enter a Starting Date, an Ending Date, or both, to set a date range for the search. If these dates are the same, you can select Use Specific Times and enter specific time periods to search.

2. Select fields you want to specifically search and use the arrow button to move each to the right pane.

Tips: You can use the Field Search field to filter the list of available fields by keyword.

If you want to use specific fields and/or values often in this kind of search, use Add To Favorites. After you define a value or define the limits for a
field, click Save Value on the Filter dialog box. The next time that you perform a search, you can open the Favorite Fields tab or the Saved Values tab to re-use these favorite fields and pre-set values.

To see details about a field, you can mouseover the field in the Filter Summary list.

3. When prompted, enter a value or define the limits for the field, and then click OK.
4. You can, click Options and set values for additional search options: Date/Time Filter, Number of Records to Return, and Specific Room Filters.
5. Click Get Data or Refresh to see search results.
6. You can work with the search results just as you would for the Basic Search (above).

7. Click Close.
CHAPTER 108: Apply Calculations to Billing

Calculations are additional charges that can be applied to billable items based on an associated group or individual, a category or service, or a room.

... such as gratuity or sales tax. Both pricing methods and calculations determine the final cost for a billable item; however, unlike pricing, which is applied when a billable item is reserved (and retained, even if the price for the item later changes), calculations are figured each time a confirmation or an invoice is generated. If an event has associated calculations (which are assigned to groups or individuals, categories and services, and rooms), you will see these in the invoicing process.

This quick reference gets you going with billing and invoicing in EMS Desktop Client:

- Run the Billing Worksheet to Review Charges
- Edit Charges on Reservations
- Invoice Reservations in Batch
- Run the General Ledger Distribution Report by Invoice
- Apply Payments in Batch
- Void Payments and Invoices
- Additional Billing Reports

RUN THE BILLING WORKSHEET TO REVIEW CHARGES

- Once a billing cycle is complete, run the Billing Worksheet to review reservations with charges assigned that have not been invoiced yet.
- Go to Billing > Invoices > Billing Worksheet > Select the Previous Billing Cycle > Print Preview
EDIT CHARGES ON RESERVATIONS

» If a reservation on the billing worksheet needs to be modified, use the Reservation ID from the billing worksheet to open the reservation.

» Add or edit billable items like resources as needed.

» In the navigator screen, you will see the prices in the booking details pane. Edit the booking detail to manually change the price as needed.

» To change the prices to another pricing plan, go to the Reservation level > click Update Pricing

Then choose a New Pricing Plan, select the appropriate category, then click Next.
Select all Applicable Bookings, then click Finish.

INVOICE RESERVATIONS IN BATCH

» Once charges on reservations are corrected, invoice in batch.

» Go to Billing > Invoices > Invoicing

» Select the same Dates and other filter criteria used on the Billing Worksheet.

» Click Generate

» Highlight the transactions you want to invoice (all or some), click Preview to review, then click Final - click Yes to warning about posting and printing x number of invoices

» The invoices display. Close the preview.
RUN THE GENERAL LEDGER DISTRIBUTION

REPORT BY INVOICE

» Next run the general ledger distribution report by invoice to see all of the journal entries that need to be made for the billing period. The report includes the Billing Reference Number to charge, the accounts to credit, and the amount due.

» Go to Billing > Reports > General Ledger Distribution

» The first time you run this report, make the following selections and then click Memorize to save the report for future use.

» Date Range Tab:
   » Department - will default to the department you work in and are assigned to.
   » First Transaction Date and Last Transaction Date - select the date the batch invoices were created
   » Group - (all)
   » Format - By Invoice

» Group Types Tab:
   » Move all group types that you invoice from the Available to the Selected column

» Options Tab:
   » Currency: US Dollars
   » Invoices with Payments Only: unchecked
   » Show Applied Deposits/Pre-payments: unchecked
After the report has been saved, click Print Preview.

Optionally, use this report to make journal entries in your financial system. The Billing Reference Numbers represents the account to be debited, the Account represents the revenue account to be credited.

---

### APPLY PAYMENTS IN BATCH

Optionally, apply payments in EMS to represent that the journal entry was made to pay for the charges. Go to Billing > Payments > Payment Entry.

The Payment Entries window will open. Click New.

The Payment Entry window will open. Make the following selections:

- **Transaction Type - Payment**
- **Payment Type - Internal Transfer**
- **Check No. -** optionally enter the journal entry transaction number
- **Amount -** enter the total amount paid for the invoice
» Invoice No. - type the invoice number found on the General Ledger Report

» Notes - Optionally, enter other information you would like to track about this payment. Click OK to save.

VOID PAYMENTS AND INVOICES

» If a correction to an invoice is needed, you must void the most recent transaction(s) on an invoice before you can void the Invoice itself. For example, payments applied to an invoice must be voided first.

» On the Transactions Tab, select payment > Void > enter Void Reason > OK (this action does not delete the payment, it voids it and displays void date & comment)

» To void an Invoice, select invoice > Void> enter Void Reason > OK

» Transactions become locked after a certain number of days. The number of days are configured on the Department are represent the number of days you are allowed to void an invoice. If it is 365, for example, you must void invoices within one year of creating that invoice. After one year, you would not be able to void the invoice.

ADDITIONAL BILLING REPORTS

STATEMENTS

» Allows you to create a customer facing statements (across all invoices) of the original amount due on an invoice and remaining balance.

» Billing > Reports > Statements
AGEING REPORT

» Used to show who owes a payment and if they are current, 30 days, 60 days, or 90 days late.

» Billing > Reports > Ageing Report

BILLING QUERIES

» If you need a billing report that doesn’t already exist in EMS, build a query. Use billing as a filter type. When billing is selected as the filter type, transaction fields become available as filters and display fields.

» Reports > Queries > Query Builder
CHAPTER 110: Work with Invoices

You can generate an invoice in EMS Desktop Client based on a specific booking date or date range, a reservation number, or both. For example, you can generate invoices for all bookings from May 1 through May 14, for all bookings in reservation number 22, or for all bookings in reservation number 22 that occurred between May 1 and May 14. You can generate multiple invoices for the same booking, with each invoice showing the charges for a different category (such as room charges on one invoice, catering charges on another invoice, and so on). This might be necessary in situations in which you must produce multiple invoices for the same booking if the departments within your organization bill separately for the services they provide. You can also reprint an invoice and void an invoice.

You can work with invoices for a single reservation, or you can batch process multiple invoices. If you want to work with invoices for a single reservation, you do so through the Transactions tab in the Navigator. If you want to work with a batch of invoices, you do so through the EMS Desktop Client Billing menu: Billing > Invoices > Invoicing.
GENERATE AN INVOICE

TIP: Before you generate an invoice, you should generate the Billing Work-sheet report. See Generate an EMS Billing Report.

1. Do one of the following:
   - Open the reservation in the Navigator and on the Transactions tab, click New > Invoice.
   - On the EMS Desktop Client menu bar, click Billing > Invoices > Invoicing. The Invoicing window opens.
TIP: On the Setup drop-down list, you can select a saved, or memorized, invoice. If you select a memorized confirmation, then the only changes that you can make are to the dates and/or times on the **Date Range** tab.

2. Review and make changes as needed, using the table below.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date Range tab</strong></td>
<td></td>
</tr>
<tr>
<td>Department</td>
<td>Select the department that is creating the invoices. The department name and address is printed at the top of the invoice.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is automatically populated if you have a default department assigned to your user account but you can select a different value if needed.</td>
</tr>
<tr>
<td>Reservation Number</td>
<td>Automatically populated if you are generating an invoice from the Transaction tab; otherwise, enter a reservation number.</td>
</tr>
<tr>
<td>Starting Date</td>
<td>Automatically populated with the first (starting) booking date and the last (ending) booking date for the selected reservation when you are generating an invoice from the Transaction tab; otherwise, enter the date range of the bookings for which you are generating the invoice.</td>
</tr>
<tr>
<td>Ending Date</td>
<td></td>
</tr>
<tr>
<td>Use Specific Times</td>
<td>If only a specific time for the bookings is to be invoiced (for example, the bookings are from 8 am to 5 pm and you want to invoice the booking from only 8 am to noon), click Use Specific Times and then enter a specific time period.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>The default value is the current day's date. You can leave this value as is, or enter a different date.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The default value is 30 days from the current day's date. (Your Admin-</td>
</tr>
</tbody>
</table>
FIELD | DESCRIPTION
---|---
| Administrator might have configured a different default value for this field.)
| You can leave in the field as is, or you can enter a different date.

Buildings tab/Categories tab/Statutes tab/Group Types tab

Open the appropriate tab on the window and select the buildings, resource categories, booking statuses, and group types that are to be invoiced. This information is displayed on the invoice. To select a building, category, and so on, select the item in the Available list (CTRL-click to select multiple items), and then click the Move button (>) to move the items to the Selected list.

**NOTE:** You can click the Show Inactive option for both categories and statuses, to show inactive categories and statuses, so you can select these inactive items as part of your filtering criteria.

Options tab—Format settings for a printed confirmation

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Message</td>
<td>Select the header message and footer message that is to be printed on the invoice. By default, the header and footer messages are printed on every page of the invoice. To print the header only on the first page of the invoice, clear the Print Header on Each Page option.</td>
</tr>
<tr>
<td>Footer Message</td>
<td></td>
</tr>
<tr>
<td>Currency</td>
<td>Select the currency that indicates how a room or resources in a category should be charged.</td>
</tr>
<tr>
<td>Print Comments</td>
<td>Include the comments for the reservation in the printed invoice.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print Reminders</td>
<td>Include the reminders for the reservation in the printed invoice.</td>
</tr>
<tr>
<td>Print User Defined Fields</td>
<td>Include user-defined fields and their values in the printed invoice.</td>
</tr>
<tr>
<td>Suppress Reserved Time</td>
<td>Do not show the reserved time on the printed invoice. (Instead, only the event time is included on the printed invoice.)</td>
</tr>
<tr>
<td>Print Item Notes</td>
<td>Include the notes for any booking items in the printed invoice.</td>
</tr>
<tr>
<td>Print Zero Priced Items</td>
<td>Include resources for which there was no charge in the printed invoice.</td>
</tr>
<tr>
<td>Print Item Selections</td>
<td>Include any resource item selections in the printed invoice.</td>
</tr>
<tr>
<td>Print Header On Each Page</td>
<td>Include the selected Header message on each page of the printed invoice.</td>
</tr>
<tr>
<td>Suppress Logo</td>
<td>Do not show your department's/organization's logo on the printed invoice.</td>
</tr>
<tr>
<td>Print Billing Reference Allocation</td>
<td>Include the billing reference numbers for the event as well as the percentage of charges that is allocated to each number in the printed invoice.</td>
</tr>
<tr>
<td>Print Category Subtotals</td>
<td>Include the subtotal charges by category in the printed invoice.</td>
</tr>
<tr>
<td>Display Messages as HTML</td>
<td>If you have defined any HTML messages, then select this option to dis-</td>
</tr>
</tbody>
</table>
### FIELD DESCRIPTION

play the HTML version of these messages in the printed invoice; otherwise, the message is displayed in plain text.

---

**TIP:** If needed, you can always save these settings. See [Work with Saved Reports](#).

---

3. Click **Generate**. The generated invoices are displayed in the Invoicing dialog box.

   By default, invoices with a zero balance are not shown.
4. Optionally, you can do one or more of the following to work with the invoices that are displayed; otherwise, if you are satisfied with the invoices, you can go to the next step to post the invoice.

» To show zero balance invoices in the window, clear the Hide Zero Balances option.

» To preview an invoice, select the invoice (CTRL-click to select multiple invoices), and then click Preview. An onscreen preview of the selected invoices opens, titled “Invoice Preview” (to distinguish the invoices from those that have been posted). The invoices also do not have invoice numbers, which are not issued until you post the invoices. The preview window contains options for printing a hard copy of the invoices, for emailing the invoices (see Send Email from EMS), and so on. Select the option or options that best fit your working needs.

» To change the criteria for the invoices, click Filter to return to the Invoicing window. After changing the criteria, you can generate the invoices again.
Onscreen preview of an in-progress invoice

5. To post an invoice, select the invoice (CTRL-click to select multiple invoices), and then click Final. A message opens warning you that you are about to post and print (#) invoices, and asking you if want to continue.

6. Click Yes. The message closes and an onscreen preview of the final invoices opens. The preview is titled “Invoices” and each invoice has been issued an invoice number. The preview window contains options for printing a hard copy of
the invoices, for emailing the invoices (see Send Email from EMS), and so on. Select the option or options that best fit your working needs.

Onscreen preview of a posted invoice

![Onscreen preview of a posted invoice](image)

After you generate and post an invoice, the message “Items have been invoiced” is displayed in red text on the Reservation Summary tab, the Booking Summary tab, and the <Booking Detail> Summary tab in the Navigator. The booking detail folder in which the invoiced items reside now has a green background in the Booking Details pane and the icon for each invoiced item also has
a green background in the Items pane. Also, the invoice is permanently saved, and you cannot edit it. You can make changes to the balance due for a reservation only by creating an adjustment or by voiding the invoice and regenerating it after you edit the booking information. (Because invoiced bookings are locked and cannot be edited, you must void the invoice before you can edit the bookings.)

REPRINTING AN INVOICE

You can reprint both non-voided and voided invoices. You can reprint invoices for only one department at a time from the Billing area of EMS. Reprinting an invoice does not recalculate the invoice. The invoice is simply printed as it appeared when it was first generated. You can specify the invoices that you are reprinting, or you can search for invoices that meet specific criteria, and then select specific invoices to reprint from the list of search results.

To reprint invoices for one or more departments, you must select the reservation in the Navigator, open the Transactions tab and CTRL-click to select the multiple invoices that you are reprinting, and then use the Reprint option on the Transactions tab.
1. On the EMS Desktop Client menu bar, click Billing > Other > Reprint Invoices. The Reprint Invoices dialog box opens.

Reprint Invoices dialog box

2. Select the Department that generated the invoices. This field is automatically populated if you have a default department assigned to your user account, but you can select a different value if needed.
3. In the Invoice No. field, enter the number of the invoice that you want to reprint, and then click Add. The invoice is displayed (by number) in the lower right Invoice pane.

4. Repeat Step 3 until you have added all the invoices that you want to reprint.

5. Leave the reprinting criteria set to their default values, or change them as needed using the table below.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoices</td>
<td>The invoice type that you are reprinting—Non Voided (the default value) or Voided.</td>
</tr>
<tr>
<td>Format</td>
<td>Select the sort order for the reprinted invoices. The default value is By Reservation.</td>
</tr>
<tr>
<td>First Transaction</td>
<td>Leave these values blank to reprint the invoice for all bookings; otherwise, enter the date range of the bookings for which you are reprinting the invoice.</td>
</tr>
<tr>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Last Transaction</td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Print Header on Each Page</td>
<td>Leave this option selected to print the invoice header on every page of the invoice.</td>
</tr>
<tr>
<td>Print Transactions</td>
<td>Select this option to include any associated transactions (deposits, payments, and so on) in the reprinted invoice.</td>
</tr>
</tbody>
</table>
6. Click **OK**. An onscreen preview of the invoices opens. The preview is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf, emailing the invoice (see [Send Email from EMS](#)) and so on. Select the option or options that best fits your working needs.

![Invoice Preview](image_url)
VOID AN INVOICE

You can void an invoice only if the invoice has not been paid. If payments have been made against an invoice, you must first void the payments. You can void invoices for only one department at a time. When you void an invoice, the invoice is removed from the Ageing report and its associated bookings are unlocked. You can specify invoices to void, or you can search for invoices that meet specific criteria, and then select specific invoices to void from the list of search results.

**TIP:** You can also void an invoice from the **Transactions** tab when a reservation is selected in the Navigator.

1. On the EMS menu bar, click **Billing > Other > Void Invoices**. The Void Invoices dialog box opens.
2. In the Department field, select the department that generated the invoices.
3. In the Invoice No. field, enter the number of the invoice that you are voiding, and then click Add.

Two results are possible:

» If payments have not been applied to the invoice, then a Void Reason dialog box opens. Continue to Step 4.
If payments have been applied to the invoice, then an error message opens indicating that payments have been applied to the invoice and it cannot be voided. You must void the payments first before you can continue with voiding the invoice. See Void a transaction.

4. Enter a reason for voiding the invoice, and then click OK. The invoice is displayed (by number) in the lower right Invoice pane.

5. Repeat Step 3 and Step 4 until you have selected all the invoices from the same department that you are voiding.

6. Do one of the following:
   - To review an invoice before you void it, go Step 7.
   - To void an invoice without reviewing it, go to Step 8.

7. Optionally, before you void a selected invoice, you can review it to ensure that it is indeed an invoice that you want to void. In the lower right Invoice pane, select the invoice, or CTRL-click to select multiple invoices, and then click Preview. An
onscreen preview of the selected invoices opens. The preview is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf, and so on. Select the option or options that best fit your working needs. For example, before you void an invoice, you might want to email a copy of the invoice to a colleague to confirm that the invoice should be voided.
8. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple invoices that you are voiding, and then click **OK**. A message opens asking you if you are sure that you want to void the selected invoices.

9. Click **Yes**. A message opens indicating that the invoices have been voided.
10. Click **OK**. The message and the Void Invoices dialog box close. The Void column is set to **Yes** on the **Transactions** tab for each of the voided invoices in the Navigator.

**Concept: Calculations are additional charges that can be applied to billable items based on an associated group or individual, a category or service, or a room.**

... such as gratuity or sales tax. Both pricing methods and calculations determine the final cost for a billable item; however, unlike pricing, which is applied when a billable item is reserved (and retained, even if the price for the item later changes), calculations are figured each time a confirmation or an invoice is generated. If an event has associated calculations (which are assigned to groups or individuals, categories and services, and rooms), you will see these in the invoicing process.
CHAPTER 111: Types of Transactions

A transaction in EMS can be any of the following types:

<table>
<thead>
<tr>
<th>TRANSACTION TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deposit</td>
<td>A deposit is the dollar amount paid in advance of a meeting or event before invoicing occurs.</td>
</tr>
<tr>
<td></td>
<td>▶ A deposit is added to a reservation. After you invoice the reservation, all outstanding deposits are applied to the invoice to reduce the balance due.</td>
</tr>
<tr>
<td></td>
<td>▶ A damage deposit is used to collect a deposit that is not applied to an invoice and therefore, does not reduce the balance due. Instead, if the customer does not damage the room, any reserved equipment, and so on, then you must return the damage deposit to the customer by voiding the damage deposit transaction.</td>
</tr>
<tr>
<td>Payment</td>
<td>A payment is the dollar amount that is applied to an invoice to reduce the balance due. A pre-payment is similar to a deposit and is applied to a reservation.</td>
</tr>
</tbody>
</table>
| Adjustment       | An adjustment is a modification that is made to the amount due on an existing invoice. For example, if you send out an
### CHAPTER 111: Types of Transactions

<table>
<thead>
<tr>
<th>TRANSACTION TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refund</td>
<td>A refund is the return of funds that have been applied to an invoiced reservation.</td>
</tr>
</tbody>
</table>

An invoice is sent to a group for $202.00 and the group sends you a check for $200.00. You can make an adjustment of “$2.00-” to close out the invoice.
CHAPTER 112: Work with Transaction

Working with transactions includes entering and voiding:

- Adjustments.
- Deposits (Damage, Booking, Reservation).
- Payments
- Pre-Payments.
- Refunds.

Each type of transaction involves unique steps for entering them, but the task of voiding all these types of transactions are the same.

**TIP:** You might need to first search for an existing transaction to determine if it has already been entered or voided.
ENTER A TRANSACTION: ADJUSTMENTS, DEPOSITS, PAYMENTS, PRE-PAYMENTS, REFUNDS

1. Do one of the following:
   » Open the reservation in the Navigator and on the Transactions tab, click New > Payment. (This method pre-populates many fields with information for the reservation).
On the EMS Desktop Client menu bar, click Billing > Payments > Payment Entry, and then on the Payment Entries window, click New. (This method launches a blank Payment Entry form you must complete “from scratch”).
Payment Entry Window
2. Select a Transaction Type: Adjustment, Damage Deposit, Deposit (Bookings), Deposit (Reservation), Payment, Pre-payment, Refund. Your selection in this field affects your entries in other fields in this form.

**Transaction Type Field, Payment Entry Window**

![Payment Entry Window](payment_entry_window.png)
### Types of Transactions (select type in Transaction Type field of Payment Entry Window)

<table>
<thead>
<tr>
<th>TRANSACTION TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment</td>
<td>A price adjustment for the event, such as a discount or late charge.</td>
</tr>
<tr>
<td>Damage Deposit</td>
<td>A refundable amount to cover possible damages during the event.</td>
</tr>
<tr>
<td>Deposit (Reservation)</td>
<td>Deposit (Reservation) is best suited for reservations with one or more bookings that are to be invoiced in their entirety upon completion of the event.</td>
</tr>
<tr>
<td>Deposit (Bookings)</td>
<td>Deposit (Bookings) is best suited for reservations with multiple bookings, for example, an event with multiple occurrences spanning several months, that is to be billed monthly. A Deposit (Bookings) allows you to spread the deposit across multiple months so that only a portion of the deposit is consumed and applied to the invoice that is generated monthly. In this scenario, a large deposit that is entered as Deposit (Reservation) would be consumed in its entirety by the first invoice that is generated.</td>
</tr>
<tr>
<td>Payment or Prepayment</td>
<td>Remember that pre-payments act just like deposits in that they are applied to a reservation and are applied to an invoice reducing the balance due. Payments are applied to an invoice.</td>
</tr>
<tr>
<td>Refund</td>
<td>Funds reimbursed to the payee.</td>
</tr>
</tbody>
</table>

**TIP:** You can also void an existing transaction from this window by clicking the Void option. For detailed instructions, see Void Transactions (below).
3. Enter additional information using the table below.

**Field Descriptions for Payment Entry Window**

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>The default value is the current day's date. You can edit this value if needed.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the department.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Select the payment type.</td>
</tr>
<tr>
<td>Check No.</td>
<td>Enter a check number if you selected “Check” as the payment Type.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the transaction. To decrease the invoice by this amount, enter a minus sign (-) before or after the amount.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the currency for the transaction.</td>
</tr>
<tr>
<td>Reservation No.</td>
<td>Automatically populated if you opened this window from the Transaction tab in the Navigator; otherwise, enter a reservation number or Search for a reservation.</td>
</tr>
</tbody>
</table>

Adjustments, Payments, Refunds: This field is not available for these transaction types since they are applied to invoices, not reservations.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice No.</td>
<td>When required, Search for an invoice (with a specific date and Employee or Customer name from the Department you specified) to associate with this transaction.</td>
</tr>
<tr>
<td></td>
<td>Deposits, Pre-payments: This field is not required for deposits and pre-payments since they are applied before an invoice is generated. The invoicing process totals the charges for the specified date range, consumes any applied reservation deposits, and results in a net balance due for the invoice. The invoicing process does not consume any Damage deposits.</td>
</tr>
<tr>
<td></td>
<td>See Also: Work with Invoices.</td>
</tr>
</tbody>
</table>

Notes Optional. Enter any other comments or statements that explain or clarify the transaction.

4. Click OK. The Payment Entry dialog box closes. The transaction information is displayed on the Transactions tab for the reservation.

**VOID A TRANSACTION**

1. Open the reservation in the Navigator and on the Transactions tab, select the transaction you want to void (CTRL-click to select multiple transactions), and then click Void. A Void Reason dialog box opens.
Void Reason Dialog Box

**TIP:** You can also void a transaction by opening it in Edit mode from the Transactions tab or by locating the transaction by date under the **Billing > Payments > Payment Entry** option in the EMS Desktop Client menu bar. On the Payment Entry window that displays, select the **Void** option.

2. Enter the reason for voiding the transactions, and then click **OK**.
3. The Void Reason dialog box closes and a message confirms that the transaction has been voided. Click **OK** to return to the Navigator. The Void column is set to **Yes** for each of the voided transactions in the Navigator.
CHAPTER 113: Generate an EMS Billing Report

All EMS Billing reports are available under the Billing option on the menu bar. For any EMS report, you can specify the parameters, options, and format for the report, or you can generate the report according to saved settings. (For detailed information about a saved report, see Work with Saved Reports.) Not all reports require the same parameters, nor do they all have the same options available. In addition, you can generate different reports in different formats.

**TIP:** For brevity and ease, the parameters and options that are available for each report are not discussed here. Instead, the options are discussed in Report Descriptions and Options. Contact your EMS administrator if you need assistance in generating any of these reports.

GENERATE A REPORT

1. On the EMS menu bar, click Billing to open the Billing menu, and then do one of the following:
To generate the Billing Worksheet report, click **Billing > Invoices > Billing Worksheet**.

To generate any other Billing report, click **Billing > Reports**, and then click the option for the report that you are generating. For example, to generate the Ageing report, click **Billing > Reports > Ageing**.

**TIP:** All Billing reports other than the Billing Worksheet report are also available from **Reports > Billing**.

2. On the Setup drop-down list, do one of the following:
   - To generate the report according to the filter settings that you want (parameters, options, and so on), leave user-specified selected, then go to Step 3.
   - To run the report with filter settings that have been saved, select the saved report, and then go to Step 4.

**TIP:** For detailed information about saved reports, see **Work with Saved Reports**.
3. Specify the report parameters, options, and format. See:
   
   » **Invoice Reports**
   
   » **General Reports**

4. Optionally, do one or both of the following:
   
   » Click **Print Preview**. A preview of the report opens onscreen.
   
   » To print a hard copy of the confirmation, specify the number of copies that you are printing, and then click **Print**.

5. Click **Close**. Unless you change the setup, all subsequent reports will be generated and printed according to the parameters and options that you have specified and in the format that you specified. If you want to save certain settings so that you do not have to adjust the filter settings every time you run the report, you can save the report. See **Work with Saved Reports**.
CHAPTER 114: Apply a Reservation Discount

You use the Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced details in a booking. The discount is applied as a percentage of the total charge for an item and it is added to any existing discounts that have already been applied to the item.

**TIP:** To apply a discount to invoiced items, you must first void the invoice. See [Void an invoice](#).

1. Open the reservation in the Navigator. See:
   - [Open a reservation directly in the Navigator](#)
   - [Open a reservation through the Reservation Book](#)
   - [Open a reservation through a group](#)

2. In the left pane of the Navigator, select the reservation to which you are applying the discount.
3. In the Bookings pane, click **Tools**, and then click **Apply Reservation Discount**. The Apply Reservation Discount window opens. All the bookings for the selected reservation with their categories that have not been invoiced are displayed.

4. Leave the Category set to the default value of (all), or optionally, to apply a discount to all the items in a specific category, on the Category drop-down list, select a category. The Apply Reservation Discount window is updated with the bookings
that have the selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are applying the discount, or click Select All to select all the displayed bookings in a single step, and then click Finish. A message appears indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.

After you apply a reservation discount, you can view it and/or edit it when you are editing the reservation on the Billing Information tab of the Reservation window in the Navigator. See Edit a Reservation in the Navigator.
CHAPTER 115: Bill Multiple Reference and PO Numbers for a Reservation

The following procedure details how to allocate a reservation charge to multiple billing reference numbers; however, by analogy, you can follow this procedure to allocate booking charges or booking detail charges to multiple billing reference numbers and/or PO numbers.

1. For a selected reservation, open the Billing Reference Allocation tab, and then click Edit. The Billing Reference Allocation dialog box opens. By default, when this dialog box first opens, it displays the charge for the reservation allocated 100% to a single billing reference number placeholder.
2. Select the billing reference number placeholder, and then click Edit. The Split Billing Add dialog box opens.

3. Do one of the following:

   » Enter the billing reference number to which you are allocating the reservation charges, and then click OK. The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with the newly added billing reference number allocated at 100%.
Search for a billing reference: click the Search icon and select a billing reference number from the list, or, enter a search string in the Find field to choose from a list of close matches. The Billing References dialog box closes. You return to the Split Billing Add dialog box with the selected billing reference number displayed in the dialog box. You return to the Billing Reference Allocation dialog box with the selected billing reference number allocated at 100%.

4. Do one of the following

To allocate the reservation charges to only this single billing reference number, click OK. The Billing Reference Allocation dialog box closes and you return to the Navigator. The newly added billing reference number, allocated at 100%, is displayed on the Billing Reference Allocation tab.

To allocate the reservation charges to multiple billing reference numbers, click New. The Split Billing Add dialog box opens.

5. Do one of the following:
» Enter a Billing Reference number, and then click OK.
» Search for a number by selecting from the list or by keyword, and then click OK.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with each of the newly added billing reference numbers displayed with a 0% allocation.

6. Repeat these steps until you have added all the needed billing reference numbers.
7. For each new billing reference number, double-click in the Percent field to select the percent, and then change the percent to the appropriate value. The percentages must add up to 100%.
8. Click OK to close the Billing Reference Allocation dialog box and return to the Billing Reference Allocation tab on the Navigator. All the billing reference numbers and their percent allocations are displayed on the tab.
CHAPTER 116: Reprice Categories and Room Charges for a Reservation

When you edit a reservation, changes to the pricing plan are applied at the reservation-level only. Booking level service categories and room charges are not automatically repriced. To reprice services or room charges based on a new pricing plan, use the Update Pricing Plan Wizard shown here.

**NOTE:** You can reprice a room charge for a booking only if the room charge has not been invoiced. To reprice a room charge that has been invoiced, you must first void the invoice.

Additionally, you can also Edit Charges for Multiple Billable Items.

1. Open the parent reservation in the Navigator.
2. In left pane the Navigator, select the reservation or booking with which you want to work, and then on the Reservation Summary tab, click Update Pricing.
3. The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is displayed in the Pricing Plan field. The window displays all the service categories and room charges that can be repriced in one or more of the reservation bookings.
TIP: If the reservation has other optional Pricing Plans, you can change the list using the drop-down field at the top.

4. Select a service category or room charge (CTRL-click to select multiple items) to reprice and click **Next**.
5. The next window lists all bookings under the reservation that have one or more of the selected service categories or room charges that you can reprice.

6. Select the booking(s) for which you want to apply the repricing (you can click **Select All** to select all the displayed bookings in a single step), and then click **Finish**. A message confirms your changes.

7. Click **OK** to close the message and return to the Navigator.
CHAPTER 117: Confirmations

In EMS, a confirmation is a way to communicate critical information for a reservation—the date, the time, the location, the scheduled resources, and so on. You send a confirmation to the group who is sponsoring or hosting the event to make sure the reservation has been correctly set up—the time and location are correct, all the necessary resources have been scheduled, and so on. You can also use the confirmation to inform the group of any outstanding issues related to the reservation (such as a balance due) and to provide other information that is not necessarily reservation-specific such as your organization's cancellation policies, your organization's alcohol policies, and so on. You can generate a confirmation for all the bookings in a reservation, or just for a selected booking in a reservation.

Confirmations are sent automatically to essential stakeholders; notifications trigger based on more granular "notification rules."

CONFIRMATIONS

» These are either sent out automatically after a booking is made in EMS Web App, or manually from the EMS desktop client.

» They contain the date/time/resources for the booking that was created.
These usually go to end users so they know when their event is and if they owe any money.

NOTIFICATIONS

These are sent out automatically based on the filters on the notification rule:

There are five types of notification rules:

- Bookings
- Service Orders
- Anything On A VIP Event
- New Web Users
- User Defined Field

These are mostly sent out X days before a booking. They are triggered when a change occurs on a booking, service order, and so forth within that range of days.
CHAPTER 118: Specify Your Confirmation Settings

The Confirmation Settings dialog box provides a variety of options that you can specify for manual and automatic generation of a confirmation for a reservation or a booking. You can specify your confirmation settings one time and use these settings for all confirmations you generate, or you can change the settings on as-needed basis and tailor them for each confirmation you generate.

1. Open a reservation in the Navigator. See:
   » Open a reservation directly in the Navigator
   » Open a reservation through the Reservation Book
   » Open a reservation through a group

2. In the upper right corner of the Navigator, click Settings > Confirmation Settings.
   The Confirmation Settings dialog box opens.

3. Specify the settings for your system’s Confirmations.

4. You can now generate a confirmation (manually or automatically) based on the settings you specified. See Generate a Single Confirmation at a Time.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Range tab</td>
<td>The department name that appears at the top of a printed confirmation.</td>
</tr>
<tr>
<td>Buildings tab</td>
<td>Select the specific buildings that are to be included in the confirmation.</td>
</tr>
<tr>
<td>Categories tab</td>
<td>Select the specific booking details that are to be included in the confirmation.</td>
</tr>
<tr>
<td>Statuses tab</td>
<td>Select the specific statuses that are to be included in the confirmation.</td>
</tr>
<tr>
<td>Options tab</td>
<td>Format settings for a printed confirmation.</td>
</tr>
<tr>
<td>Confirmation Title</td>
<td>Appears bold and centered at the top of the printed confirmation.</td>
</tr>
<tr>
<td>Header Message Footer Message</td>
<td>Pre-configured blocks of text that appear in the header and footer of the printed confirmation.</td>
</tr>
<tr>
<td>Paper size</td>
<td>The size of the paper on which the confirmation is printed. Values are Letter, Legal, and A4.</td>
</tr>
<tr>
<td>Print Comments</td>
<td>Include the comments for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Print Reminders</td>
<td>Include the reminders for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Print Cancel Reasons</td>
<td>Include the reasons for cancellation in the printed confirmation.</td>
</tr>
<tr>
<td>Print User Defined Fields</td>
<td>Include user-defined fields and their values in the printed confirmation.</td>
</tr>
<tr>
<td>Print Room Phone</td>
<td>Include the phone number for the room in which the event is being held in the printed confirmation.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print Room Notes</td>
<td>Include any notes for the room in which the event is being held in the printed confirmation.</td>
</tr>
<tr>
<td>Print Building Notes</td>
<td>Include any notes about the building in the printed confirmation.</td>
</tr>
<tr>
<td>Print Billing Reference Allocation</td>
<td>Include the billing reference numbers for the event as well as the percentage of charges that is allocated to each number in the printed confirmation.</td>
</tr>
<tr>
<td>Print PO Allocation</td>
<td>Include the PO numbers for the event as well as the percentage of charges that is allocated to each number in the printed confirmation.</td>
</tr>
<tr>
<td>Print Category Subtotals</td>
<td>Include the subtotal charges by category in the printed confirmation.</td>
</tr>
<tr>
<td>Print Room Type</td>
<td>Include the room type for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Print Item Selection Notes</td>
<td>Include the notes for each resource selection item for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Reserved Time</td>
<td>Do not show the reserved time for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Location</td>
<td>Do not show the location for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Pricing</td>
<td>Do not show the reservation's room charges or resource charges in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Logo</td>
<td>Do not show your organization's logo in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Notes</td>
<td>Do not show notes for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Suppress Item Special Instructions</td>
<td>Do not show special instructions for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Selections</td>
<td>Do not show any resource item selections in the printed confirmation.</td>
</tr>
<tr>
<td>Always Display Time Zone</td>
<td>Always show the time zone for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Display Messages as HTML</td>
<td>If you have defined any HTML messages, then select this option to display the HTML version of these messages in the printed confirmation; otherwise, the message is displayed in plain text.</td>
</tr>
<tr>
<td>Limit Bookings to Those With Details in Selected Categories</td>
<td>Show only those bookings in the printed confirmation that contain details for the categories that are selected on the Categories tab.</td>
</tr>
</tbody>
</table>

**Email Options Tab**
Format settings for the body of an emailed confirmation.

**Header Message Footer Message**
Pre-configured blocks of text that appear in the body of the emailed confirmation.

- **Note:** Your EMS administrator configures these values. Contact your administrator if you need assistance with adding or editing a value.

**Email Format**
- **None**—Opens a blank email form.
- **Detail**—The confirmation appears in its entirety in the email body.
- **Mobile Friendly**—The confirmation appears in a condensed version that is viewable on a mobile device.
- **Summary**—Only the booking information appears in the email body.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached Detailed Confirmation</td>
<td>The entire confirmation is provided as an attachment to the email.</td>
</tr>
<tr>
<td>Attach .ics file</td>
<td>An .ics file is a file that a recipient can save to create an entry in his/her personal calendar. Select this option to attach an .ics file to the email.</td>
</tr>
<tr>
<td>Prompt for Res. Attachments</td>
<td>Select from a list of reservation-level attachments that you are including in the email.</td>
</tr>
<tr>
<td>Email To</td>
<td>Select the users associated with the reservation who should receive the email confirmation.</td>
</tr>
<tr>
<td>Email CC</td>
<td></td>
</tr>
<tr>
<td>Copies to Print</td>
<td>The number of copies of the confirmation that are automatically printed if you print the confirmation. (Not applicable if you email a confirmation.)</td>
</tr>
</tbody>
</table>
CHAPTER 119: Send Confirmations

1. Open a reservation in the Navigator.

2. In the upper right corner of the Navigator, click Settings > Confirmation Settings. The Confirmation Settings dialog box opens.
Concept: Confirmations vs. Notifications: What's the Difference?

CONFIRMATIONS

» These are either sent out automatically after a booking is made in EMS Web App, or manually from the EMS desktop client.
» They contain the date/time/resources for the booking that was created.
» These usually go to end users so they know when their event is and if they owe any money.

NOTIFICATIONS

» These are sent out automatically based on the filters on the notification rule:
» There are five types of notification rules:

- Bookings
- Service Orders
- Anything On A VIP Event
- New Web Users
- User Defined Field

» These are mostly sent out X days before a booking. They are triggered when a change occurs on a booking, service order, and so forth within that range of days.
CHAPTER 120: Generate a Single Confirmation at a Time

You can generate a confirmation for all the bookings in a reservation, or just for a selected booking in a reservation. In the as-delivered implementation of EMS, when you generate a confirmation for a reservation or a booking, the Confirmation dialog box opens. This dialog box has the same tabs as the Confirmation Settings dialog box. It also contains options for generating a print preview of the confirmation and for manually printing or emailing an EMS-generated confirmation.

See Also:

- Your Confirmation Settings determine the information included in a confirmation. See Also: Specify Confirmation Settings.
- To generate multiple confirmations in a single step, see also: Generating Multiple Confirmations.
- You can Memorize your confirmation settings for the next time you generate the confirmation. See Also: Working with Saved Reports.
MANUALLY GENERATING ONE CONFIRMATION AT A TIME

1. Open a reservation.
2. In the left pane of the Navigator, select the reservation for which you are generating the confirmation.
   » You can also associate the confirmation with a specific booking within the reservation by selecting it in the Bookings (lower right) pane.
3. Do one of the following:
   » If you are generating a confirmation for a reservation, then open the Reservation Summary tab or Properties tab in the upper right pane of the Navigator, and then click Confirmation.
   » If you are generating a confirmation for a selected booking, then open the Booking Summary tab in the upper right pane of the Navigator, and then click Confirmation.
   » The Confirmation dialog box opens. The dialog box has the same tabs as the Confirmation Settings dialog box with one exception, the Date Range tab. On the Date Range tab, you can limit the confirmation to specific bookings and/or specific booking times. When the dialog box first opens, the Confirmation Setup is set to (user-specified).
4. Review the selections on this dialog box, and optionally, make any needed modifications.

   If you Use Specific Times, then you must also click Options and indicate how the confirmation is to be limited: to bookings that start within the range or to bookings that occur within the time range.
From the Setup drop-down list, you can select a memorized confirmation. If you select a memorized confirmation, then the only changes that you can make are to the dates and/or times on the Date Range tab.

5. Generate a printed confirmation or email one:

For a printed confirmation, enter the number Copies to Print, and click Print. A Print dialog box opens in which you can specify information, such as the printer to use and the page range. Click Print in this dialog box to manually generate the printed confirmation.

**TIP:** Before you print the confirmation, you can view a Print Preview, from which you can email the confirmation, export the confirmation to .pdf, and print the confirmation.

For an emailed confirmation, click Email. See Sending Email from EMS. Below is an example of the SMTP email window.
AUTOMATICALLY GENERATING A CONFIRMATION

If you want to always automatically generate a printed or emailed confirmation based on your confirmation settings, then you must edit the Confirmation setting on the General tab of the Navigator Options dialog box.

1. Open a reservation.
2. In the upper corner of the Navigator window, click Settings > Options. The Navigator Options dialog box opens. The General tab is the active tab.
3. Under Confirmation, select one of the following:

» **Email**—Always automatically generate an emailed confirmation based on your confirmation settings.

» **Print**—Always automatically generate a printed confirmation based on your confirmation settings.
4. Click **OK** to close the dialog box and return to the Navigator. The next time you initiate a Confirmation in the Navigator, EMS will Email or Print your confirmation based on your settings above.
CHAPTER 121: Generate Printed Confirmations

A confirmation is a document that details the critical information for a reservation—the date, the time, the location, the scheduled resources, and so on. Through the Navigator, you have the option of generating a single confirmation, either manually or automatically. (See Also: Confirmations.) A miscellaneous reservation function is also available for manually generating multiple confirmations at the same time. When you generate multiple confirmations, all the confirmations are contained in a single file, but each confirmation begins at the top of a new page. All the confirmations are "sent" by the same office, all the confirmations use the same format (By Booking Date, By Date Added, or By Date Changed) and all the confirmations use the same print options (Confirmation Title, Header Message, and so on); however, each confirmation can contain unique information for the buildings, statuses, and/or categories that are detailed in the confirmation. Because multiple confirmations are for multiple recipients, you cannot mass email these confirmations. Instead, you can only print them, and then manually mail them. You can specify the settings for multiple confirmations "from scratch," or you can copy an existing confirmation format, and edit it as needed.
1. On the EMS menu bar, click Reservations > Other > Confirmations. The window opens on the Date Range tab.

![Confirmation window]

2. You can either draft a confirmation by completing the fields shown on this page (defined below), or on the Setup drop-down list at the, select a saved, or memorized, confirmation, which means that the only changes that you can make are to the dates and/or times on the Date Range tab.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE RANGE TAB</td>
<td></td>
</tr>
</tbody>
</table>

EMS Software © 2018 / V44.1 / Page 773
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>The department name that appears at the top the printed confirmation.</td>
</tr>
<tr>
<td>Starting Date</td>
<td>The range of dates for which you are generating the confirmations.</td>
</tr>
<tr>
<td>Ending Date</td>
<td></td>
</tr>
<tr>
<td>Use Specific Times</td>
<td>Available only if the Starting Date is the same as the Ending Date. If this option is selected, then two fields are displayed on the Date Range tab in which you must specify the time range. After you specify the time range, click Options &gt; Date/Time Filter, and then indicate how the confirmation is to be limited by bookings that start within the time range, or by bookings that occur within the time range.</td>
</tr>
<tr>
<td>Format</td>
<td>The format/organization of the confirmation By Booking Date, By Date Added, or By Date Changed.</td>
</tr>
</tbody>
</table>

**BUILDINGS TAB** – Select the specific buildings that are to be included in the confirmation.

**CATEGORIES TAB** – Select the specific booking details that are to be included in the confirmation.

**STATUSES TAB** – Select the specific statuses that are to be included in the confirmation.

**OPTIONS TAB** – Format settings for a printed confirmation.

<table>
<thead>
<tr>
<th>Confirmation Title</th>
<th>Appears bold and centered at the top of the confirmation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Message</td>
<td>Pre-configured blocks of text that appear in the header and footer of the printed confirmation.</td>
</tr>
</tbody>
</table>
### FIELD | DESCRIPTION
--- | ---
Footer Message | Note: Your EMS administrator configures these values. Contact your administrator if you need assistance with adding or editing a value.
Paper Size | The size of the paper on which the confirmation is printed. Values are Letter, Legal, and A4.
Print Comments | Include the comments for the reservation in the printed confirmation.
Print Reminders | Include the reminders for the reservation in the printed confirmation.
Print Cancel Reasons | Include the reasons for cancellation in the printed confirmation.
Print User Defined Fields | Include user-defined fields and their values in the printed confirmation.
Print Room Phone | Include the phone number for the room in which the event is being held in the printed confirmation.
Print Room Notes | Include any notes for the room in which the event is being held in the printed confirmation.
Print Building Notes | Include any notes about the building in the printed confirmation.
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Billing Reference Allocation</td>
<td>Include the billing reference numbers for the event as well as the percentage of charges that is allocated to each number in the printed confirmation.</td>
</tr>
<tr>
<td>Print PO Number Allocation</td>
<td>Include the PO numbers for the event as well as the percentage of charges that is allocated to each number in the printed confirmation.</td>
</tr>
<tr>
<td>Print Category Sub-totals</td>
<td>Include the subtotal charges by category in the printed confirmation.</td>
</tr>
<tr>
<td>Print Room Type</td>
<td>Include the room type for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Print Item Selection Notes</td>
<td>Include the notes for each resource selection item for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Reserved Time</td>
<td>Do not show the reserved time for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Location</td>
<td>Do not show the location for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Suppress Pricing</td>
<td>Do not show the reservation's room charges or resource charges in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Logo</td>
<td>Do not show your organization's logo in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Notes</td>
<td>Do not show notes for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Special</td>
<td>Do not show special instructions for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Selections</td>
<td>Do not show any resource item selections in the printed confirmation.</td>
</tr>
<tr>
<td>Always Display Time Zone</td>
<td>Always show the time zone for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Display Messages as HTML</td>
<td>If you have defined any HTML messages, then select this option to display the HTML version of these messages in the printed confirmation; otherwise, the message is displayed in plain text.</td>
</tr>
<tr>
<td>Limit Bookings</td>
<td>Show only those bookings in the printed confirmation that contain details for the categories that are select-</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ings to Those</td>
<td>ted on the Categories tab.</td>
</tr>
<tr>
<td>With Details</td>
<td></td>
</tr>
<tr>
<td>in Selected</td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td></td>
</tr>
</tbody>
</table>

**TIP:** If needed, you can always save or memorize, these settings. See Also: [Work with Saved Reports](#).

3. To print the confirmation, do one or both of the following:

» Click **Print Preview** to open an onscreen preview of the printed confirmation. A variety of options are available from this preview, including the options to export the confirmation to a .pdf and to print the confirmation.
To manually print the confirmations, edit the number of copies to print as needed in the Copies to Print field (the default value is 1), and then click **Print**. A Print dialog box opens in which you can specify information, such as the printer to use and the page range. Click **Print** in this dialog box to manually print the confirmations.
CHAPTER 122: Generate Word Merge Documents for Custom Documentation

EMS provides options for producing pre-formatted documents that contain reservation information such as confirmations. Your organization, however, might have organization-specific information that must be included in these documents. If your organization has purchased and implemented the optional Word Merge module, you can generate Word Merge documents to produce custom confirmations, contracts, and so on that contain not only selected reservation information from EMS, but also, any information that is required by your organization. Because these documents are generated in a Word format (.docx), you cannot print them or email them from EMS.

TO GENERATE WORD MERGE DOCUMENTS

1. Open the reservation in the Navigator. See:
   - Opening a reservation directly in the Navigator
   - Opening a reservation through the Reservation Book
Opening a reservation through a group

Search Tools

2. In the left pane of the Navigator, do one of the following:
   - Select the reservation for which you are generating the confirmation.
   - Select the reservation for which you are generating the confirmation, and then in the Bookings (lower right) pane, select the booking for which you are generating the confirmation.

3. Do one of the following:
   - If you are generating a confirmation for a reservation, then open the Reservation Summary tab or Properties tab in the upper right pane of the Navigator, and then click Confirmation.
   - If you are generating a confirmation for a selected booking, then open the Booking Summary tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The Date Range tab is the active tab.
4. At the top of the Confirmation dialog box, click **Word Merge**. The Word Merge
Documents dialog box opens. This dialog box displays all the Word Merge doc-
documents that your EMS administrator has configured for your organization-specific documents such as confirmations, contracts, and so on.

**Word Merge Documents Dialog Box**

5. Select the appropriate Word Merge document, and then optionally, do one or both of the following:

   - To attach the document at the reservation-level for the selected reservation, click Attach to Reservation.
Select the attachment type.

6. Click **Generate**. A message opens, indicating that the Word Merge was successful, and asking you if you want to view the document.

7. Optionally, click **Yes**. The document opens in Microsoft Word. You can now use any of the standard Word functions to save the document, to print the document, attach the document to email, and so on.

**TIP:** To save a copy of the document in your EMS database, you must either attach the document to the reservation, or you must open and view the document and save it as a Word document.
CHAPTER 123: Send Emails

Once your EMS Desktop Client Administrator has configured system email for EMS Desktop Client, you can set personal preferences on your installation of the application to email confirmations or invoices to groups or miscellaneous information to your EMS users or groups.

Your personal preferences on your installation of the EMS Desktop Client control how emails are sent:

- If your organization uses Microsoft® Outlook, you can set preferences to use your respective email system within EMS Desktop Client to send confirmations and invoices or any other individual emails to EMS users or groups.
- To send bulk emails to groups within EMS Desktop Client (basic/advanced, transactions, calendar, and so on), however, you must set preferences to use SMTP email.
- If your organization does not use Microsoft® Outlook, furthermore, SMTP email is also used to send all email from EMS Desktop Client, including emails to users or groups and confirmations and invoices.
- Generic emails (which are not “tied” to a confirmation, invoice, reminder, etc.) can go to any recipient.
TIP: For any of your personal email preferences to work, your user account must be configured with an email address. See your EMS administrator or internal IT staff for information on how to enable SMTP email.

EMAILING RESERVATION ATTENDEES FROM THE EMS DESKTOP CLIENT APPLICATION

1. Select a reservation, and then click Email to open a pre-addressed SMTP email to the group associated with the reservation.
2. Enter the necessary information in the From, Subject, Message and other fields.
3. Optionally, do one or both of the following:
   » To attach a file, click Attachments at the top of the window.
   » To format the body of the email message, use the options on the Formatting toolbar.
4. Click Send.
SENDING A MEETING CONFIRMATION OR INVOICE

1. On the Confirmation dialog box or on the onscreen preview of a new or reprinted invoice, click Email.
   
   » For a confirmation, an Email window that displays the confirmation in the body opens. The From field is populated with the user address that is associated with your user account or, based on your user preferences, the email address of the department that is associated with your user account. You can select either address. (See Also: Setting User Preferences and Default Values.) The To field is blank.

   » For an invoice, an Email window that contains the invoice as an attachment opens. The From field is populated with the user address that is associated with your user account or, based on your user preferences, the email address of the department that is associated with your user account, and you cannot change this value. (See Also: Setting User Preferences and Default Values.) The To field is populated with the email address for the associated group, but you change this value if needed.
TIP: For an invoice, the SMTP email window also has Header Message and Footer Message fields for including header and footer messages in the email body.

2. Select the recipients for the email.

3. Optionally, do one or both of the following:
   - To format the body of the email message, use the options on the Formatting toolbar.
   - To attach a file, click Attachments at the top of the window.
   - The default format for the attached invoice is PDF. You can select a different format if needed. Other allowed formats are HTML, Microsoft Excel (.xls), Microsoft Word (.rtf), Picture (.tiff), and Text File (.txt).
   - If the emailed confirmation is to include the entire confirmation as an attachment, then you must also select a file format for the attached confirmation. The default value is Adobe (.pdf). Other allowed formats are HTML, Microsoft Excel (.xls), Microsoft Word (.rtf), Picture (.tiff), and Text File (.txt).
   - If the emailed confirmation includes one or more attachments, then the Confirmation Title is also used for the name for all attachments other than an .ics file. If the confirmation includes an .ics file, then the .ics file is always named Confirmation.ics.
4. Click **Send**.

**SENDING A GENERIC EMAIL**

1. On the EMS toolbar, click the Email icon. A generic email form opens. Depending on your preferences, the **From** field is automatically populated either with the email address that is specified for your user account, or the email address of the department that is associated with your user account. (See Also: **Setting User Preferences and Default Values**.)

2. Enter the necessary information in the To, Subject, Message, and other fields.

3. Optionally, do one or both of the following:
   - To attach a file, click **Attachments** at the top of the window.
   - To format the body of the email message, use the options on the Formatting toolbar.

4. Click **Send**.
CHAPTER 124: View a History of Sent Emails

You can use the Email History function to review a list of all emails that have been sent from within your organization’s EMS system via SMTP (not via Microsoft Outlook), including confirmation emails, report emails (which includes invoices, reminders, queries, guest requests, and group and contact information), and generic emails. You can also view the contents of sent emails and print sent emails.

1. On the EMS main menu, click Reservations > Other > Email History. The Emails window opens. Regardless of your preferences, the From field is automatically populated with the email address for your user account, but you can always change this value.
2. Enter the search criteria for the emails, and then click Display.

   Tip: Under Source, the Report option collectively refers to confirmations, invoices, reminders, queries, group requests, and group and contact information.

All of the emails that meet the search criteria are displayed in the bottom pane of the Emails window.

3. Optionally, do one or more of the following:
   - To view an email, select the mail in the search results list, and then click View.
   - To print the complete results list, click Print > List.
To print the contents of one or more emails in the results list, select the mail, or CTRL-click to select multiple emails, and then click Print > Emails.